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法律资讯

警告提示系统

为了您的人身安全以及避免财产损失，必须注意本手册中的提示。人身安全的提示用一个警告三角表示，仅与财产

损失有关的提示不带警告三角。警告提示根据危险等级由高到低如下表示。

危险

表示如果不采取相应的小心措施，将会导致死亡或者严重的人身伤害。

警告

表示如果不采取相应的小心措施，可能导致死亡或者严重的人身伤害。

小心

表示如果不采取相应的小心措施，可能导致轻微的人身伤害。

注意

表示如果不采取相应的小心措施，可能导致财产损失。

当出现多个危险等级的情况下，每次总是使用最高等级的警告提示。如果在某个警告提示中带有警告可能导致人身

伤害的警告三角，则可能在该警告提示中另外还附带有可能导致财产损失的警告。

合格的专业人员

本文件所属的产品/系统只允许由符合各项工作要求的合格人员进行操作。其操作必须遵照各自附带的文件说明，特

别是其中的安全及警告提示。 由于具备相关培训及经验，合格人员可以察觉本产品/系统的风险，并避免可能的危

险。

按规定使用 Siemens 产品

请注意下列说明：

警告

Siemens 产品只允许用于目录和相关技术文件中规定的使用情况。如果要使用其他公司的产品和组件，必须得到 
Siemens 推荐和允许。正确的运输、储存、组装、装配、安装、调试、操作和维护是产品安全、正常运行的前提。

必须保证允许的环境条件。必须注意相关文件中的提示。

商标

所有带有标记符号 ® 的都是西门子股份有限公司的注册商标。本印刷品中的其他符号可能是一些其他商标。若第三

方出于自身目的使用这些商标，将侵害其所有者的权利。

责任免除

我们已对印刷品中所述内容与硬件和软件的一致性作过检查。然而不排除存在偏差的可能性，因此我们不保证印刷

品中所述内容与硬件和软件完全一致。印刷品中的数据都按规定经过检测，必要的修正值包含在下一版本中。

Siemens AG
Industry Sector
Postfach 48 48
90026 NÜRNBERG
德国

A5E32786003-AA
Ⓟ 09/2014 本公司保留更改的权利

Copyright © Siemens AG 2014.
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前言 1
本文档的用途

本文档含有如下的支持信息：

● 执行步骤确保 PCS 7 系统可用

● 验证对 PCS 7 系统进行有效诊断的要求

● 理解 PCS 7 系统的报警概念

● 对故障作出相应的反应，并为维修专家准备有关 PCS 7 系统状态的详细信息

● 选择正确的诊断工具，使您能利用所提供的帮助在 PCS 7 系统上执行诊断

免责声明

警告

对因不正确使用本文档中提供的说明而可能给客户带来的任何后果，西门子概不承担任何

责任。

● 只有经过培训的维修人员才有权操作过程控制系统。

● 对系统进行更改时，请始终遵守工厂特定规则和政府法规。

● 请遵守工厂特有限制条件并相应地对工作进行调整。

● 请始终记住，对系统的更改可能会影响系统的其它部分。

本文档的目标读者

本文档供如下经过培训的维护人员（服务级别 1）使用：

● PCS 7 用户

● SIMATIC S7 专家

访问 PCS 7 文档的方式

可在以下位置找到 PCS 7 文档：

● Process Control System; SIMATIC PCS 7 DVD 上

● 安装后的计算机上

● Internet 上

服务支持和诊断 (V8.1)
维修手册, 11/2014, A5E32786003-AA 9



完整版本的文档可在“SIMATIC PCS 7 技术文档”网站找到：www.siemens.com/pcs7-
documentation (www.siemens.com/pcs7-documentation)

说明

PCS 7 自述文件（Internet 版本）

Internet 上的 PCS 7 自述文件中提供的信息优先于所有 PCS 7 文档。

请仔细阅读该 PCS 7 自述文件；其中包含有关 PCS 7 的重要信息和修正。

Process Control System; SIMATIC PCS 7 DVD 上的 PCS 7 文档

● PCS 7 自述文件（DVD 版本）

Process Control System; SIMATIC PCS 7 DVD 中的 PCS 7 自述文件包含有关 PCS 7 
的重要信息，其优先级高于随产品所提供的 PCS 7 文档。 安装 PCS 7 后，可在 
Windows“开始”(Start) 菜单的以下路径下找到《过程控制系统 PCS 7；PCS 7 自述文

件》(Process Control System PCS 7; PCS 7 Readme) 文档：

“Siemens Automation > SIMATIC > 产品说明 > <语言>”(Siemens Automation > 
SIMATIC > Product Notes > <language>)

● 可在以下位置找到最重要的 PCS 7 系统文档：

– SIMATIC PCS 7 DVD 中的“_Manuals”文件夹

– 工程师站上 SIMATIC Manager 应用程序的在线帮助（CHM 文件）

– 工程师站上 Windows“开始”(Start) 菜单的以下路径下的 PDF 文件：

“Siemens Automation > SIMATIC > 文档 > <语言>”(Siemens Automation > SIMATIC 
> Documentation > <language>)

说明

包括以下 PCS 7 系统文档：

● 目录总览《过程控制系统 PCS 7；PCS 7 文档》(Process Control System PCS 7; 
PCS 7 Documentation)

● 组态手册《过程控制系统 PCS 7；工程组态系统》(Process Control System PCS 7; 
Engineering System)

● 功能手册《过程控制系统 PCS 7；PCS 7 - PC 组态》(Process Control System PCS 
7; PCS 7 - PC Configuration)

● 组态手册《过程控制系统 PCS 7；操作员站》(Process Control System PCS 7; 
Operator Station)

● 功能手册《过程控制系统 PCS 7；OS 过程控制》(Process Control System PCS 7; 
OS Process Control)

● 产品文档随相关产品一起安装。

前言

服务支持和诊断 (V8.1)
10 维修手册, 11/2014, A5E32786003-AA

http://www.siemens.com/pcs7-documentation


Internet 上的 PCS 7 文档（最新版本）

最新版本的 PCS 7 文档可在“SIMATIC PCS 7 技术文档”网站的以下位置找到：

● 在“SIMATIC PCS 7 的软件手册 ...”部分中

– 特定 PCS 7 版本的最新系统文档和产品文档的链接。

– 最新的系统文档“PCS 7 文档门户安装程序”的下载链接。

说明

PCS 7 文档门户安装程序

安装程序包含完整的 PCS 7 系统文档（PDF 文件和在线帮助）。

● 无需 PCS 7 即可运行此安装程序。

● 在工程师站上运行此安装程序时（完全安装和覆盖安装 - 选择原始安装文件夹时），
将更新以下文档：

– “SIMATIC Manager”应用程序的在线帮助：（CHM 文件）

– Windows“开始”(Start) 菜单的以下路径下的 PCS 7 系统文档：
“Siemens Automation > SIMATIC > 文档 > 语言 > PDF 文件”(Siemens Automation 
> SIMATIC > Documentation > language > PDF files)

● PCS 7 新闻快讯将通知您新版本的系统文档何时可用。

– 我的文档管理器 (http://support.automation.siemens.com/CN/view/zh/38715968)中
手册汇集形式的完整 PCS 7 文档的下载链接。

手册汇集包括硬件和软件手册。

● 在“Hardware Manuals for SIMATIC PCS 7 ...”部分中

– 批准用于某个 PCS 7 版本的组件的最新手册的链接。

– 批准用于 PCS 7 的 SIMATIC PCS 7 工业软件的最新手册的链接。

目录、小册子、客户杂志和演示软件

此信息在以下 Internet 地址提供： 信息和下载中心 (http://www.automation.siemens.com/
mcms/infocenter)

所需知识 

本文档提供使用 PCS 7 的相关信息，主要供经过培训的维护人员使用。 下面是理解文档

时所需的知识：

● Microsoft Windows 操作系统的基本知识

● SIMATIC PCS 7（工程组态系统、PCS 7 操作站）的功能和组态知识。

● SIMATIC S7（S7-400、STEP 7）的功能和组态知识

● SIMATIC NET（网络组件和传输介质）的功能和组态知识

前言
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关于本文档的重要信息

本文档为服务支持指南。 因此并不面面俱到。 由于缺少对您的工厂所处特殊环境的相关知

识，因此，对于本文档，我们无法确保以下各项：

● 您可以使用本文档自己改正问题。

● 如果需要进行维护（类似于所显示的内容），则所介绍的过程一定会帮助找到故障的原

因或帮助排除故障。

● 有关各硬件或软件组件的详细信息是完整的。

● 有关各硬件或软件错误的详细信息是完整的。

● 本文档不能提供维护技术人员或热线人员所能提供的专业知识。

● 此过程的执行不会对系统造成干扰。

● 所介绍的过程可通过远程访问来执行。

相对于先前版本的变更

下面概述了本文档与先前版本相比所做的最重要的更改：

从 PCS 7 V8.1 开始的新增内容

● 升级 CPU 410-5H 的系统扩展卡 (页 62)（自固件版本 8.1 起）

自 PCS 7 V8.0 Update 1 开始的新增内容

● PROFINET 的诊断工具

● 基金会现场总线的诊断工具

● PROFINET 的 BANY

从 PCS 7 V8.0 开始的新增内容

● 监视 OS 服务器的时间同步

相关信息，请参见“OS 服务器的时间主站角色（状态） (页 160)”部分

● 用于以下操作系统的诊断工具：

– Microsoft Windows 7
– Windows Server 2008

前言

服务支持和诊断 (V8.1)
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从 PCS 7 V7.0 开始的新增内容

● PCS 7 中用于通用诊断/维护的维护工作站

相关信息，请参见“使用维护站进行诊断（资产管理） (页 106)”部分。

● PROFIBUS PA 的诊断

相关信息，请参见“PROFIBUS PA 的诊断 (页 122)”部分。

● 其它诊断工具：

– SIMATIC Shell (页 152) 
– Microsoft 基准安全分析器 (MBSA) (页 151)
– BANY PROFIBUS (页 172)

约定

在本文档中，软件界面元素的名称使用的语言与本文档的语言一致。 如果为操作系统安装

了多语言软件包，则在切换语言后某些名称将会以操作系统的基本语言显示，因此，会与

文档中所用的名称不同。

前言

服务支持和诊断 (V8.1)
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更多支持 2
如果对如何使用本手册中描述的产品有任何疑问，而本文未给出解答，请与您当地西门子

代理联系。

可在以下网址找到您当地代理的信息：

http://www.siemens.com/automation/partner (http://www.siemens.com/automation/
partner) 

提供有关各 SIMATIC 产品和系统的技术文档详情的指南，可在以下网址找到：

http://www.siemens.com/simatic-tech-doku-portal (http://www.siemens.de/simatic-tech-
doku-portal) 

在线目录和在线订购系统位于：

https://mall.industry.siemens.com/ (https://mall.industry.siemens.com) 

技术支持

通过以下网址的在线支持请求表单，可访问所有 A&D 产品的技术支持：

● 通过支持申请 Web 表单

 技术支持  (http://www.siemens.en/simatic-tech-doku-portal) 

● 有关技术支持信息，请访问 Internet 网址：

http://www.siemens.com/automation/service (http://www.siemens.de/automation/
support-request)。 

Internet 上的服务和支持

除了文档集外，我们还在 Internet 上提供了知识库。

http://www.siemens.com/automation/service&support (http://www.siemens.com/
automation/partner)

在这您可以访问：

● 新闻快讯，不断提供有关我们的产品的最新信息

● 所需的文档，可通过服务与支持中的搜索功能进行查找

● 论坛，为用户和专家提供一个用于交流经验的国际平台

服务支持和诊断 (V8.1)
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● 当地的自动化与驱动代理

● 关于本地服务、维修、备件的信息，“我们的技术支持与服务”部分提供了更多的选

项。

更多支持
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确保可用性 3
3.1 简介

概述

本部分介绍了用于确保 PCS 7 系统可用性的措施。

有关容错系统的信息，可参考《过程控制系统 PCS 7；容错过程控制系统》(Process Control 
System PCS 7; Fault-Tolerant Process Control Systems) 手册。

本部分中的信息使您能够执行下列任务：

● 维护工厂的基准条件。

示例： 遵守维护时间间隔、更换电池

● 优化工厂并防止故障

示例： 进行固件更新、消除错误的已知来源

● 将故障导致的停工时间缩至最短

示例： 提供备份

读者注意事项

本部分分成了若干个主题区。 每个主题区都提供了以下信息：

内容 描述的内容

时间 执行此操作的时间

步骤 有关相关主题的信息，可参考题目为“...”的部分。

服务支持和诊断 (V8.1)
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内容

主题区 信息

数据备份 ● 内容： 有关在 PCS 7 工厂中备份和恢复数据的信息。 如果要恢复

组件或组态的状态（例如，因为硬盘损坏），则需要进行备份。

● 时间： 如果已在 PCS 7 工厂中进行了更改，则应该执行数据备

份。

● 方法： 有关创建数据备份的信息，可参考“数据备份选项 
(页 19)”部分。

硬件更新 如果更改硬件，SIMATIC 站可切换到 STOP 模式。

● 内容： 有关如何执行固件更新以及随后所需的组态步骤的信息。

● 时间： 如果要将组件转换为当前固件版本（例如，因为要使用新

功能或必须更正错误）。

● 方法： 有关固件更新的信息，请参阅“硬件更新 (页 40)”部分。

软件更新 如果更改软件，SIMATIC 站可切换到 STOP 模式。 
● 内容： 有关将项目从早期版本转换为当前版本的信息。 有两种类

型的软件更新：

– 利用新版本 PCS 7 中的新功能进行的更新

– 不利用新版本 PCS 7 的新功能进行的更新

● 时间： 
– 如果要利用新版本 PCS 7 的新功能。

– 如果要将 PCS 7 项目不断更新到最新的技术状态。

– 如果软件更正需要进行转换。

● 方法： 有关软件更新的信息，请参阅“软件更新 (页 60)”部分。

确保可用性

3.1 简介

服务支持和诊断 (V8.1)
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3.2 数据备份

3.2.1 数据备份选项

简介  

用户可通过多种方式并根据不同的用途来备份项目数据，例如，通过项目归档、映像文件。

系统出现故障后，可使用备份将系统快速恢复到其原始状态。

增强数据安全性的建议

● 在以下情况下始终对数据进行备份：

– 组态更改后

– 系统组件升级前后

– 组态软件升级前后

● 至少保留 PCS 7 项目的三个最新版本。

● 使用不同的存储介质来备份数据。

示例：

– LAN 硬盘

– USB 硬盘

– MOD
– CD/DVD
这样，即使设备出现故障，也能保持数据可用。

● 还可以在网络中 PC 的硬盘上备份数据。 几乎不可能出现多台 PC 上同时发生硬盘故障

的情况。

数据备份选项

以下各部分描述了数据备份选项：

备份 ES 项目数据

● 备份 SIMATIC 站的参数设置 (页 21)

● 归档 PCS 7 项目 (页 22)

● 重新获取 PCS 7 项目 (页 24)

● 归档和重新获取多重项目 (页 24)

确保可用性

3.2 数据备份
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● 归档自定义库 (页 26)

● 导出操作员文本和显示文本 (页 27)

● 备份自定义功能和操作 (页 28)

备份 OS 项目数据

● 备份 OS 组态数据 (页 29)

备份批生产数据

● 备份组态数据 (页 30)

● 生成备份 (页 31)

● 从备份恢复数据 (页 32)

● 归档批生产 (页 33)

备份 SIMATIC Route Control 数据

● 备份组态数据 (页 35)

● 备份 SIMATIC Route Control 的项目数据 (页 35)

● 从备份恢复数据 (页 36)

创建映像文件

● 通过生成映像文件来备份数据 (页 37)

说明

请确保将备份存储在受保护的地方（隔离室、防火柜等）。

请确保备份可读（尤其在使用可重用的存储介质时，如软盘）。

使用 Version Trail

Version Trail 是一款对项目、多重项目或库进行版本化归档和恢复的软件。 Version Trail 
具有以下功能：

● 在用户指定的时间备份对象。 
在版本化归档中输入备份对象时，会分配一个版本。 该版本是对象的唯一标识。

● 恢复和重用版本化项目数据

● 自动归档

● 自动回读

可以在 SIMATIC Manager 的在线帮助中找到此主题的更多相关信息。

确保可用性

3.2 数据备份
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3.2.2 备份 ES 项目数据

3.2.2.1 如何备份 SIMATIC 站的参数设置

简介

可以使用 PCS 7 OS 和工程师站在 SIMATIC 站中在线更改参数（例如，控制器设置）。 

在某些情况下，必须对 SIMATIC 站中的当前数据块、FB 或参数设置进行备份。 例如，在

从数据备份来恢复组态数据时。 

可以使用以下备份选项：

● 从 SIMATIC 站读取数据块和 FB

● 从 SIMATIC 站读取包含当前参数的图表

说明

这些操作将使用系统的当前值覆盖组态中的所有设置。 例如，确保正确保持设置的起始

值。

危险

读回数据

如果从 SIMATIC 站回读数据，必须确保在系统热启动后或下载组态数据后不出现任何

危险状况。

从 SIMATIC 站读取数据块和 FB

1. 在 SIMATIC Manager 中打开项目。

2. 选择菜单命令 视图(View) > 在线(Online)。

3. 在树形视图中，选择要从 SIMATIC 站读取的数据块和 FB。

4. 从菜单中选择 编辑(Edit) > 复制(Copy)。

5. 选择菜单命令 视图(View) > 离线(Offline)。

6. 从菜单中选择 编辑(Edit) > 粘贴(Paste)。

确保可用性

3.2 数据备份
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从 SIMATIC 站读取包含当前参数的图表

1. 在 SIMATIC Manager 中双击任意 CFC 图表，以启动 CFC 编辑器。

2. 选择菜单命令 图表(Chart) > 回读(Read Back)。

3. 在“回读图表”(Read Back Chart) 对话框中，进行以下设置：

– 源文件： CPU 的程序

– 范围： 具有 OCM 功能的参数

建议： 此时备份项目。 相关信息，可参考“如何将项目归档 (页 22)”部分。 

此数据备份包括了 SIMATIC 站的所有当前参数设置。

3.2.2.2 如何将项目归档

简介                       

您可以使用各种工具对项目数据进行归档。

在下文中，将使用 PKZip（PKZip 服务器）程序进行归档：

可在 SIMATIC PCS 7-DVD 中找到 PKZip 的安装程序。 PKZip 在 PCS 7 系统安装期间自

动安装。 

可以通过 SIMATIC Manager 启动 PKZip。

要求

● 已安装一款用于归档项目数据的工具（默认工具：  PKZip）。

在 SIMATIC Manager 中进行设置

1. 在 SIMATIC Manager 中，选择菜单命令 选项 (Options) > 设置 (Settings)。
“设置”(Settings) 对话框将打开。

2. 选择“归档”(Archive) 选项卡。

3. 从下拉列表框中选择“首选归档程序”(preferred archiving program)（默认程序为 PKZip）。

4. 选择以下“选项”(options)：
– Check options（检查选项）

– Check target directory on retrieval（重新获取时检查目标目录）

5. 可以在“在下列操作期间归档目录”(Archive directory during) 区域中选择归档或重新获取项
目的默认路径。

6. 单击“确定”(OK) 应用设置。

确保可用性

3.2 数据备份
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将项目归档

1. 在 SIMATIC Manager 中，选择菜单命令“文件”(File) >“归档”(Archive)
将打开“归档”(Archive) 对话框。

2. 选择“多项目”(Multiprojects)（或“用户项目”(User Projects)）选项卡。

3. 单击“浏览”(Browse)，然后从列表中选择要归档的项目。

4. 单击“确定”(OK) 保存设置。
将打开“归档 - 选择归档”(Archive - Select Archive) 对话框。

5. 针对归档进行以下设置：

– 在“保存”(Save) 下拉列表中，选择归档文件所在的驱动器和文件夹。

– 在“文件名称”(File name) 框中，输入保存归档文件应该使用的文件名。

建议：

项目归档文件的命名采用通过名称就可推断归档日期的方式。 示例： “年月日项目名

称”；091230 名称

6. 单击“保存”(Save) 以应用设置。
将打开“归档 – 选项”(Archive – Options) 对话框。

7. 如果要在软盘上归档项目，请选择磁盘的大小。
有关此对话框的更多信息，可单击“帮助”(Help) 进行查找。

8. 单击“确定”(OK)。
归档过程随即开始。

“归档”(Archive) 对话框关闭后，归档即完成。

写保护

说明

如果将项目直接复制到 CD/DVD 上，则所有文件和目录都将处于写保护状态。 再次使用

该项目前，需要去除项目中所有文件和文件夹的“只读”文件属性。

备份组态数据

还需要备份以下组态数据：

● 将 GSD 文件 (Siemens\STEP 7\S7Data\GSD) 备份到另一分区或另一驱动器

● 标准功能的 C 脚本

备份工程师站上的 PDM 组态数据

备份 PCS 7 项目时会自动备份 PDM 组态数据。

确保可用性

3.2 数据备份
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更多信息

有关产品版本的更多信息，请参见《过程控制系统 PCS 7；PCS 7 - 自述文件》(Process 
Control System PCS 7; PCS 7 - Readme) 文件（请参见“前言 (页 9)”）。

3.2.2.3 如何恢复项目

要求

● 已安装一款用于归档项目的工具（默认工具：  PKZip）。

● 已设置归档项目的工具所需的所有默认值（更多相关信息，请参阅“如何将项目归档 
(页 22)”部分）。

说明

可在 Process Control System; SIMATC PCS 7 DVD 上找到 PKZip  的安装程序。 PKZip 
在 PCS 7 系统安装期间自动安装。

步骤

1. 在 SIMATIC Manager 中，选择菜单命令“文件 > 恢复”(File > Retrieve)。
将打开“恢复 - 选择归档”(Retrieve -  Select Archive) 对话框。

2. 编辑归档文件的以下设置：

– 在“搜索范围”(Search in) 列表中：

输入用于项目归档的驱动器和文件夹。

– 在“文件名称”(File name) 框中：

输入用于归档项目的文件名称。

3. 单击“打开”(Open) 保存设置。
将打开“选择目标目录”(Select destination directory) 对话框。

4. 在列表中选择目标目录/项目目录。

5. 单击“确定”(OK) 应用设置。

“恢复”(Retrieving) 对话框关闭后，恢复完成。

3.2.2.4 如何归档并恢复多项目

简介                

可将多项目以压缩形式存储在归档文件中，方式与存储单个项目或库相同。 可以在硬盘或

移动式存储介质（如 ZIP 盘）上完成此操作。

确保可用性

3.2 数据备份
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如果多项目中的各个项目存储在网络中的多台 PC 上，则必须使用下列程序将此多项目归

档：

PKZip
该程序随 PCS 7（STEP 7 附件包）一起自动安装。

建议：

在工程师服务器上将该多项目归档。

归档多项目的要求

● 已安装一款用于归档项目数据的工具（默认工具：  PKZip）。 PKZip 在 PCS 7 系统安

装期间自动安装。

● 将多项目归档是一种跨项目功能。 因此，归档期间其它任何过程都不可对多项目中的任

何项目进行访问。

将多项目归档

1. 在 SIMATIC Manager 中选择多项目。

2. 选择菜单命令 文件(File) > 归档(Archive)。
将打开“归档”(Archive) 对话框。

3. 选择“多项目”(Multiprojects) 选项卡。

4. 通过单击“确定”(OK) 保存输入内容，以确认所选的多项目。

5. 针对归档进行以下设置：

– 在“保存到”(Save to) 下拉列表中：

选择驱动器和文件夹。

– 在“文件名称”(File name) 框中：

输入用于保存数据的文件的名称。

6. 单击“保存”(Save) 以应用设置。
将打开“归档 – 选项”(Archive – Options) 对话框。

7. 如果要在软盘上归档项目，请选择磁盘的大小。
有关此对话框的更多信息，可单击“帮助”(Help) 进行查找。

8. 单击“确定”(OK)。
归档过程将开始。

“归档”(Archive) 对话框关闭后，归档即完成。

恢复多项目 

1. 在 SIMATIC Manager 中，选择菜单命令 文件(File) > 恢复(Retrieve)。

2. 在下一个对话框中，选择归档的多项目。
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3. 单击“打开”(Open) 以保存输入内容。 
将打开“选择目标目录”(Select Destination Directory) 对话框。

4. 选择要用于解压缩归档的目标目录。 单击“确定”(OK)。
即会恢复多项目。 
完成恢复操作后，将打开“恢复”(Retrieve) 对话框。

5. 单击“确定”(OK)。
以下内容将显示在“恢复”(Retrieve) 对话框中。

– 被恢复项目的名称

– 打开项目的提示

6. 根据需要，单击“是”(Yes) 打开项目，或单击“否”(No) 关闭会话。

结果

在所选目标目录中自动创建一个子目录。 该子目录包含以下内容：

● 默认情况下： 多项目的名称

● 单独情况下： 派生自多项目名称的唯一目录名

子目录中将放置以下内容：

● 多项目

● 多项目中包含的项目

● 库（包括主数据库）

对某多项目进行恢复后，该多项目的所有项目目录均位于此目录下的同一级别。

3.2.2.5 如何将自定义库归档

简介

如果已在 PCS 7 中创建了一个自定义项目库，我们建议您将其归档。 针对每个要进行备

份的库，执行以下步骤。

步骤

1. 在 SIMATIC 管理器中，选择菜单命令 文件(File) > 归档(Archive)。 
将打开“归档”(Archive) 对话框。

2. 打开“库”(Libraries) 选项卡。

3. 单击“浏览”(Browse)，然后从列表中选择要归档的库。

4. 单击“确定”(OK) 保存设置。
将打开“归档 - 选择归档”(Archive - Select Archive) 对话框。
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5. 针对归档进行以下设置：

– 在“保存到”(Save to) 下拉列表中：

选择驱动器和文件夹

– 在“文件名称”(File name) 框中：

输入用于保存数据的文件的名称。

6. 单击“保存”(Save) 以应用设置。
归档过程将开始。

自定义画面文件夹

自 PCS7 8.1 起，打开项目编辑器时，“GraCS”项目文件夹中将自动创

建“PCS7CustomPictures”文件夹。可以在“GraCS”项目文件夹中为自定义画面创建其它

文件夹。

如果自定义画面文件位于“GraCS”项目文件夹或其子文件夹中，则为过程显示编译 OS 时
将使用自定义画面文件。 

更多详细信息，请参见文档《过程控制系统 PCS 7；操作员站》(Process Control System 
PCS 7; Operator Station) 组态手册。

3.2.2.6 如何导出操作员文本和显示文本

简介

为了在操作员站使过程可视化，请使用面板，例如，该面板会向工厂操作员显示测量值、

操作限制、元件和块操作员文本。 

如果更改了块中的操作员文本或显示文本，建议您对操作员文本和显示文本进行备份。

导出操作员文本和显示文本

在 SIMATIC Manager 中，可将与参数、信号和消息相关的信息导出到一个文件中（格

式： *.csv）。

可在标准的 MS 办公应用程序（如 Excel 和 Access）中编辑此文件。

用于导出的机制与用于转换为项目特定语言的机制相同。
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要求

PCS 7 允许您以各种所需语言来存储所有操作员文本和显示文本。 唯一的要求是该语言已

安装在项目中：

● 通过菜单命令选项 (Options) > 显示设备的语言 (Language for Display Devices) 可显

示 SIMATIC Manager 中可用的语言。

● 所提供语言的数目是在安装 Windows 时指定的（系统特性）。

过程

1. 在 SIMATIC Manager 中打开项目。

2. 在组件视图中，选择主数据库（如果其不可用，则选择项目文件夹）。

3. 选择菜单命令 选项 (Options) > 管理多语言文本 (Manage Multilanguage Texts) > 导出 
(Export)。
将打开“导出用户文本”(Export User Texts) 对话框。

4. 进行以下设置：

– 在“文本表”(Text Tables) 组中，设置导出文件的存储位置和格式（可用的格式包

括：  *.xls 和 *.csv）。

– 在“语言”(Language) 组中，依照显示语言设置源语言和目标语言。

5. 单击“确定”(OK)。

6. 如果必须管理多个项目特定的语言，则对于每种语言，请重复步骤 3 到步骤 5。 请注意，
随后必须设置不同的导出文件名称或目标目录。

3.2.2.7 如何备份自定义功能和操作

简介

PCS 7 使您可以通过创建自定义功能和操作在 OS 项目中创建动态序列。这些功能和操作

均以 ANSI-C 语言编写而成。

必须对已创建或修改的所有项目功能、标准功能、本地操作和全局操作进行备份。 

项目功能和标准功能

项目功能和标准功能的文件扩展名为 *.fct。默认情况下，PCS 7 将这些功能放置在下列文

件夹中：

● 项目功能位于 OS 项目的“\library”文件夹中。

● 标准功能位于 PCS 7 安装目录的“\aplib”文件夹中。

确保可用性
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本地操作和全局操作

本地操作和全局操作的文件扩展名为 *.pas。默认情况下，PCS 7 将这些操作放置在下列

文件夹中：

● 本地操作位于项目目录的“\<PC 名>\Pas”文件夹中。

● 全局操作位于 OS 项目的“\Pas”文件夹中。

更多信息

● WinCC 信息系统 在线帮助

3.2.3 备份 OS 项目数据

3.2.3.1 备份组态数据

简介

PCS 7 操作员站的组态数据会在归档多项目时自动进行备份。 不需要单独进行备份。

备份 OS 组态数据

默认情况下，PCS 7 操作员站的组态数据保存在下列文件夹中： ...\Siemens\WinCC
\WinCCProjects。

要备份数据，请在此文件夹中压缩项目路径并将其保存在适当的介质（例如 CD）上。

备份 OS PC 数据

OS 组态数据位于 PCS 7 工程师站上。因此，可使用映像来备份 OS 服务器 PC 或 OS 客
户机 PC。 相关信息，可参考“通过生成映像文件来备份数据 (页 37)”部分。

确保可用性

3.2 数据备份

服务支持和诊断 (V8.1)
维修手册, 11/2014, A5E32786003-AA 29



3.2.4 备份批生产数据

3.2.4.1 备份组态数据

数据备份选项        

SIMATIC BATCH 提供了多个选项用于备份和恢复项目数据。 

数据 备份操作的菜单命令 恢复操作的菜单命令

● 物料

● 库

● 基本配方

● 公式类别

● 公式

● 权限和角色

● 用户设置 (1)
● 项目设置

Options（选项）> Backup
（备份） 

相关信息，可参考“如何生

成备份 (页 31)”部分。

(2) 

Options（选项）> Restore
（恢复） 

相关信息，可参考“如何从

备份恢复数据 (页 32)”部分。

(3)

● 完成的批生产 选择批生产，在快捷菜单中

选择“归档”(Archive)

相关信息，可参考“如何将

批生产归档 (页 19)”部分。

-

(1)“用户设置”只能/只会备份到数据库副本中。

(2) 将数据保存到 SBB 文件（压缩的 XML 文件）中。

(3) 从 SBB 文件（压缩的 XML 文件）中恢复数据。

更多信息

● 手册《过程控制系统 PCS 7；SIMATIC BATCH》(Process Control System PCS 7; 
SIMATIC BATCH)
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3.2.4.2 如何生成备份

备份的元素

可使用“备份”(Backup) 命令备份所有组态的数据。 备份包括以下元素：

● 物料

● 库

● 基本配方

● 公式

● 权限和角色

● 项目设置

规则

说明

进行备份时，适用以下规则：

不可在正在生成备份的 BATCH 客户机上执行操作员输入。

过程

1. 在 BatchCC 中，选择菜单命令 选项 (Options) > 备份 (Backup)。

2. 如果项目中存在未归档的批生产，则必须确认未归档批生产的消息对话框。 在这种情况下，
单击“确定”(OK)。
将打开“另存为...”(Save as...) 对话框。

3. 在“文件名称”(File Name) 输入域中，输入备份文件 ("...".sbb) 的名称。

4. 在“保存到”(Save to) 输入域中为备份文件选择存储位置。

5. 单击“保存”(Save) 按钮。 
即会生成备份文件。

导入/导出助手

使用 IEA，可以将以下批生产对象导出到扩展名为 *.sbx 的文件或从该文件中导入：

● 库

● 基本配方

● 公式类别
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SIMATIC BATCH V6.1 或更高版本支持导出功能。

说明

出于性能考虑，导出/导入大型配方时，应仅导出/导入一个配方。

说明

所有引用对象（如库、物料和公式类别）均会包含在导出中。

此外还会包括属于公式类别的所有公式。

启动导入/导出助手 (IEA, Import/Export Assistant)

● 选择菜单命令“选项”(Options) >“导出”(Export) 从 BatchCC 启动导出助手。

● 选择菜单命令“选项”(Options) >“导入”(Import) 从 BatchCC 启动导入助手。

更多信息

● SIMATIC BATCH 手册

3.2.4.3 如何从备份恢复数据

简介

可从备份文件恢复数据并在 SIMATIC BATCH 控制中心 (BatchCC, BATCH Control Center) 
中更新批生产过程单元。

要求

BatchCC 中没有可用的批生产过程单元。

读取备份

1. 在 BatchCC 中，选择菜单命令 选项 (Options) > 恢复 (Restore)。
将打开“恢复”(Restore) 对话框。

2. 选择备份文件 ("...".sbb) 的存储位置。

3. 单击“打开”(Open)。
即会加载备份文件。
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更新批生产过程单元

1. 在 BatchCC 的树形视图中，选择批生产过程单元。

2. 选择菜单命令 编辑(Edit) > 更新过程单元(Update Process Cell)。
将打开“批生产过程单元 - ...”(Batch Process Cell - ...) 对话框。

3. 单击“确定”(OK)。
将打开“更新过程单元”(Update Process Cell) 对话框。

4. 逐行比较“当前过程单元”(Current process cell) 列和“新建过程单元”(New process cell) 列。 
必要时对它们进行重新排序。
更多相关信息，可参考手册《过程控制系统 PCS 7；SIMATIC BATCH》(Process Control 
System PCS 7; SIMATIC BATCH)。

5. 单击“确定”(OK)。
“更新过程单元”(Updating Process Cell) 对话框将打开，并在完成更新后自动关闭。

结果

在 BatchCC 中，备份文件中的数据被输入到批生产数据库中并可重新供工厂使用。

3.2.4.4 如何将批生产归档

长期归档

可将批生产归档在 BatchCC 的长期归档中。 根据 FDA 要求，长期归档用于长期存储批生

产数据。 

规则

● 只能归档已完成的批生产。

● 不可将长期归档中的数据用于恢复有问题的批生产数据或批生产结构。

确保可用性
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要求 

在 BatchCC 中预设了归档方法。

● “目录”方法：

归档文件保存在共享网络文件夹中。 SIMATIC BATCH 不使用任何特定的登录身份或密

码设置来访问此文件夹。

● “SQL Server”方法：

归档文件保存在 SQL 数据库中。 对于此方法必须有登录身份和密码；不会使用域规

范。

● “FTP 服务器”方法：

归档文件保存在 FTP 服务器中。 对于此方法必须有登录身份和密码；只有为登录身份

分配了域时，才需要域规范。

更多相关信息，请参考 SIMATIC BATCH 在线帮助。

将单个批生产归档

请按以下步骤将单个已完成批生产归档：

1. 在详细视图中选择要归档的批生产。

2. 右键单击以打开快捷菜单，然后选择菜单命令“归档”(Archive)。

将多个批生产归档

请按以下步骤将多个已完成批生产归档：

1. 从“详细信息”(Details) 快捷菜单中打开批生产概览列表。

2. 选择要归档的批生产。

3. 右键单击以打开快捷菜单，然后选择菜单命令“归档”(Archive)。

确保可用性
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3.2.5 备份 SIMATIC 路径控制数据

3.2.5.1 备份组态数据

数据备份选项        

SIMATIC Route Control 提供了下列选项，用于备份和恢复项目数据。 

● 可从 SIMATIC Route Control，通过 PCS 7 项目备份项目数据。 
更多相关信息，请参阅“如何将项目归档 (页 22)”部分。

● 可生成项目数据库所在分区的映像。

● 可以导出/导入 SIMATIC Route Control 的部分路径。

更多相关信息，请参见“如何备份 SIMATIC 路径控制的项目数据  (页 35)”部分。

更多信息

● 手册《过程控制系统 PCS 7；SIMATIC Route Control》(Process Control System PCS 
7; SIMATIC Route Control)

3.2.5.2 如何备份 SIMATIC 路径控制的项目数据 

简介 

本部分介绍了如何将 SIMATIC 路径控制中的部分路径单独备份到文件。

说明

可从 SIMATIC 路径控制备份带有离线项目数据的部分路径。 接口块是 PCS 7 项目的一部

分，在 PCS 7 项目归档期间对其进行备份。

准备数据库备份

进行备份前，必须始终在路径控制工程中执行下列步骤：

● 通过菜单命令 选项 (Options) > 检查一致性 (Check Consistency) 来检查数据库的一致

性。

● 通过菜单命令 选项 (Options) > 压缩数据库 (Compress Database) 来压缩数据库。

确保可用性
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创建备份

1. 在 SIMATIC Manager 中选择多项目/项目。

2. 选择菜单命令“选项”(Options) >“SIMATIC 路径控制”(SIMATIC Route Control) >“工程”
(Engineering)。
将打开“路径控制工程 - ...”(Route Control Engineering - ...) 对话框。

3. 选择菜单命令“选项”(Options) >“导出/导入 CSV”(Export/Import CSV) >“CSV 导出/导入向
导...”(CSV Export/Import Wizard ...)。
将打开“向导：  CSV 文件数据交换（导出/导入）”(Wizard:  CSV file data exchange (Export/
Import))。

4. 检查“目录”(Directory) 输入框中的路径。

5. 在“方向”(Direction) 组中，激活“RC 项目工程 >> CSV 文件（导出）”(RC project 
engineering >> CSV file(s) (Export)) 复选框。

6. 单击“继续”(Continue)。

7. 选中所有复选框。

8. 单击“继续”(Continue)。

9. 单击“完成”(Finish)。
即会导出文件。

更多信息

● 手册《过程控制系统 PCS 7；SIMATIC 路径控制》(Process Control System PCS 7; 
SIMATIC Route Control)

3.2.5.3 如何从备份恢复数据

简介 

从备份文件中恢复来自 SIMATIC 路径控制的部分路径。

导入备份

1. 在 SIMATIC Manager 中选择多项目/项目。

2. 选择菜单命令“选项”(Options) >“SIMATIC 路径控制”(SIMATIC Route Control) >“工程”
(Engineering)。
将打开“路径控制工程 - ...”(Route Control Engineering - ...) 对话框。

3. 选择菜单命令“选项”(Options) >“导出/导入 CSV”(Export/Import CSV) >“CSV 导出/导入向
导...”(CSV Export/Import Wizard ...)。
将打开“向导：  CSV 文件数据交换（导出/导入）”(Wizard:  CSV file data exchange (Export/
Import))。

4. 将打开对话框“向导： CSV 文件数据交换（导出/导入）”(Wizard:  CSV file data exchange 
(Export/Import))。
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5. 检查“目录”(Directory) 输入框中设置的默认路径。

6. 在“方向”(Direction) 组中，激活“CSV 文件 >> RC 项目工程（导入）”(CSV file(s) >> RC 
project engineering (Import)) 复选框。

7. 单击“继续”(Continue)。

8. 选中所有复选框。

9. 单击“继续”(Continue)。

10.单击“完成”(Finish)。
即会导入项目工程数据。

更多信息

● 手册《过程控制系统 PCS 7；SIMATIC 路径控制》(Process Control System PCS 7; 
SIMATIC Route Control)

3.2.6 创建映像

3.2.6.1 通过生成映像文件来备份数据

简介 

为了备份分区和硬盘数据，建议生成一个安装映像文件（例如，在重新安装后）。

映像文件

映像文件可映射备份介质（硬盘、逻辑驱动器）上的所有数据。 它用于备份分区或硬盘上

的数据。 许多可用于生成映像文件的软件包同样也提供了数据压缩功能。 

启动分区包含在备份中。 这使您能够保存所有 PC 设置，包括 Windows 系统设置。

可使用映像文件恢复 PC 中的所有数据，且只需很短的时间（例如，2 GB 数据大约需要 
10 分钟）。 发生故障时可以恢复整个 PC 安装内容。 

规则

● 必须使用同一硬件来恢复数据。

● 对于映像文件，请注意以下硬盘设置

（更多相关信息，可参考“管理操作系统 (页 137)”部分）：

– 分区大小

– 分区或硬盘的格式化（例如，NTFS、FAT32）

确保可用性

3.2 数据备份

服务支持和诊断 (V8.1)
维修手册, 11/2014, A5E32786003-AA 37



● 授权和许可证密钥不能包含在备份中。

● 映像软件必须与当前的操作系统兼容。

基本过程

1. 在生成映像前，将授权和许可证密钥移动到其它介质上（磁盘、分区等）。

2. 创建映像时，请按照映像软件制造商的说明进行操作。

更多信息

● 与所用映像软件相关的文档

3.2.7 比较项目版本

3.2.7.1 使用 VXM 比较项目版本

版本交叉管理器 (VXM, Version Cross Manager) 

版本交叉管理器是一个单独的应用程序，可作为选件订购。 利用版本交叉管理器可快速、

可靠地比较两个用户程序之间是否存在与下载相关的差异。 从而可以检测出是否对用户程

序做了更改，以及做了哪些更改。

确保可用性
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概述

比较内容 详细信息 调用方式 更多信息

不同项目版本用户程序中

的更改

CFC 图表

SFC 图表

在“开始”(Start) 菜单的 
Siemens SIMATIC 程序中： 
“STEP 7 > VXM - 比较版本”
(STEP 7 > VXM - Compare 
Versions)

组态手册《过程控制系统 
PCS 7；工程系统》(Process 
Control System PCS 7; 
Engineering System)

版本交叉管理器在线帮助

基于 XML 文件的用户程序

（例如，用于将过程控制项

目数据与规划数据进行同

步）

CFC 图表

SFC 图表

版本交叉管理器

●
使用 文件(File) > 导出...
(Export...) 生成的 XML 文
件。

● 通过使用 文件(File) > 与 
XML 文件比较...(Compare 
With XML File...) 来比较 
XML 文件。

版本交叉管理器在线帮助

确保可用性
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3.3 硬件更新

3.3.1 硬件更新

简介        

在本章节中，硬件更新指的是更改 SIMATIC 模块中的固件。 更新 SIMATIC 模块的固件在

下文中称为“固件更新”。

固件更新包括以下方面：

● 功能升级

● 操作系统增强

已发布模块

有关特定 PCS 7 版本的已发布模块的固件版本，可参考与所述版本对应的《PCS 7 - 已发

布模块》(PCS 7 - Released Modules) 文档。 

固件更新的要求

如果要使用新功能或更正错误，可能需要更新 SIMATIC 模块的固件。

检查模块的最新产品版本或固件版本

在下列情况下，需要检查模块的最新产品版本或固件版本：

● 更换模块时（例如，由于发生故障）

● 更改组态后要使用新功能时

请比较 PCS 7 早期版本的文档《PCS 7 - 已发布模块》(PCS 7 - Released Modules) 以了

解哪个 PCS 7 版本最先包括该功能。

确定产品版本或固件版本 

具有更新功能的模块：

● 可在具有更新功能的模块中找到下列标识符：

– 产品版本由十字标指示（以下实例中为： 产品版本 6）。

– 固件的原始版本由文本指示（以下实例中为： V3.0.2）。

确保可用性
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实例：

CPU 416-2

416-2XK02-0AB0

7

V3.0.2

X

98

● 固件更新交付时，会有一个显示当前固件版本的标签，可在已有的标签上粘贴该标

签。 完成固件更新后，请相应地更换模块标签以标识有效 FW 版本。 这样可确保设备

文档的统一性。

不能进行更新的模块：

● 如果只有制造商才能对模块执行更改，则模块外壳上仅显示产品版本（由十字标指示；

以下实例中为： 产品版本 10）。

实例：

PS 407 10A

407-0KA01-0AA0

 X 11

 12 13

有关进行固件更新的建议

请在适当时机（例如，在预定的工厂停机期间）定期执行这些固件更新。

最新固件版本的供给来源

可以从 Siemens 联系伙伴处请求最新固件版本的更新文件，或从 Internet (http://
support.automation.siemens.com) 下载这些文件： 如果无法访问该 Internet 地址，请联系

技术支持。

说明

更新文件以可执行的自解压文件 (.exe) 形式提供。 如果要连续更新各种模块版本的不同模

块类型，则必须按以下方式针对不同的 CPU 在不同的文件夹中解压缩这些更新文件：

● 模块的类型

● 产品版本

● 固件版本

确保可用性
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概述

以下章节描述了与硬件更新有关的主题： 

● 硬件更新后的调整 (页 42) 

● 更新 SIMATIC S7 CPU (页 42) 

● 更新接口模块 IM xxx (页 47) 

● 更新 CP xxx (页 51) 

● 处理 GSD 文件 (页 58) 

3.3.2 如何在硬件更改后进行调整

基本步骤  

硬件更改后往往需要对软件进行更改。 在 HW Config 中组态硬件更改。编译这些更改，

然后将数据下载到 CPU。 接下来可实际替换、删除或添加修改后的硬件。

步骤

1. 在 HW Config 中打开项目 (AS)。

2. 将对象（例如 CPU： 类型、固件版本 x.x）从硬件目录拖放到 AS 组态表中的相应插槽中。 
将出现下列消息： “Do you want to exchange component ... with component ...?（是否要使
用组件... 交换组件...？）”

3. 确认后，单击“是”(Yes)。

4. 选择菜单命令 站(Station) > 保存/编译(Save/Compile)。
也可以在后续工作期间执行编译。

3.3.3 更新 CPU

准备工作   

将所用模块的类型和制造日期与文档《PCS 7 已发布模块》(PCS 7 Released Modules) 中
的信息进行比较。

如果需要更换 CPU，请联系您的 Siemens 代理。

确保可用性
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更改 SIMATIC S7-410 CPU 的数量结构

相关信息，请参见“升级 CPU 410-5H 的系统扩展卡 (页 62)”部分。

CPU S7-400H 的固件更新

说明

在容错 PCS 7 系统中，(S7-400H) CPU 必须始终保持统一的硬件版本以及相同的固件版

本。

CPU 的更新功能

自以下固件版本起，可以按照下面介绍的步骤对固件进行在线更新：

● CPU S7-400H （自固件版本 4.5  起）

自固件版本 4.5 起，可在 RUN 模式下更新固件。

● CPU S7-400 （自固件版本 5.0  起）

对版本较旧的 CPU 进行固件更新时，始终需要使用存储卡。

组件 更新 CPU S7-400 更新 CPU S7-400H

具备外部 EPROM 刻录器的 PC 或用于对存

储卡进行编程的编程设备

X X

存储卡 Flash-EPROM；8 MB X X

STEP 7 X X

用于固件更新的文件（可从 Internet 获
得）。 

X X

3.3.3.1 如何为 CPU 执行固件更新（自 V5.0 起）

公司为用户提供了多个包含最新固件的文件 (*.UPD)，以更新 CPU 的固件。 将这些文件

下载到 CPU。 对于在线更新，不需要使用存储卡。 但仍可使用存储卡执行固件更新。 

确保可用性
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准备工作

将所用模块的类型和制造日期与文档《PCS 7 已发布模块》(PCS 7 Released Modules) 中
的信息进行比较。

如果需要更换 CPU，请联系您的 Siemens 代理。

要求

●  编程设备或 PC 上安装了 STEP 7 V5.3 或更高版本。

● 在编程设备/PC 上提供了用于固件更新的更新文件。

● 必须能在线访问（例如，通过 PROFIBUS、MPI 或工业以太网访问）要更新固件的 
CPU。 可从编程设备或 PC 的文件系统中获得包含最新固件版本的文件。 文件夹可能

只包含一个固件版本的文件。

说明

对于具有 PROFINET 接口的 CPU，可以通过工业以太网使用 PROFINET 接口更新其

固件。 通过工业以太网进行更新要比通过 MPI 或 DP 更新快得多（取决于所组态的波

特率）。

如果 CPU 通过 CP 连接至工业以太网，则可通过工业以太网更新其它 CPU 的固件。

HW Config 中的过程

请按以下步骤更新 CPU 的固件：

1. 在 HW Config 中打开包含要更新的 CPU 的站。

2. 选择 CPU。

3. 选择菜单命令“PLC > 更新固件”(PLC > Update Firmware)。

4. 在“更新固件”(Update Firmware) 对话框中单击“浏览”(Browse) 按钮，选择固件更新文件 
(CPU_HD.UPD) 的路径。
选择了文件之后，在“更新固件”(Update Firmware) 对话框的下方区域，将显示哪些模块以
及哪些固件版本适用于该文件。

5. 单击“运行”(Run)。
STEP 7 将检查 CPU 是否可以解释所选文件，如果可以，则会将此文件加载到 CPU 中。 
如果必须切换 CPU 的工作状态才可以执行此操作，则会弹出对话框提示您进行操作。

确保可用性
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SIMATIC Manager 中的操作步骤

该步骤与在 HW Config 中的操作步骤一致；此处的菜单命令也是“PLC > 固件更新”(PLC > 
Update Firmware)。 但 STEP 7 只会在执行某一功能时检查模块是否支持此功能。

说明

保护更新过程

在更新 CPU 期间会检查数据签名，以保护固件更新。 如果检测到错误，则原固件仍然有

效，新固件被丢弃。

保留固件更新后接收到的值

CPU 存储器复位后，将保留下列值：

● MPI 接口的参数（MPI 地址和最高 MPI 地址）。

● CPU 的 IP 地址

● 设备名称 (NameOfStation)

● 子网掩码

● 静态 SNMP 参数

使用操作系统更新卡更新 CPU

更多相关信息，可访问 Internet 地址：

http://www.siemens.automation.com/service (http://support.automation.siemens.com/
CN/view/zh/2774118) 

3.3.3.2 如何为 H-CPU 执行固件更新（自 V4.5 起）

自固件版本 V4.5.x 起，可以使用在线功能更改固件版本。

● RUN 模式下 H 系统的固件更新

● 不能在 RUN 模式下进行降级

自 V4.5 起在 RUN 模式下对 H-CPU 执行固件更新

通常来说，在 RUN 模式下执行固件更新时，固件版本只能升级为下一更高固件版本。 不
能在 RUN 模式下进行降级。 您还应阅读特定版本说明中提供的信息。 

确保可用性
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要在 RUN 模式下更新 H 系统的 CPU 的固件，请执行以下步骤： 

1. 确保 H 系统处于冗余状态且没有错误。

2. 在“硬件配置”(HW Config) 或“SIMATIC Manager”中选择一个 CPU。

3. 选择菜单命令“PLC > 更新固件”(PLC > Update Firmware)。 
将打开“更新固件”(Update Firmware) 对话框。 两个 CPU 都显示了部件编号、当前固件版
本、名称和安装位置。

4. 选择要加载到 CPU 中的固件文件。

5. 通过“运行”(Run) 按钮进行确认后，将打开具有以下内容的对话框： “警告 ... 将删除所有 
CPU 数据。是否继续？” (Caution ... all CPU data will be deleted. Do you want to 
continue?")。 
单击“是”(Yes)。

6. 可以在下一个对话框中激活“自动继续”(Automatically continue)。 
单击“下一步”(Next)。 在“运行”状态下启动固件更新。

7. 在两个 CPU 上完成固件更新。
检查两个 CPU 的运行模式和激活的固件版本。

对 H-CPU 降级

如果 S7-400H 中的 CPU 出现故障，请订购部件编号相同的新 CPU。 新 CPU 将附带最新

的固件版本。 该固件版本可能比之前的 CPU 的固件版本高。 在这种情况下，必须将新 
CPU 设回原固件版本。 

1. 将新 CPU 插入自动化系统中。

说明

不要将光缆连接至 H 系统的 CPU。

2. 在 HW Config 或 SIMATIC Manager 中选择该 CPU。

3. 选择菜单命令“PLC > 更新固件”(PLC > Update Firmware)。 
将打开“更新固件”(Update Firmware) 对话框。

4. 选择与原 CPU 版本相符的固件文件。

5. 将此文件下载到 CPU。 新 CPU 的固件版本现已与之前使用的 CPU 的固件版本相同。

6. 现在请为 H 系统的 CPU 连接光缆。 
启动此 CPU，将系统切换为“冗余”运行模式。

然后，即可在“运行”状态下将 H 系统的两个 CPU 升级为最新固件。

与非冗余系统固件更新的区别

进行实际固件更新后，将自动启动 H 系统自检。 此功能可能需要几分钟的时间。 具体时

间取决于装载存储器的大小（所插入存储卡的大小）以及工作存储器的大小。

确保可用性
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使用操作系统更新卡更新 H-CPU

更多相关信息，请参见以下 Internet 地址：

http://www.automation.siemens.com/service 

参见

S7-400H CPU 的操作系统更新 (http://support.automation.siemens.com/CN/view/zh/
6741018)

3.3.4 更新接口模块

3.3.4.1 更新接口模块 (IM, Interface Module)

简介         

PCS 7 中的接口模块 (IM) 为自动化系统的中央机架与分布式 I/O 之间的现场总线提供接

口。

准备工作

● 将所用接口模块的类型和版本与文档《PCS 7 已发布模块》(PCS 7 Released 
Modules) 中的信息进行比较。

● 如果需要更换接口模块，请联系您的 Siemens 代理。

● 对于某些接口模块可进行固件更新。 相关过程，可参考下面的“如何执行 IM 的固件更

新 (页 48)”部分。

接口模块或接口模块下行耦合器的更新功能

可对下列组件（接口模块或接口模块下行耦合器）的固件进行更新： 

组件 起始部件编号 起始固件版本

IM 152-1 6ES7 152-1AA00-0AB0 V2.02

IM 153-2 6ES7 153-2Bx00-0XB0  

IM 153-4 6ES7 153-4BA00-0XB0 V4.x

Y 耦合器 6ES7 197-1LB00-0XA0  

确保可用性
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组件 起始部件编号 起始固件版本

Y-Link 6ES7 197-1LA01-0XA0  

DP/PA-Link 6ES7 157-0AA82-0XA0 V4.x

对带有冗余接口模块的 SIMATIC 站进行固件更新

说明

在运行期间，可对带有冗余接口模块的 SIMATIC 400H 站中的接口模块实现固件更新。

3.3.4.2 如何完成接口模块 (IM, Interface Module) 的固件更新

简介

本部分描述了如何通过工业以太网更新接口模块 (Interface Module (IM)) 的固件。 

要求

要通过工业以太网执行该更新需要具备以下条件：

● 编程设备或 PC 上安装了 STEP 7 V5.3 或更高版本。

● 在编程设备/PC 上提供了用于固件更新的更新文件。

● 仅适用于 PROFIBUS DP 的接口模块：

CP 443-1 具有路由功能（请参见 HW Config： CP 的属性 > 列出了关于“路由”的简

述）。

● IM 已集成到 PCS 7 项目中。

步骤

1. 打开 SIMATIC Manager。

2. 在组件视图中，选择 IM 所在的 SIMATIC 站。

3. 双击详细信息窗口中的“硬件”(Hardware) 对象。
将打开 HW Config。

4. 选择要更新其固件的 IM。

5. 选择菜单命令 PLC >“更新固件”(Update Firmware)。
将打开“更新固件”(Update Firmware) 对话框。

6. 按照下表进行设置。

7. 单击“执行”(Execute)。 即会更新固件。

确保可用性
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“更新固件”(Update firmware) 对话框中的设置

设置 操作

固件文件

的位置

在“固件文件”(Firmware File) 组中，指定放置固件更新文件的文

件夹。 如果要进行搜索，可使用“浏览”(Browse) 打开资源管理

器。

“新”固件的激活 按照以下方式使用“下载后激活固件”(Activate firmware after 
download) 复选框来指定何时激活“新”固件：

● 如果新固件成功加载后 IM 要执行自动“复位”(RESET)，则请

选中“下载后更新固件”(Update firmware after download) 复选

框。 新固件将在重启后被激活。

● 清除“下载后更新固件”(Update firmware after download) 复选

框，以防止新固件加载后 IM 执行“复位”(RESET)。 只有在切

断电源后才能激活“新”固件。

通过 PROFIBUS DP 更新冗余系统中的固件

在更新了活动 IM 的固件后，“RESET”（复位）将自动触发两个 IM 的切换。 

确保可用性
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现在可以在冗余系统中更新第二个 IM。 必须分别对每个 IM 进行更新。 

说明

通过 PROFIBUS DP 在冗余系统中直接更新两个 IM 的固件

对于 V4.x 以上固件版本的 IM 153-2，正常操作期间可在冗余模式下同时更新两个 IM 的固

件。 STEP 7 支持该更新，并且更新对正在运行的应用程序没有任何影响。 通过 PROFIBUS 
DP 直接从编程设备/PC 更新冗余系统中的固件。

要求

● 具有 PROFIBUS 接口的编程设备/PC（例如： CP 5611)
● 编程设备/PC 直接与 PROFIBUS DP 相连接

● 编程设备/PC 上的 STEP 7 版本： 自 STEP 7 V5.4 起
● 在编程设备/PC 上提供了用于固件更新的更新文件。

● H 系统无错误并处于冗余模式下。

步骤

1. 在 SIMATIC Manager 中，选择菜单命令“选项 > 设置 PG/PC 接口...”(Options > Set PG/
PC Interface...)。

2. 选择 PROFIBUS 接口。

3. 单击“属性”(Properties) 按钮并根据组态的总线参数设置接口。

4. 在 SIMATIC Manager 中，选择菜单命令“PLC > 显示可访问的节点...”(PLC > Display 
Accessible Nodes...)。

5. 选择包含要更新的 IM 的工作站。

6. 选择快捷菜单命令“更新固件”(Update Firmware)。
将打开“更新固件”(Update Firmware) 对话框。 两个 IM 都显示订货号、当前固件版本和总
线地址。

7. 选择要加载到 IM 中的固件文件。

8. 单击“执行”(Execute)。 即会更新固件。

注

更新相应的 IM 后，由于重新启动的原因，工作站会短暂丧失冗余功能。

更新标识符

说明

在成功完成 IM 的固件更新后，请更新固件版本的标识符。 相关信息，可参考“硬件更新 
(页 40)”部分。

确保可用性
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3.3.5 更新 CP xxx

3.3.5.1 更新通讯处理器 (CP, Communication Processor)

简介

在 PCS 7 中，通讯模块 (CP, Communication Module) 用于将 SIMATIC 站连接到总线系

统。 通过更新固件，可以增强 CP 的属性，而无需更换硬件。

CP 的更新功能

发生固件更新时，将保留模块的特定属性。 固件更新不会更改 CP 的类型。

CP 类型 更新功能 部件编号

CP 341 所有版本均可更新  

CP 443-1 所有版本均可更新  

CP 443-5 Extended 所有版本均可更新  

概述

以下部分描述了更新固件的过程： 

● CP 341 固件更新 (页 52)

● CP 443-1 固件更新 (页 53)

● CP 443-5 Extended 固件更新 (页 55)

确保可用性
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3.3.5.2 如何实现 CP 341 的固件更新

简介

本部分介绍了如何更新 CP 341 的固件（6ES7 341-1xH01-0AE0 固件 V1.x）。 

注意

V2.x 及更高版本的固件

从固件 V2.x (6ES7 341-1xH02-0AE0) 开始，需要在 HW Config 中执行更新。

在 HW Config 中选择菜单命令“PLC > 更新固件...”(PLC > Update firmware...)。
更多相关信息，请参见《S7-300 CP 341 点对点通信、安装和参数分配》(S7-300 CP 341 
Point-to-Point Communication, Installation and Parameter Assignment (http://
support.automation.siemens.com/CN/view/zh/1117397)) 手册。

准备工作

● 将所用模块的类型和版本与文档《PCS 7 已发布模块》(PCS 7 Released Modules) 中
的信息进行比较。

● 如果需要更换 CP，请联系您的 Siemens 代理。

固件更新的要求

● 编程设备或 PC 上安装了 STEP 7 V5.3 或更高版本。

● 在编程设备/PC 上提供了用于固件更新的更新文件。

● 安装了随 CP 一同提供的版本不低于 V5.0 的软件包“点对点通信的组态软件包”
(Configuration package for point to point communication)。

● 有效参数分配存储于 HW Config 中，并已被下载到 CPU。

步骤

1. 打开 SIMATIC Manager。

2. 在组件视图中，选择 CP 341 所在的 SIMATIC 站。

3. 双击详细信息窗口中的“硬件”(Hardware) 对象。
将打开 HW Config。

4. 双击要更新其固件的 CP。
将打开 CP 的“属性”(Properties) 对话框。

5. 选择“常规”(General) 选项卡。

确保可用性
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6. 单击“参数...”(Parameters ...)。
将打开参数化接口的对话框。

7. 选择菜单命令“选项”(Options) >“固件更新...”(Firmware Update ...)
– 如果 CP 可用，将指示当前模块固件的固件版本 (Vx.y.z)。
– 如果 CP 上不存在固件，将显示一条相关消息。 例如，在固件更新中止时会发生这

种情况。 这时会删除旧的固件。 必须下载一个固件。

8. 在“固件文件”(Firmware File) 组中，指定放置固件更新文件的文件夹。 要搜索此文件夹，
通过单击“浏览”(Browse) 打开一个资源管理器窗口。
所选固件的版本即显示在“选定的 FW 版本”(Selected FW version) 下。

9. 将 CPU 切换到 STOP 模式。

10.单击“下载固件”(Download Firmware)，以开始到 CPU 的下载过程。

11.单击“下载固件”(Download Firmware) ，以确认下载过程。 
如果单击“取消”(Cancel)，下载将中止。 如果发生此情况，模块将无法运行。 
重新开始固件下载，以使模块再次运行。

说明

在删除旧固件之前，CP 将检查要下载的固件订货号是否允许使用。

结果

新固件安装在 CP 的操作系统存储器中。进度条和完成百分比指示安装进度为“完成”
(Done)。 一旦完成固件更新，模块即可直接运行。

3.3.5.3 如何实现 CP 443-1 的固件更新

准备工作  

● 将所用模块的类型和版本与文档《PCS 7 已发布模块》(PCS 7 Released Modules) 中
的信息进行比较。

● 如果需要更换 CP，请联系您的 Siemens 代理。

固件更新的要求

● 编程设备或 PC 上安装了 STEP 7 V5.3 或更高版本。

● 在编程设备/PC 上提供了用于固件更新的更新文件。

● 具有以太网卡的网络适配器（例如 CP 1613 和标准网络适配器）

确保可用性

3.3 硬件更新

服务支持和诊断 (V8.1)
维修手册, 11/2014, A5E32786003-AA 53



确定 CP 443-1 的 MAC 地址

更新固件时，必须要知道 CP 443-1 的当前 MAC 地址。

1. 打开 SIMATIC Manager。

2. 在组件视图中，从 SIMATIC 站下方选择要更新其固件的 CP 443-1。

3. 选择 CPU >“诊断/设置”(Diagnostics/Settings) >“模块信息”(Module Information)。

4. 单击“特殊诊断”(Special Diagnostics)。
将打开 NCM S7 诊断工具。

说明

如果 NCM S7 诊断未启动，则编程设备/PC 与 CP 443-1 之间的连接出现故障。 排除

故障。

5. 注意“工业以太网”下 CP 443-1 的 MAC 地址设置。

执行固件更新

说明

请注意以下几点：

● 如果无意寻址到不正确的 CP 类型，则在下载操作开始前将出现一条警告消息。 不过，如
果该消息被确认，则固件仍会下载到不正确的 CP 类型。

● 通过以下步骤，CP 上的所有数据均将被删除且无法恢复！

● 下载操作一旦开始，请勿将其取消。 如果执行此操作，CP 可能再也无法使用，并且必须将
其交送进行维修。

1. 在“开始”(Start) 菜单的 Siemens SIMATIC 程序中，选择：“STEP 7 > NCM S7 工业以太
网 > 固件加载程序”(STEP 7 > NCM S7 Industrial Ethernet > Firmware Loader)。
将打开固件加载程序对话框。

2. 单击“继续”(Continue)。

3. 在“步骤 1”(Step 1) 对话框中，设置更新文件的路径：

– 单击“浏览”(Browse)。
– 使用“选择文件”(Select file) 来选择所需的文件（例如，“<驱动器>:\TEMP

\Cp4435ba.fwl”）。

– 单击“打开”(Open) 按钮。

4. 单击“继续”(Continue)。

5. 在“步骤 2”(Step 2) 对话框中，设置“MAC 地址”(MAC address)。

6. 单击“继续”(Continue)。

7. 检查以下设置：

– “应用程序访问点”

– “已使用的接口参数分配”

确保可用性
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8. 请确保已在组态控制台中激活了正确的设置。

说明

访问点必须设置为“S7ONLINE CP xxxx(ISO)”。

9. 通过单击“下载”(Download) 激活固件更新。 

10.检查打开的 *.fwl 文件是否包含所需的 CP 固件更新。

发生下载错误时的操作过程

如果下载操作由于某错误终止，CP 上不会有任何 LED 亮起。

1. 切断机架电源，然后再次接通。

2. 重复加载操作。

如果 CP 对下载启动作出响应，但是下载操作未正常完成，原因可能是：

● 同一地址在工厂总线上被多次分配。

● 工厂总线上的负载过高。

说明

如果 CP 未通过组态的 MAC 地址对加载过程作出响应，则将通过标记的地址再次加载 
CP。

3.3.5.4 如何完成 CP 443-5 Extended 的固件更新

准备工作 

● 将所用模块的类型和版本与文档《PCS 7 已发布模块》(PCS 7 Released Modules) 中
的信息进行比较。

● 如果需要更换 CP，请联系您的 Siemens 代理。

确保可用性
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固件更新的要求

● 编程设备或 PC 上安装了 STEP 7 V5.3 或更高版本。

● 在编程设备/PC 上提供了用于固件更新的更新文件。

● MPI 电缆

说明

对于 CP 443-5 Extended 的固件更新，请确保以下事项：

● 如果要在转换后将使用 PROFIBUS 标准 DPV1 运行的设备连接到 PCS 7 系统，则必须
更换硬件（例如，CP 型号： 固件为 V5.1 或更高版本的 6GK7 443-5DX03-0XE0）。

● 此硬件要求使用特殊的设备驱动器。 
有关生成设备驱动器的信息，请参阅文档《过程控制系统 SIMATIC PCS 7；编程指南，
为 PCS 7 创建块》(Process Control System SIMATIC PCS 7; Programming Instructions, 
Creating Blocks for PCS 7)。

固件更新的准备工作

1. 请确保可在编程设备或 PC 上获得所需的固件更新文件。 
可从 Internet 获得用于固件更新的文件。 相关信息，可参考“硬件更新”部分。

2. 切断插入 CP 的机架的电源 (PS)。

3. 使用 MPI 电缆在编程设备或 PC 的 MPI 接口与 CP 的 PROFIBUS 接口之间建立直接连接。

4. 接通机架、编程设备或 PC 的电源。

5. 在“开始”(Start) 菜单的 Siemens SIMATIC 程序中，选择“SIMATIC NET > 设置 PG/PC 接
口”(SIMATIC NET > Set PG/PC Interface)。 
可使用此菜单命令建立到 CP 443-5 Extended 的访问路径。 
示例： 对 CP 5611 (FWL) 进行以下设置：

– 选择“FWL_LOAD”作为到 CP 443-5 Extended 的“应用程序访问点”。

– 选择具有补充“(FWL)”的 MPI 接口作为接口。

6. 单击“确定”(OK)。

7. 请确保编程设备上没有活动的应用程序。

8. 重启接口。

执行固件更新

说明

请注意以下几点：

● 通过以下步骤，CP 上的所有数据均将被删除且无法恢复！

● 下载操作一旦开始，请勿将其取消。如果执行此操作，CP 可能再也无法使用，并且必须将
其交送进行维修。

确保可用性
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1. 在“开始”(Start) 菜单的 Siemens SIMATIC 程序中，选择“STEP 7 > NCM S7 > 固件加载程
序”(STEP 7 > NCM S7 > Firmware Loader)。
固件加载程序的对话框打开。

2. 单击“继续”(Continue)。

3. 在“步骤 1”(Step 1) 对话框中，设置更新文件的路径。

– 单击“浏览”(Browse) 按钮。

– 使用“选择文件”(Select file) 来选择所需的文件（例如，“<驱动器>:\TEMP
\Cp4435ex.fwl”）。

– 单击“打开”(Open) 按钮。

4. 随后的三个对话框都通过单击“下一步”(Next) 进行确认，直到出现“步骤 4：  执行加载操
作”(Step 4:  Perform Load Operation) 为止。

5. 阅读“步骤 4： 执行加载操作”(Step 4: Perform Load Operation) 对话框中的信息。
在下表中，可找到所显示的下载操作状态。

6. 切断机架电源。

7. 单击“取消”(Cancel) 关闭对话框。

8. 重新建立最初的 PROFIBUS 连接。

9. 接通模块的电源。
CP 将执行自检，并准备好运行。

下载操作的状态

位置 显示 状态

在 PG/PC 的“固件加载

程序”(Firmware Loader) 
对话框中

对话框中的条发生变化。 下载过程正在进行。

在 PG/PC 的“固件加载

程序”(Firmware Loader) 
对话框中

显示消息“下载成功完成”
(Download completed 
successfully)。

下载过程已完成。

CP 443-5 Extended CP RUN LED 闪烁。 下载过程正在进行。

CP 443-5 Extended CP STOP LED 亮起。 下载过程已完成。

发生下载错误时的操作过程

如果下载操作由于某错误终止，CP 上不会有任何 LED 亮起。

1. 切断机架电源，然后再次接通。

2. 重复加载操作。

确保可用性
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3.3.6 处理 GSD 文件

3.3.6.1 处理 GSD 文件

简介

STEP 7 V5 会更严格地测试 GSD 文件（GSD = Device Master dataFfile，设备主数据文

件）。 但早期项目中的 GSD 文件会发生语法错误或不可解释性错误。 

对于 V 5.1 SP2 及更高版本的 STEP 7，针对语法错误和 GSD 问题提供了经过改进的帮助

文本。 

如果以下措施不成功，请联系设备制造商并请求获得一个新的 GSD 文件。 可从下表中找

到针对某些错误的解决方案：

确保可用性
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故障诊断

错误发生的时

间

错误消息 错误来源 补救措施

插入操作期间 “SIMATIC 400(1) 站”不支

持“MBK-P”节点的传输速

率“187.5 kbps”。

未显示条目“187.5_supp = 
1”。

1. 请联系设备制造商。

安装新 GSD GSD 文件的路径\文件名包含

语法错误。

无法解释文件。

Vendor_Name： 引号间的

字符数不得超过 32 个；不

允许使用特殊字符。

1. 创建文件的备份副本，然后

使用文本编辑器（如 
WordPad）将其打开

2. 检查 Vendor_Name。
3. 更正该名称，保存文件并再

次将其链接。

确定 GSD 文件

的名称和路

径：

通过 DP 从站的

对象属性

“SIMATIC 400(1)”站不支

持“MBK-P”节点的传输速

率“187.5 Kbps”。

传输速率中的十进制分隔符

必须输入为句点而非逗点。

1. 创建文件的副本。

2. 使用文本编辑器（如 
WordPad）打开原始文件。 
在传输速率中，将

“187,5_supp = 1”更改

为“187.5_supp = 1”。

3. 启动 HW Config，选择菜单

命令“选项”(Options) >“更

新目录”(Update catalog)。
备注：如果未出现条

目“187.5_supp = 1”，则不支

持该传输速率。 请联系设备制

造商。
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3.4 软件更新

3.4.1 软件更新

信息

● 有关 PCS 7 软件更新的更多信息，请参阅 
– 《过程控制系统 PCS 7；不使用新功能的软件更新》(Process Control System PCS 7; 

Software update without utilization of the new functions)
– 《过程控制系统 PCS 7；使用新功能的软件更新》(Process Control System PCS 7; 

Software update with utilization of the new functions)

● 有关运行期间更新冗余操作站的信息，请参见手册《过程控制系统 PCS 7；容错过程控

制系统》(Process Control System PCS 7; Fault-Tolerant Process Control Systems) 中
的“运行期间更新冗余 OS 指南”部分。

有关此内容的简要概述，请参见本文档的“运行期间更新 PCS 7 OS (页 73)”部分。

● 有关安装热修复软件的信息，包含在附带热修复软件的各自软件包中。

有关软件更新的信息

说明

请注意以下几点：

● 通过更新，现有软件包将被新版本的软件所取代。 确保选择新版本的最新软件包。

● 用户或许必须在软件包升级期间运行 PC 站： 
有时，必须在软件安装期间确认重启 PC。

● 如果要更新 PCS 7 项目，以最新版本的 PCS 7 替换先前版本的 PCS 7，请按照有关软件更
新手册中的说明操作。

– 《过程控制系统 PCS 7；不使用新功能的软件更新》(Process Control System PCS 7; 
Software update without utilization of the new functions)

– 《过程控制系统 PCS 7；使用新功能的软件更新》(Process Control System PCS 7; 
Software update with utilization of the new functions)

● 新版本软件的优点可能仅适用于相应的硬件。 
● 有关推荐的 PC 站硬件的信息，请参见《过程控制系统 PCS 7；PCS 7 自述文件》(Process 

Control System PCS 7; PCS 7 Readme)（Internet 版本）文档。

使用 SIMATIC Management Console

SIMATIC Management Console（以下称为 Management Console）是 SIMATIC PCS 7 
产品系列中的一款软件，用于集中管理 SIMATIC 软件产品。 

确保可用性
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可以在 PCS 7 安装程序中选择安装 Management Console。

相关信息，请参见文档《过程控制系统 PCS 7；SIMATIC Management Console》(Process 
Control System PCS 7; SIMATIC Management Console)。

确保可用性
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3.5 许可证和许可证密钥

3.5.1 安装和更新许可证密钥

有关处理 PCS 7 软件许可证密钥的信息，请参见《SIMATIC；自动化许可证管理器》

(SIMATIC; Automation License Manager) 文档。

升级软件包的许可证密钥

只有在相应 PC 站上提供了要更新的许可证密钥后，才能升级许可证密钥（升级许可证密

钥和 PowerPack 许可证密钥）。

升级 AS 410 (CPU 410-5H) 的许可证密钥

相关信息，请参见以下部分：

● “升级 CPU 410-5H 的系统扩展卡 (页 62)”部分

● “通过更换 System Expansion Card 升级 CPU 410-5H 的过程对象 (页 71)”部分

3.5.2 升级 CPU 410-5H 的系统扩展卡

3.5.2.1 基本步骤

有效性

本文档适用于升级 CPU 410-5H（自固件版本 8.1 起）的 PO 数量。 升级期间，将重新许

可 CPU 的 System Expansion Card 上的过程对象数量。

步骤

1. 订购升级
至少需要一个 CPU 410 扩展数据包才能进行升级。 
相关信息，请参见“订购 CPU 410-5H 的升级 (页 64)”部分。

2. 准备升级
相关信息，请参见“如何准备升级系统扩展卡 (页 65)”部分。

确保可用性
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3. 通过支持请求发送 PO-Activation-File
相关信息，请参见“如何发送 PO 激活文件 (页 66)”部分 

4. 执行升级
相关信息，请参见“如何执行系统扩展卡升级 (页 68)”部分。

系统扩展卡 (SEC)

已根据系统扩展卡可加载的最大过程对象数量对 CPU 410-5H 进行标定。 

将系统扩展卡插入位于 CPU 背面的插槽中。

CPU 410 Expansion Pack

此产品允许您对 CPU 410-5H 的系统扩展卡进行升级。 CPU 410 扩展数据包中包括以下

内容：

● 升级许可证 (COL) 

● 数据介质和相应的升级许可证密钥

要使用 CPU 410 扩展数据包，需要按步骤中的说明准备并执行升级。

PO-Activation-File

该文件包含所有相关信息，用于生成升级所需的具有新 PO 数量的 PO 发布文件。 该 PO 
激活文件由自动化许可证管理器创建且必须发送到 Siemens 客户支持部门。

说明

系统扩展卡和 PO 激活文件构成一个单位

系统扩展卡和 PO 激活文件在分配后即构成一个单位。 升级仅对此系统扩展卡有效。

Support Request

您需要创建支持请求，并以附件形式将 PO 激活文件发送到 Siemens 客户支持部门。 作
为回复，您将收到 PO 发布文件。

PO-Release-File

该文件用以升级到所需的 PO 数量。 必须通过自动化许可证管理器将该 PO 发布文件分配

给原始系统扩展卡，升级才会生效。 

将 PO 激活文件发送给 Siemens 客户支持后，可从客户支持获取 PO 发布文件。

确保可用性
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3.5.2.2 订购 CPU 410-5H 的升级

说明

升级过程对象 (PO) 的信息仅适用于类型为“自 V8.1 版本起的 CPU 410-5H”的 CPU。 

自动化系统需要许可证的过程对象 

在 SIMATIC Manager 中显示自动化系统需要许可证的过程对象数量：

在 SIMATIC Manager 中选择菜单命令“选项 > PCS 7 许可证信息”(Options > PCS 7 
License Information)。
在“PCS 7 许可证信息”(PCS 7 license information) 对话框中选择“过程对象 (AS RT PO)”
(Process objects (AS RT PO)) 选项后，将显示可以操作和监视并可以生成信息的对象。 
只有这些对象需要过程模式许可并需要许可证密钥“AS RT PO”。

通过 CPU 410 扩展数据包指定 PO 数量

如果要升级自动化系统需要许可证的过程对象数量，则至少需要一个 CPU 410 扩展数据

包。

● 升级 System Expansion Card 会增加 CPU 上的 PO 数量，具体如下：

系统扩展卡上的 PO 数量 + 所有 CPU 410 扩展数据包的 PO 数量  

● 一个 CPU 410 扩展数据包可能的大小：

– 100 个 PO
– 500 个 PO

● 遵守 CPU 的最大 PO 数。

更多信息，请参见“激活专家模式 (页 71)”部分。

● 对于冗余组态的自动化系统，必须正确选择 CPU 410 扩展数据包，使得 PO 总量在升

级后等分到两个系统扩展卡上。 
升级冗余组态的自动化系统时，各 CPU 410 扩展数据包的大小示例： 

AS 要扩展的 PO 数量 各 CPU 410 扩展数据包的可能大

小：

不可以

300PO 6 x 100PO 1x 100PO + 1x 500PO

500PO 2 x 500PO 或 10 x 100PO 1x 500PO + 5x 100PO

确保可用性
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订购 CPU 410 扩展数据包

可通过以下方式订购：

● 联系 Siemens 代理：

www.siemens.com/automation/partner (www.siemens.com/automation/partner)

● 在线订购：

www.siemens.com/industrymall (www.siemens.com/industrymall)

3.5.2.3 如何准备升级系统扩展卡

要求

● CPU 410-5H（自固件版本 8.1 起）

● 要升级其系统扩展卡的 CPU 必须已上电且运行正常。 使准备工作与 CPU 运行模式无

关。

● CPU 410 Expansion Pack:
CPU 410 扩展数据包的许可证密钥存储工程师站的可用驱动器上。

有关 CPU 410 扩展数据包的信息，请参见“订购 CPU 410-5H 的升级 (页 64)”部分

● 可以通过工程师站使用 PCS 7 项目访问要执行 PO 升级的 CPU。

准备升级（创建 PO-Activation-File）

1. 选择菜单命令“编辑 > 连接目标系统 > 连接/断开 AS 410...”(Edit > Connect target system 
> Connect/disconnect AS 410...)。
“连接目标系统”(Connect target system) 对话框将显示与自动化许可证管理器相连的自动
化系统的列表。

2. 如果要连接其它自动化系统，请单击“添加”(Add) 按钮。
将显示项目对话框。

– 在 PCS 7 项目中，选择要执行 PO 升级的自动化系统。

– 单击“应用”(Apply)。
在“我的电脑”(My Computer) 下将创建“SIMATIC PCS 7 AS 410”文件夹。 在该文

件夹中，自动化系统和“在线”(Online) 子文件夹可见。 自动化系统的最新 PO 数量

在“在线”(Online) 文件夹中显示。

3. 使用拖放功能将 CPU 410 扩展数据包许可证密钥传送至要执行 PO 升级的自动化系统的文
件夹。 
如果选择了错误的自动化系统，可以移动 CPU 410 扩展数据包的许可证密钥。

4. 在自动化系统的树形视图中，打开“在线”(Offline) 文件夹。

确保可用性
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5. 选择许可证。

6. 为自动化系统选择菜单命令“目标系统 > 升级”(Target system > Upgrade)。

说明

系统扩展卡和所选 CPU 410 扩展数据包组成一个单元

执行后续菜单命令“CPU > 升级”(CPU > Upgrade) 将确认所选组件（系统扩展卡和 CPU 
410 扩展数据包）的升级顺序。 
所选 CPU 410 扩展数据包的许可证密钥将删除，并且 PO 激活文件会在列表中显示。

系统扩展卡和 PO 激活文件在分配后即构成一个单位。 升级仅对此系统扩展卡有效。

您需要创建支持请求，并以附件形式将 PO 激活文件发送到 Siemens 客户支持部门。 相
关信息，请参见“如何发送 PO 激活文件 (页 66)”部分。

说明

PO 激活文件

● PO 激活文件将在工程师站的以下目录中自动创建：
Documents > Siemens > Automation > PCS 7 > Activations

● PO 激活文件的标准名称：
<项目名称>..<自动化系统的名称>..<CPU 的名称>..<日期_YYYYmmdd_hhmmss>.act
示例：Proj..AS1..CPU410-20140922_173055.act

更多信息

有关专家模式的信息，请参见以下文档：

● “激活专家模式 (页 71)”部分

● 自动化许可证管理器

参见

如何执行系统扩展卡升级 (页 68)

3.5.2.4 如何发送 PO 激活文件

要求

● 已为 CPU 410-5H 创建了 PO 激活文件。

● 计算机上的 PO 激活文件可用且计算机可访问 Internet。

确保可用性
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说明

PO 激活文件将在工程师站的以下目录中自动创建：

Documents > Siemens > Automation > PCS 7 > Activations

通过支持请求发送 PO 激活文件

1. 在 Internet 浏览器中打开以下 Web 页面：
http://www.siemens.com/automation/support-request

2. 步骤 1： 选择产品

– 在“产品/订货号”(Product/Order number) 输入字段中输入以下内容：CPU 410
– 单击“搜索”(Search)

在“产品系列”(Product range) 列表中，将看到“SIMATIC PCS7”条目。

– 选中“CPU 410”选项框。

– 选中“SIMATIC 授权/许可证的问题”(Problem with SIMATIC authorization/license) 复
选框。

– 单击“下一步”(Next)。

3. 步骤 2： 选择应用实例

– 在输入字段中输入以下内容： Upgrade CPU 410
– 单击“下一步”(Next)。

4. 步骤 3： 我们的解决方案

– 单击“下一步”(Next)。

5. 步骤 4： 描述问题

– 在必填字段中输入内容。

– 在“详细信息”(Details) 输入字段中输入以下内容：Request PO-Activation-File
– 在“附件”(Attachment) 区域，单击“浏览”(Browse)。

导航到在计算机上的 PO 激活文件。

选择 PO 激活文件并单击“打开”(Open)。
文件会以附件形式添加至支持请求。

可以通过一个支持请求发送多个 PO 激活文件。

– 单击“下一步”(Next)。

6. 步骤 5： 指定联系方式

– 在必填字段中输入内容。

– 单击“下一步”(Next)。

7. 步骤 6： 汇总和发送

– 检查输入的内容。 确保添加了所有附件。

– 单击“发送”(Send)。

确保可用性
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● 等待回复

您将在 48 小时内收到回复邮件。 邮件中包含一个用于各个已发送的 PO 激活文件的文

件。 此文件即为用于执行升级的 PO‑Release-File。
相关详细信息，请参见“Auto-Hotspot”部分。

3.5.2.5 如何执行系统扩展卡升级

要求

● 可以通过工程师站使用 PCS 7 项目访问要执行 PO 升级的自动化系统。 

● 为其将 PO-Activation-File 发送给 Siemens 的系统扩展卡已插入自动化系统。

● 已获取 PO-Release-File。

通过 PO 发布文件执行升级

1. 将收到的 PO 发布文件传送到工程师站的以下升级目录中：
Documents > Siemens > Automation > PCS 7 > Activations

2. 打开自动化许可证管理器。

3. 选择菜单命令“编辑 > 连接目标系统 > 连接/断开 AS 410...”(Edit > Connect target system 
> Connect/disconnect AS 410...) 。
“连接目标系统”(Connect target system) 对话框将显示与自动化许可证管理器相连的自动
化系统的列表。

4. 单击“确定”(OK)。
列表中将显示已连接的自动化系统。

5. 在树形视图中，打开已为其接收 PO 发布文件的自动化系统。

6. 使用拖放功能将 PO 发布文件传送到自动化系统的“在线”(Online) 文件夹。
将完成升级。 所需时间取决于自动化系统的负载。

7. 成功升级后，将删除升级目录中用过的文件（PO 发布文件和 PO 激活文件）。
自动化许可证管理器将显示更新后系统扩展卡的新 PO 数量。

更多信息

有关专家模式的信息，请参见以下文档：

● “激活专家模式 (页 71)”部分

● 自动化许可证管理器

确保可用性
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3.5.2.6 升级冗余组态的自动化系统

目标

为冗余组态的自动化系统增加 PO 数量。

要求

● 可以通过工程师站使用 PCS 7 项目访问要执行 PO 升级的 CPU。

● 要升级其系统扩展卡的 CPU 必须已上电且运行正常。 使准备工作与 CPU 运行模式无

关。

● 两个 CPU 系统扩展卡上的 PO 数量已平均分配。

基本步骤

1. 使用 CPU 410 扩展数据包，为两个 CPU 创建包含所需 PO 数量的 PO 激活文件。
更多相关信息，请参见以下部分：

– “订购 CPU 410-5H 的升级 (页 64)”部分

– “如何准备升级系统扩展卡 (页 65)”部分

2. 为此自动化系统执行升级。
相关信息，请参见“如何执行系统扩展卡升级 (页 68)”部分。

3.5.2.7 升级 CPU 包含不同 PO 数量的冗余组态的自动化系统

示例

在冗余组态的自动化系统中，一个 CPU 410-5H 已彻底损坏（例如，由于进水损坏）。

您想使用新硬件恢复系统。

初始状态：

● 可以使用具有不同 PO 数量（例如，100 个 PO 和 800 个 PO）的两个 CPU。 

● 由于各个 CPU 系统扩展卡上许可的 PO 数量不同，因此无法实现自动化系统的冗余操

作。

请按如下说明升级系统扩展卡。 

确保可用性
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建议

请避免在 CPU 系统扩展卡上许可不同 PO 数量的情况。 

● 如果在 CPU 失效时相应系统扩展卡仍然有效，可将失效 CPU 的系统扩展卡插入到替

代 CPU 中。 替代 CPU 将接收该系统扩展卡的许可证密钥和 PO 数量。

● 如果因 PO 数量不同导致不支持冗余运行，请将具有更多 PO 数量的 CPU 用作活动 
CPU（主站）。 

目标

通过 PO 升级实现冗余系统中的 PO 数量均等分配（例如，等于 800 个 PO）。

要求

● 可以通过工程师站使用 PCS 7 项目访问要执行 PO 升级的 CPU。

● 要升级其系统扩展卡的 CPU 必须已上电且运行正常。 使准备工作与 CPU 运行模式无

关。

基本步骤

1. 使两个 CPU 的 PO 数量相同：
使用 CPU 410 Expansion Packs 为 PO 数量较少的 CPU 生成 PO-Activation-File，从而在
升级后，该冗余组态的自动化系统的两个系统扩展卡具有相同的 PO 数量。 必须在“连接
目标系统”(Connect target system) 对话框中激活专家模式来创建 PO 激活文件。

2. 为此 CPU 进行升级。

注意

活动 CPU 的 PO 数量较少（主站）

如果该自动化系统中的活动 CPU（主站）的 PO 数更少，则在执行升级时，若多次出

现传输错误，此 CPU 会切换到 STOP 模式。

更多信息

● “订购 CPU 410-5H 的升级 (页 64)”部分

● “如何准备升级系统扩展卡 (页 65)”部分

● “如何执行系统扩展卡升级 (页 68)”部分

确保可用性
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3.5.2.8 激活专家模式

在某些情况下，可以强制升级 CPU 的系统扩展卡。 为此，需要打开自动化许可证管理器

中的“连接目标系统”(Connect target system) 对话框。

如果您能接受相关后果，则在以下情况下可选择“激活专家模式”(Enable expert mode) 复
选框：

情况 影响

要强制升级 CPU 的包含多余 PO 数
量的系统扩展卡。

● 升级操作将消除对此自动化系统的 PO 数限制。

● 多余的过程对象将丢失。

要在 CPU 系统扩展卡的 PO 数量各

不相同的冗余系统中执行升级。

如果该自动化系统中激活的 CPU（主站）具有的 
PO 数更少，则在重复发生传输错误时，此 CPU 会
切换到 STOP 模式。 

如果 PO 发布文件传输失败，您又能

确定该文件适合系统扩展卡，则您可

尝试强制升级。 

● PO 发布文件传输将成功完成。

● 如果再次发生错误，则必须重新同步系统扩展

卡。 请联系许可热线。 
● 如果传输错误反复发生，则 CPU 会切换到 STOP 

模式。 

3.5.3 通过更换 System Expansion Card 升级 CPU 410-5H 的过程对象

需要卸下 CPU 才能更换系统扩展卡 (SEC)。

说明

卸下 CPU 会删除 CPU 上的用户程序。

说明

冗余操作 
需要更换两个 SEC 才能进行冗余操作。 新 SEC 必须具有相同的 PO 数量。

确保可用性
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3.6 确定清单数据以及安装软件

确定清单数据

主题 详细信息 调用方式 更多信息

确定 PC 站的清

单数据

确定 PCS 7 工厂中 PC 站
的硬件和软件

在“开始”(Start) 菜单

的 Siemens 
SIMATIC 程序中： 
SIMATIC > 
SIMATIC 
Management 
Console

（需要许可证）

 

 

SIMATIC 
Management 
Console 的在线帮助

只能对装

有“SIMATIC 
Management 
Agent”服务的 PC 站
进行管理。

 

确定许可证 ● 确定许可证密钥

– 已安装

– 已使用

● 生成许可证报表

确定 PCS 7 工
厂的组件

确定组态的组件和可用的

组件

SIMATIC 
Management 
Console 的在线帮助

需要连接到工程师站

远程安装软件

说明

只能对装有“SIMATIC Management Agent”服务的 PC 站进行管理

● 安装并更新 SIMATIC 软件

● 组合安装的软件包 

● 安装软件包

确保可用性

3.6 确定清单数据以及安装软件
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3.7 更新运行中的 PCS 7 OS

简介               

为将当前的 PCS 7 过程控制系统从“较旧”版本更新为“较新”的 PCS 7 版本，可选择

在运行期间更新冗余 PCS 7 OS 组态。

更新 PCS 7 OS 包括下列任务：

● 准备工作

● 安装“新”软件

● 修改现有 PCS 7 过程控制系统所需的调试工作

运行操作期间更新 PCS 7 OS 有下列优点： 

● 不会中断 PCS 7 系统的运行。

● AS 不进入 STOP 模式。

● 操作员仍可监控自动化过程。

运行期间更新冗余 OS 

更多相关信息，可参考文档《过程控制系统 PCS 7；容错过程控制系统》(Process Control 
System PCS 7; Fault-tolerant Process Control Systems) 中的“运行期间更新冗余 OS 指
南”部分。

确保可用性

3.7 更新运行中的 PCS 7 OS
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确保可用性

3.7 更新运行中的 PCS 7 OS
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组态诊断条件 4
4.1 诊断的要求

要求

要确保有效诊断 PCS 7 系统的状态，必须满足几个要求。 最重要的要求如下： 

● 为组件启用了诊断。

● 组态期间激活诊断选项

有关组态诊断选项的信息

可从以下文档中了解主要组态：

● 组态手册《过程控制系统 PCS 7；工程组态系统》(Process Control System PCS 7; 
Engineering System)

● 组态手册《过程控制系统 PCS 7；操作员站》(Process Control System PCS 7; Operator 
Station)

● 《过程控制系统 PCS 7；维护站》(Process Control System PCS 7; Maintenance 
Station) 功能手册

● 手册 SIMATIC; SIMATIC PDM (Process Device Manager)

可以在这些手册的索引中搜索信息，方法是输入“Diagnostics……”作为关键词。

检查 PC 组件

● 使用 PCS 7 的软件工具（例如，维护工作站或 PC DiagMonitor）和操作系统检查 PC 
组件。

● 以下的组态操作有助于诊断 PC 组件：

组态的元素 参考文档

设备状态监视 组态手册《过程控制系统 PCS 7；操作员站》

(Process Control System PCS 7; Operator Station)

PC 诊断的诊断画面 组态手册《过程控制系统 PCS 7；操作员站》

(Process Control System PCS 7; Operator Station)
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组态的元素 参考文档

WinCC“系统信息”(System Info) 通
道

WinCC 信息系统在线帮助，“通信”
(Communication) >“系统信息”(System Info)

带有冗余 OS PC 的系统的诊断 组态手册《过程控制系统 PCS 7；操作员站》

(Process Control System PCS 7; Operator Station)

检查模块属性

1. 在 SIMATIC Manager 中打开项目。

2. 在组件视图中，选择 SIMATIC 站。

3. 双击详细信息窗口中的“硬件”(Hardware) 对象。
将打开 HW Config。

4. 双击要检查的模块。
将打开所选模块的属性对话框。

5. 浏览相应选项的各个选项卡。
根据模块类型激活诊断属性。
可在以下选项卡中找到可用的诊断选项：

– “诊断”(Diagnostics)
– “输入”(Inputs)
– “输出”(Outputs)
– “选项”(Options)

具备诊断属性的 SIMATIC 模块

下列组件可用于 PCS 7 具有诊断功能的模块：

● S7-400

● S7 300 模块

● ET 200M

● ET 200S

● ET 200iSP

● ET 200pro

● DP 从站

● DP/AS-i 连接器

● 诊断中继器

● 网络组件 (SCALANCE)

组态诊断条件

4.1 诊断的要求
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更多信息

● PC DiagMon 在线帮助

组态诊断条件

4.1 诊断的要求
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组态诊断条件

4.1 诊断的要求
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PCS 7 的消息概念 5
5.1 维护系统 - 消息概念

简介  

PCS 7 的消息系统和诊断选项用于访问系统状态。 有关 PCS 7 消息概念的信息，可参考

以下部分：

● PCS 7 消息系统 (页 81)

● 消息来源 (页 83)

● 确定消息来源 (页 84)

● 评估和解析消息 (页 85)

基本术语

在 PCS 7 消息概念中使用的一些基本术语定义如下： 

术语 定义

事件 事件会导致自动化系统中的数据状态发生变化。

例如，事件可以是如下所示： 
在过程值有变化时或达到指定的限值后，修改了自动化系统中的一个位。

组态确定哪些事件触发消息。

消息 消息由事件或消息帧触发。 存在以下几种消息类型： 
● 操作员输入消息

● 过程消息

● 运行消息

● 过程控制消息和系统消息

错误和故障 在 PCS 7 中，PCS 7 操作站的操作员控件和监视系统也用于显示过程中的

错误和故障。

● 错误： 对过程不造成干扰的组件（对象）状态（例如，有故障的显示

灯）。

● 故障：对过程造成干扰的组件（对象）状态（例如，有故障的电机）。
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更多信息 

有关消息系统的详细信息，可参考以下部分：

● 在 WinCC 信息系统中：

在“开始”(Start) 菜单的 SIEMENS SIMATIC 产品下选择菜单命令“WinCC 信息系统”
(WinCC Information System)，然后参阅“系统概述 > WinCC 如何运行”(System 
Overview > How WinCC Works) 之下的内容：

– PCS 7 OS 消息系统 (Message system of a PCS 7 OS)
– PCS 7 OS 归档系统 (Archive system of a PCS 7 OS)
– PCS 7 OS 报表系统 (Reports system of a PCS 7 OS)

● 组态手册《PCS 7 过程控制系统；操作站》(PCS 7 Process Control System; Operator 
Station) 中的“报警系统的设置”(Settings for the alarm system) 部分

● 在 SIMATIC BATCH 在线帮助中，可参考“批生产数据管理”(Batch Data Management) 
中的下列信息：

– 批生产报表

– 归档批生产

● 在 SIMATIC Route Control 在线帮助中，可参考“操作员监控”(Operator Control and 
Monitoring) 中的下列信息：

– 路径日志

PCS 7 的消息概念

5.1 维护系统 - 消息概念

服务支持和诊断 (V8.1)
80 维修手册, 11/2014, A5E32786003-AA



5.2 PCS 7 消息系统

PCS 7 消息系统

PCS 7 使用通过适当参数分配的块采集有关过程和过程控制系统状态的数据。 可通过适当

的程序影响对事件的响应。 

PCS 7 最重要的消息系统有：

● WinCC 操作员监控系统

● SIMATIC BATCH 批生产数据管理

在过程模式下（运行期间），两个消息系统在 PCS 7 OS 上都可用。

在 PCS 7 OS 的消息列表中的消息组态

在 PCS 7 OS 上显示的每个过程消息始终包含以下信息：

● 日期

● 时间

● 来源 (Origin)

● 事件 (Event)

● 消息类别

您可使用 PCS 7 OS 的“报警记录”(Alarm Logging) 编辑器修改要在 WinCC 中显示的特定

消息信息。

说明

组态 PCS 7 消息系统

● 组态消息时，可指定需要报告事件的状态。

● 自 PCS 7 V8.0 SP1 起，您可组态 PCS 7 消息系统。 您可以针对单个项目组态过程消息的
消息类别的重要性和显示。

PCS 7 的消息概念

5.2 PCS 7 消息系统
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信号跳变的消息准确性

说明

请注意消息系统的准确性。

如果在一个扫描周期内记录事件，这些事件会以错误的顺序在消息列表中显示。

补救措施： 有关此内容的相关信息，可参考功能手册《过程控制系统 PCS 7；高精度时间

戳》(Process Control System PCS 7; High-precision Time Stamping)。

更多信息

有关组态消息的详细信息，可参考下列手册：

● 组态手册《过程控制系统 PCS 7；工程组态系统》(Process Control System PCS 7; 
Engineering System)

● 组态手册《过程控制系统 PCS 7；操作员站》(Process Control System PCS 7; Operator 
Station)

● 有关菜单项组态 PCS 7 消息系统的详细信息，请参见 SIMATIC Manager 的在线帮助

PCS 7 的消息概念

5.2 PCS 7 消息系统
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5.3 消息来源

消息路径

根据组态的不同，消息可来源于 PCS 7 中的不同位置。 给每个消息一个时间戳。 由哪个

事件引发分配给消息的时间戳，这取决于消息来源的位置。 无论消息来源于何处，所有消

息在 PCS 7 OS 上显示和归档的处理方式都相同。

图 5-1 画面中的字母“A”代表 PCS 7 中的报警消息。

更多信息

有关组态消息的信息，可参考以下文档：

● 组态手册《过程控制系统 PCS 7；工程系统》(Process Control System PCS 7; 
Engineering System)

● 组态手册《过程控制系统 PCS 7；操作员站》(Process Control System PCS 7; Operator 
Station)

有关组态具有更高时间戳精度消息的信息，请参阅功能手册《PCS 7 过程控制系统；10 毫
秒时间戳》(PCS 7 Process Control System; 10 ms Time Stamping)。

PCS 7 的消息概念

5.3 消息来源
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5.4 如何确定消息来源

步骤 

1. 通过单击以下图标启用消息列表

2.  “激活/禁用自动滚动”(Activate/Deactivate Autoscroll)。

3. 在消息列表中，选择需要从中获得更多相关信息的消息。

4. 单击“打开信息文本”(Open Infotext)。

5. 记下消息号并使用“报警日志”(Alarm Logging) 确定消息来源。

PCS 7 的消息概念

5.4 如何确定消息来源
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5.5 解析消息

5.5.1 简介

概述

有关解析 PCS 7 消息概念的重要信息，可参考以下部分：

● 消息列表和归档中的消息类型 (页 86)

● 消息的目标组 (页 87)

● 过程模式中的消息列表 (页 87)

● 消息缓冲区的溢出 (页 89)

● 消息优先级 (页 89)

● 影响消息 (页 90)

PCS 7 的消息概念

5.5 解析消息
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5.5.2 消息列表和归档中的消息类型

消息列表和归档中的消息类型 

可将消息划分为如下类别： 

术语 定义

操作员输入消息 操作员输入消息在操作员控制过程变量（例如更改控制器的运

行模式）时生成。 
● 如果使用库中已准备好的面板，则 PCS 7 自动生成操作员

输入消息。

● 如果在 PCS 7 项目中使用根据《PCS 7 过程控制系统；块

编程指令》(PCS 7 Process Control System; Programming 
Instructions for Blocks) 文档创建的面板，这些面板可生成 
PCS 7 兼容的操作员输入消息。

过程消息 在自动化过程中发生过程事件时就会生成过程消息，例如越限

和操作消息。

● 过程消息是为各块预定义的，因此无需组态。 根据需要，

可在 CFC 块的对象属性中修改消息文本和消息优先级。 也
可在过程对象视图中集中进行这些修改，或通过导入/导出

操作进行这些修改。

● 操作消息是过程消息的一个子集。 它们发出过程值的信号，

这些过程值可用于评估与过程相关的组件，例如运行时间计

数器。

过程控制消息 过程控制消息在 PCS 7 检测到本系统范围内组件的错误并发出

信号时生成。此类错误的范围从组件故障到已连接 I/O 信号的

断线消息。

过程控制消息由 PCS 7 中的驱动程序块生成，且无需组态。

系统消息

系统消息是由设备的自诊断触发的消息。 系统消息通常包括在过程控制消息或过程消息

（操作消息）中。

PCS 7 的消息概念

5.5 解析消息
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5.5.3 消息的目标组

目标组

消息类型 目标组： 过程管理 目标组： 操作管理和

记录

目标组： 系统专家和

维护专家

操作员输入消息 X X X

过程消息 X X X

运行消息 X X X

过程控制消息  X X

系统消息   X

5.5.4 过程模式中的消息列表

消息列表

PCS 7 将进入消息放置在消息列表中。 将根据事件源和报警状态在不同的报警列表中提供

消息。

默认情况下，可使用以下消息列表。 可修改这些标准消息列表或创建其它消息列表。

默认消息列表

列表 内容

进入报警列表 进入报警列表包含需要确认的报警，不过，这些报警仍然待确认或待禁

用。

已确认报警列表 已确认报警列表包含已确认的过程报警。

离开报警列表 离开报警列表包含标记为“离开”(Outgoing) 的报警。 这些报警将不再

激活，但尚未经过确认。

历史列表 
(History list)

历史列表提供包含所有报警（除操作员日志之外）的报警日志的视图。

PCS 7 的消息概念

5.5 解析消息
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列表 内容

过程控制列表 过程控制列表提供依据过程报警（和类似报警）过滤的报警日志的视

图。 

实例： 机架故障

过程报警也将显示在以下列表中：

● 进入报警列表

● 已确认报警列表

● 离开报警列表

● 历史列表

操作列表 操作列表提供报警日志的视图。 操作列表包含操作员日志。

实例： 
● 操作员已将控制器设定值设置为 5 巴
● 操作员已激活驱动器

下图说明了消息在消息列表中的路径。

报警日志

所有报警、操作员信息和状态变化均被保存在报警日志中。 可以使用过滤器从报警日志读

取特定信息。

PCS 7 的消息概念

5.5 解析消息
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5.5.5 消息缓冲区的溢出

消息缓冲区的溢出

整个 PCS 7 系统的每个组件能处理的消息有限。 如果在某个具体时限内，组件（例如 
AS）中生成的报警超过了该组件的处理能力，则会丢失其中一些报警。 如果发生这种情

况，AS 将置位溢出标志且在 PCS 7 OS 中将报告以下事件： “NRMS7 消息丢失”(NRMS7 
Messages Lost)。

说明

如果触发消息的事件连续快速地改变状态，则可能引发消息蜂拥而至。 这就不再能够完全

确保设备状态的总览。

更多信息

激活“Messaging Triggered by Acknowledgment（通过确认触发消息）”功能可防止消息

蜂拥而至。 有关组态的信息，可参考组态手册《过程控制系统 PCS 7；工程系统》(Process 
Control System PCS 7; Engineering System)。

5.5.6 消息优先级

更改消息优先级

在 PCS 7 中，可向每个消息分配优先级。0 为最低优先级，16 为最高优先级。新生成发

送信号块时，其消息最初具有最低优先级（0）。

有如下多种更改优先级的方法：

● 在块的对象属性中

● 在过程对象视图中

● 通过导入操作

PCS 7 的消息概念

5.5 解析消息
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规则

● 仅在将消息号范围定义为“在整个 CPU 中唯一”(Unique for Entire CPU) 时，才能指定

消息优先级。

● 在 PCS 7 OS 中，具有最高优先级的未经确认消息始终显示在总览上方的消息行中。如

果出现具有相同优先级的多个消息，则在该行中显示最近的消息。

● 可按优先级过滤列表。

更多信息

有关组态消息优先级的信息，可参考组态手册《过程控制系统 PCS 7；操作员站》（Process 
Control System PCS 7; Operator Station）。

5.5.7 影响消息

选项

PCS 7 有以下选项,用于影响消息：

● 消息抑制

– 可抑制带有 CFC 组态的单个块消息。

– 在过程模式中，可使用“抑制消息”(Suppress message) 复选框在面板中直接抑制各

消息。

● 锁定和发布块和 OS 区域的消息

当工厂操作员想要锁定可中断功能块或 OS 区域的所有消息时，可使用锁定（和发布）

块和 OS 区域的消息。

● 隐藏和显示消息

在过程模式中，可隐藏单个消息，以减少显示的消息数量。 在历史列表中输入消息。 
下列变更可用于隐藏和显示 PCS 7 中的消息：

– 在过程模式中手动隐藏和显示消息

– 在过程模式中自动隐藏和显示消息

PCS 7 的消息概念

5.5 解析消息
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更多信息

● 组态手册《过程控制系统 PCS 7；操作员站》（Process Control System PCS 7; 
Operator Station）

● 组态手册《过程控制系统 PCS 7；工程系统》（Process Control System PCS 7; 
Engineering System）

● 手册《过程控制系统 PCS 7 OS 过程管理》（Process Control System PCS 7 OS 
Process Management）

PCS 7 的消息概念

5.5 解析消息
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PCS 7 的消息概念

5.5 解析消息
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故障 - 下一操作 6
6.1 发生故障时的措施

发生故障时的基本操作过程                

1. 评估有关下列方面的消息：

– 时间

– 顺序

– 信息来源

2. 确定故障发生的位置和区域。

说明

如果使用的组件不具备诊断功能，则仅发出次要的故障信号。

– 使用诊断工具分析故障。 使用诊断工具可实现下列操作：

查找故障原因。

或

验证推测的故障原因。 
– 有关下列信息，可参考“PCS 7 的诊断”(Diagnostics for PCS 7) 部分以获得支持：

PCS 7 可用的诊断工具

视子系统而定的各种诊断工具的应用程序

说明

如果无法根据可用信息找到问题的解决方案，请联系经验丰富的专业人员获取帮助。

有关此主题的信息，请参见本文档的“更多支持 (页 15)”部分。

3. 确定要执行的操作。
在运行的工厂中：检查是否需要停机。

说明

请注意以下事项：

● 只能由合格的专业人员在遵守法律规定和工厂特定规定的前提下执行下列操作：

– 更改组态

– 更换和更改组件

● 请记住，激活后工厂可能会发生异常情况。 请确保组件和次级系统的激活在小心谨慎的
控制之下。
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原因实例

故障 可能的原因 初始诊断

CPU 故障 ● 由内部错误导致的故障

● 由外部错误导致的故障

CPU 诊断

CP 故障 ● 由内部错误导致的故障

● 由外部错误导致的故障

模块诊断 (Module Diagnostics) 
> 特殊诊断 (Special 
Diagnostics) > NCM S7 诊断 
CP... (NCM S7 Diagnostics 
CP...) >

信息来源：

● “模块”(Module) 文件夹

● “运行模式”(Operating 
mode) 文件夹

● “诊断缓冲区”(Diagnostic 
buffer) 文件夹

I/O 模块故障 ● 由 SIMATIC 站组件导致的故障

● 由外部影响导致的故障（如，模

块终端上出现短路）

模块诊断 (Module diagnostics) 
> 状态信息(Status information)
以及诊断信息（如可用） 

PC 组件故障 如果 PC 正在运行：

● 由事件导致的故障

● 连接故障

如果 PC 出现故障：

● 维修/更换

● 恢复数据

故障 - 下一操作

6.1 发生故障时的措施
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6.2 为专业人员支持做准备

6.2.1 有关故障原因的信息

简介

主题区 信息

为专业维修人

员提供支持

● 操作：为专业人员提供进行故障分析所需基本信息时所用的操作。

● 时间：如果发生故障时需要专业人员支持，向其提供有关工厂或有故

障组件的基本信息可有助于他们的工作。

● 方法： 相关信息，可参考本部分。

概述

可通过向专业维修人员提供信息来支持他们的工作：

● 专业维修人员需要有关工厂以及有故障系统的信息，以便提供快速支持。 
更多相关信息，请参阅下面的“设备文档 (页 95)”部分。

● 专业维修人员需要来自 CPU 的诊断缓冲区的信息，以便分析产生 CPU 故障的原因。

更多相关信息，请参阅下面的“如何读取 CPU 诊断缓冲区 (页 96)”部分。

● 内存信息转储有助于分析 CPU 故障的原因。

更多相关信息，请参阅下面的“CPU 故障 - 准备诊断 (页 97)”部分。

● 备份诊断文件有助于分析 OS 故障。 
更多相关信息，请参阅下面的“如何备份 PCS 7 OS 的诊断数据 (页 99)”部分。

● 可以采取所有必要措施以实现通过“远程访问”进行远程诊断。

更多相关信息，请参阅下面的“PCS 7 系统的远程诊断 (Remote diagnostics of a PCS 
7 system) (页 99)”部分。

6.2.2 设备文档

维护系统信息 

有关系统组件的信息是成功完成维修所需的最重要信息之一。

故障 - 下一操作

6.2 为专业人员支持做准备
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在以下情况下需要使用此信息：

● 规划维护时

● 拨打求助热线时

不间断维护此信息会缩短因故障导致的停工时间。 因此，请始终使包含下列数据的列表

（例如，在数据库中或表格中）保持最新：

● 工厂 (Plant)

● 单元 (Unit)

● 在工厂中的位置

● 组件

● 版本

– 硬件（版本，如果进行替换）

– 固件

– 软件

– S7 程序中使用的库

6.2.3 如何读取 CPU 诊断缓冲区

保存诊断数据         

将准备好的诊断缓冲区的内容另存为服务数据（自固件版本 V4.0 起）有助于维修工程师对

有故障的 CPU 执行初始诊断，也可以采用以下格式：

● HEX 格式

● TXT 格式

要求

CPU 处于 STOP 模式。

步骤

1. 在 SIMATIC Manager 中选择有故障 CPU。

2. 自固件版本 V4.0 起：
选择菜单命令“CPU > 保存服务数据”(CPU > Save service data)。 
指定存储位置和名称。 保存文件。

故障 - 下一操作

6.2 为专业人员支持做准备
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3. 选择菜单命令 PLC > 诊断/设置(Diagnostics/Settings) > 模块信息(Module Information)。
将打开“模块信息 - 在线”(Module Information - Online) 对话框。

4. 选择“堆栈”(Stacks) 标签并读出以下系统内存：

– 块堆栈（B 堆栈）

– 中断堆栈（I 堆栈）

5. 将这些数据提供给维修工程师。

6.2.4 CPU 故障 - 准备诊断

简介  

以下信息对分析 CPU 故障非常重要：

● 有关受影响 CPU 的信息

● 发生故障时的信息或操作

规则

警告

请注意以下几点：

● 只有经过培训的维修人员才有权操作过程控制系统。

● 对系统进行更改时，请始终遵守工厂特定规则和政府法规。

● 请遵守工厂特有限制条件并相应地对工作进行调整。

● 请始终记住，对系统的更改可能会影响系统的其它部分。

有关受影响 CPU 的信息 

发生 CPU 故障时，需要以下信息：

● 订货号

● 固件版本 (Firmware version)

● 硬件版本 (Hardware version)

故障 - 下一操作

6.2 为专业人员支持做准备

服务支持和诊断 (V8.1)
维修手册, 11/2014, A5E32786003-AA 97



如果可从工程师站访问 CPU，则可通过模块信息查询此信息。 更多相关信息，请参阅“模

块信息 (页 166)”部分。

说明

如果对包含所有模块信息的列表不断进行更新，可有助于发生故障时的故障诊断并可减少

排除故障的所需时间。

发生故障时的信息

发生故障时，需要以下信息：

● 导致故障的操作以及活动/事件历史

● CPU 前端 LED 显示灯指示的状态（如 RUN）

只有 RUN LED 亮起

SIMATIC 站正在无错状态下运行。

RUN LED 以及附带的红色 LED 亮起

SIMATIC 站中发生了故障。 使用诊断工具进行分析。 更多相关信息，请参阅“CPU 的诊

断 (页 118)”部分。

STOP LED 亮起 

● 如果 STOP LED 亮起，请读出诊断缓冲区。 有关此步骤的更多信息，请参阅“如何读

取 CPU 诊断缓冲区 (页 96)”部分

将诊断缓冲区信息保存到 HEX 文件和 TXT 文件！

● 可由经过培训的专业维修人员来分析这些数据。 这些数据包含有关故障原因的信息，例

如：

– I/O 错误

– H-CPU 的同步错误

● 如果 I/O 中的硬件错误可能导致 CPU 切换到 STOP 模式，请保存相关模块和关联总线

接口模块（如，CP 443-5）的诊断缓冲区内容。

● 生成内存信息转储。

所有 LED 都熄灭或都闪烁

可通过 CPU 前端的下列 LED 显示灯来识别“CPU 故障”状态：

● 所有 LED 都闪烁。

● 所有 LED 都熄灭（即使电源已接通）。

故障 - 下一操作

6.2 为专业人员支持做准备
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要获取其它支持，请联系您的 Siemens 代理或技术支持。 请准备好上述的“发生故障时

的信息”。

6.2.5 如何备份 PCS 7 OS 的诊断数据

基本步骤     

建议您备份供专业人员用于分析 OS 故障原因的诊断文件。 

备份诊断文件夹

1. 关闭 WinCC。

2. 备份 WinCC 的所有诊断文件夹
（默认路径： [安装路径]\Siemens\WinCC\Diagnostics）。

3. 将该信息提供给维修人员。
可以使用快捷菜单命令“保存到”(Save to) >“压缩的文件夹”(Compressed (zipped) Folder) 
备份诊断文件。

说明

一旦备份了诊断文件（并非在诊断文件夹中），即可删除诊断文件夹的内容。 这样，可

避免在新诊断文件中仍保留旧的信息。 
如果下次启动 WinCC 时发生同样的错误，请另外进行备份以帮助专业人员分析。 在此

备份中仅需对少量消息进行分析。

6.2.6 PCS 7 系统的远程诊断 (Remote diagnostics of a PCS 7 system)

安全性要求

如果要在 PCS 7 系统中执行远程诊断，则必须保护此工厂免受未经授权的访问。

您需要采取几项措施以落实安全性理念。 只有全面的安全措施才能够为系统提供最佳保护。

更多相关信息，请参见白皮书《PCS 7 和 WinCC 中的安全性理念 - 基本文档》(Safety 
Concept in PCS 7 and WinCC - Basic Document)。

故障 - 下一操作

6.2 为专业人员支持做准备
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传输路径

可沿以下路由传输数据：

● 电话线（调制解调器）

● 网络连接（例如，工厂的内部 TCP/IP 连接）

PCS 7 工厂的远程诊断和远程管理的可选方式

对于 PC 站，建议您使用以下工具对 PCS 7 工厂进行远程诊断和管理访问：   

● VNC
自 PCS 7 V8.0 起，“RealVNC”Enterprise Edition 软件经认证，可用于远程服务访问。

● RDP
远程桌面协议（RDP，Remote Desktop Protocol）仅允许用于远程维护 PCS 7 客户

端。 而且，在这些计算机上不可以运行任何服务器服务（例如，WebNavigator 服务

器、DataMonitor 服务器、OPC 服务器）。

有关更多信息，请参见安装手册《过程控制系统 PCS 7；PCS 7 - PC 组态》(Process 
Control System PCS 7; PCS 7 - PC Configuration)。

更多信息

● 白皮书《PCS 7 和 WinCC 中的安全性理念 - 基本文档》(Security Concept PCS 7 and 
WinCC - Basic Document) 中的“安全性要求”部分。

● 安装手册《过程控制系统 PCS 7；PCS 7 - PC 组态》(Process Control System PCS 
7; PCS 7 - PC Configuration)

6.2.7 使用 OS Web 选件进行交互式操作员监控

使用 OS Web 选件对 PCS 工厂进行交互式操作员监控 

使用 OS Web 选件对 PCS 工厂进行交互式操作员监控。 
更多相关信息，请参阅手册《过程控制系统 PCS 7；OS Web 选项》(Process Control 
System PCS 7; OS Web Option)。

下图给出了如何在 PCS 7 工厂中使用 OS Web 选件（OS Web 服务器、Web 客户端）。

故障 - 下一操作

6.2 为专业人员支持做准备
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传输路径

可沿以下路由传输数据：

● 电话线（调制解调器）

● TCP/IP 连接（系统内部网络连接）

● Internet

安全性要求

如果在 PCS 7 工厂中使用 OS Web 选件，则必须保护此工厂免受未经授权的访问。 

实现一个安全性概念需要采用数项措施。 只有当作为一个整体提供所有安全措施时，才能

提供最合适的保护。 

更多相关信息，请参阅白皮书《PCS 7 和 WinCC 中的安全性概念 - 基本文档》(Safety 
concept in PCS 7 and WinCC - Base document)。

故障 - 下一操作

6.2 为专业人员支持做准备

服务支持和诊断 (V8.1)
维修手册, 11/2014, A5E32786003-AA 101



故障 - 下一操作

6.2 为专业人员支持做准备
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PCS 7 中的诊断 7
7.1 在 PCS 7 子系统中的诊断功能

免责声明

说明

对本文档中的说明的不恰当使用,及可能对客户产生的任何后果，西门子概不承担任何责

任。

说明

请注意以下几点：

● 只有经过培训的维修人员才有权操作过程控制系统。

● 对系统进行更改时，请始终遵守工厂特定规则和政府法规。

● 请遵守工厂特有限制条件并相应地对工作进行调整。

● 请始终记住，对系统的更改可能会影响系统的其它部分。

简介

PCS 7 的消息系统和诊断工具可用于访问系统状态。 下述部分中包含有关诊断工具的信

息。

此描述说明了诊断工具的功能，以便根据个人需要应用这些功能。 

● 下述部分中也包含有关诊断工具应用领域的信息。

● 您将学习如何调用诊断工具。

● 由于引起故障的原因多种多样，而且在线帮助中已包含使用诊断工具的过程，所以此处

不再详述。
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评估过程控制系统的状态

主题 回答的问题

PCS 7 中的诊断 在何处执行特定的诊断操作？

诊断工具 ● 通过诊断工具可完成哪些诊断过程？

● 如何激活诊断工具？

● 在何处可找到有关诊断工具或诊断功能的描述？

诊断 

诊断是指要实现下述目的而进行的所有操作：

● 确定系统的状态

● 尽早发现错误和故障，并确定其原因

诊断消息

诊断功能用于分析系统状态和确定故障原因。

诊断工具概述

下述部分中包含有关按照应用领域组合的使用诊断工具的信息：

● 使用维护站进行完整诊断 (页 106) 

● PC 用户设置的诊断 (页 110) 

● PC 组件的诊断 (页 111) 

● 网络连接的诊断 (页 114) 

● 组态期间的诊断 (页 117) 

● CPU 的诊断 (页 118) 

● 模块的诊断 (页 119) 

● PROFIBUS DP 的诊断 (页 120) 

● PROFIBUS PA 的诊断 (页 122) 

● PROFINET 的诊断 (页 121) 

● 基金会现场总线的诊断 (页 123) 

● OS 的诊断 (页 124) 

● BATCH 站的诊断 (页 126) 

PCS 7 中的诊断

7.1 在 PCS 7 子系统中的诊断功能
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● Route Control 站的诊断 (页 127) 

● 时钟的诊断 (页 128) 

许多组件在前面板上有指示组件状态及所有错误的显示。 分析这些显示的内容，可在不干

预系统的情况下获得信息。 有关进行此分析时需要的其它产品手册，可参考“硬件显示的

诊断 (页 129)”部分。

PCS 7 中的诊断

7.1 在 PCS 7 子系统中的诊断功能
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7.2 使用维护站进行诊断（资产管理）

简介   

对于 PCS 7 V6.1 及更高版本，可借助维护工作站对 PCS 7 系统进行全面诊断。 维护工作

站是经专门组态并分配特定的参数以发挥诊断和维护功能的操作站。

强烈建议您在大中型 PCS 7 系统中使用维护工作站。

维护站

通过维护工作站，PCS 7 使您能够在以层级结构显示的诊断画面中调用所有 PCS 7 组件的

相关状态信息。 在此过程中，使用关联工具的可用在线功能来分析组件的数据。 可从诊断

画面（可通过访问保护机制进行控制）中访问 ES 数据。

用于过程控制诊断的画面可针对整个 PCS 7 系统自动生成，并在维护工作站上显示。 顶
层是整个系统的总览画面。

说明

禁用设备状态监视

如果在工厂运行维护站，则必须禁用通过“设备状态监视”实现的生命迹象监视。 
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诊断选项

在维护工作站的特定诊断画面中，可以使用诊断功能来查看各个 PCS 7 组件的状态信息。

区域 诊断对象

自动化系统 ● CPU
● SIMATIC PCS 7 BOX
● 分布式 I/O（如 ET 200M、ET 200S、

ET 200iSP、ET 200pro、输入和输出模块）

● 现场设备（HART、PROFIBUS PA……）

● 冗余

– 主站/备用站组态

– 冗余伙伴的状态

PC 站 ● 操作站

● BATCH 站
● Route Control 站
● 归档服务器

● SIMATIC PCS 7 BOX
● SIMATIC 工业 PC
● 标准 PC（以及通过 IP 地址连接的 WebNavigator 客户端

或 WebNavigator 诊断客户端）

● 连接状态（OS 服务器和 OS 客户端之间双向）

● PCS 7 中 PC 站的冗余 
– 主站/备用站组态

– 冗余伙伴的状态

以太网组件 ● 交换机，例如：

– SCALANCE X
● 网络对象（通过配置文件）

– 网桥

– 路由器

● 支持使用“NIB II”配置文件进行诊断的网络组件（例如，

打印机以及其它具有 SNMP 功能的设备）
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区域 诊断对象

PROFIBUS 组件 ● PROFIBUS DP
– 接口模块 (IM, Interface Module)
– 耦合器

– Link 模块

– 诊断中继器

● PROFIBUS PA
– 接口

– 耦合器

PROFINET 组件 ● 接口模块 (IM, Interface Module)
● IE/PB-Link

– 耦合器

智能现场设备 ● HART 现场设备

● 以下现场总线系统中的现场设备：

– PROFIBUS DP
– PROFINET
– PROFIBUS PA
– FOUNDATION Fieldbus

● 不同产品组的设备

例如

– SIPART
– SITRANS

更多信息

● 有关如何组态维护工作站的描述，可参考功能手册《过程控制系统 PCS 7；维护工作

站》(Process Control System PCS 7; Maintenance Station)。

● 有关在过程模式下如何使用维护工作站的描述，请参见组态手册《过程控制系统 PCS 
7；PCS 7 OS 过程控制》(Process Control System PCS 7; PCS 7 OS Process 
Control)。

● 有关配有 Web 诊断服务器和 Web 诊断客户端的 PCS 7 工厂的组态信息，请参见功能

手册《过程控制系统 PCS 7；PCS 7 OS Web 选件》(Process Control System PCS 7; 
PCS 7 OS Web Option)。

● 有关现场设备诊断的维护站的更多信息，请参见功能手册《过程控制系统 PCS 7；维护

站》(Process Control System PCS 7; Maintenance Station)。
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● 有关使用 SIMATIC PDM 进行现场设备诊断的信息，请参见“SIMATIC PDM (页 169)”
部分。

● “设备状态监视 (页 152)”部分
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7.3 PC 用户设置的诊断

概述    

诊断 诊断工具 调用方式

定义用户、

设置文件和文件夹的访问权限

（Windows 用户和用户组）

Windows 用户管理 
(页 140)

“控制面板 > 系统和安全 > 管理工

具 > 计算机管理 > 系统工具 > 本地

用户和组”(Control Panel > System 
and Security > Administrative Tools 
> Computer Management > System 
Tools > Local Users and Groups)

WinCC 用户 用户管理器 (页 155) 通过选择菜单命令 编辑器 (Editors) 
> 用户管理器 (User Administrator)> 
打开 (Open) 打开 WinCC 项目管理

器

PCS 7 用户（PCS 7 应用程

序中的用户角色和用户权限）

 在“开始”(Start) 菜单的 Siemens 
SIMATIC 程序中： “SIMATIC Logon 
> 组态 SIMATIC Logon”(SIMATIC 
Logon > Configure SIMATIC Logon)

共享 驱动器、文件夹和

文件的共享 (页 138)
“控制面板 > 系统和安全 > 管理工

具 > 计算机管理 > 系统工具 > 共享

文件夹 > 共享”(Control Panel > 
System and Security > 
Administrative Tools > Computer 
Management > System Tools > 
Shared Folders > Shares)
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7.4 PC 组件的诊断

概述         

诊断 诊断工具 调用方式

PC 站状态、冗余 维护站 (页 106) 维护站是专门组态用于诊断的操作站。

必须组态维护站。

更多相关信息，请参见文档《过程控制系

统 PCS 7；维护站》(Process Control 
System PCS 7; Maintenance Station)

PCS 7 工厂

● 管理任务

● 采集清单数据

● 已安装的 SIMATIC 软件 
● 安装的许可证密钥

SIMATIC Management 
Console (页 72) 

在“开始”(Start) 菜单的 Siemens 
SIMATIC 程序中： SIMATIC > SIMATIC 
Management Console

（需要许可证）

PC 组态 Windows 系统信息 
(页 135) 

在“开始”(Start) 菜单的“运行”(Run) 对话

框中输入以下内容： msinfo32"

注：

可以将系统信息保存到文件中。 
1. 在“开始”(Start) 菜单的“选项 > 系统

程序 > 系统信息”(Options > System 
Programs > System Information) 下选

择。

2. 选择菜单命令“文件”(File) >“保存”
(Save)。

驱动程序、日志和服务的功能 管理操作系统 (页 137) “控制面板 > 系统和安全 > 管理工具 > 计
算机管理 > 系统工具 > 事件查看器”
(Control Panel > System and Security > 
Administrative Tools > Computer 
Management > System Tools > Event 
Viewer) 

注： 仅有蓝色图标 =“完全正确”

PCS 7 中的诊断

7.4 PC 组件的诊断

服务支持和诊断 (V8.1)
维修手册, 11/2014, A5E32786003-AA 111



诊断 诊断工具 调用方式

标准网络模块的功能 设置 PC 站 (页 141) 在“开始”(Start) 菜单的 Siemens 
SIMATIC 程序中： “SIMATIC NET > 设
置 > 设置 PC 站”(SIMATIC NET > 
Settings > Set PC Station)

在树形视图中，选择 PC 站 (PC Station) 
> “网络模块”(Network Module) 模块 > 
Softnet IE。

单击“测试”(Test)。

冗余 OS 组件运行能力的在线验证 显示冗余状态 (页 159) 必须组态画面并将画面下载到 OS。

更多相关信息，请参见组态手册《过程控

制系统 PCS 7；操作站》(Process Control 
System PCS 7; Operator Station)

网络和网络连接  相关信息，请参见“网络连接的诊断 
(页 114)”部分

安全设置和修补程序 MBSA (页 151) 在“开始”(Start) 菜单的“运行”(Run) 对话

框中输入以下内容： "Mbscali.exe"

打印机和打印作业 打印机和打印作业 (页 144) 在“开始”(Start) 菜单的“打印机和传真”
(Printers and Faxes) 设置中

要获得有关打印作业的信息，请单击正在

执行作业的打印机。

已安装的 PCS 7 软件版本 已安装的 SIMATIC 软件 
(页 145) 

在“开始”(Start) 菜单的 Siemens 
SIMATIC 程序中： “SIMATIC > 产品信

息 > 已安装软件”(SIMATIC > Product 
Information > Installed Software)

PCS 7 软件的语言版本

● 欧洲语言版本：

__SIMATIC PCS 7 EU__
● 亚洲语言版本：

__SIMATIC PCS 7 CHS__

PCS 7 中的诊断

7.4 PC 组件的诊断

服务支持和诊断 (V8.1)
112 维修手册, 11/2014, A5E32786003-AA



诊断 诊断工具 调用方式

PCS 7 捆绑的 PC PC DiagMonitor (页 144) 捆绑的 PC 启动时，PC DiagMonitor 可自

动启动。

监视 RAID 磁盘 

（仅限于 PCS 7 捆绑的 PC）

PC DiagMonitor (页 144) 捆绑的 PC 启动时，PC DiagMonitor 可自

动启动。

注：

RAID 系统的制造商经常随 RAID 系统一道

提供诊断程序。 请检查 RAID 制造商是否

提供此信息。
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7.5 网络连接的诊断

概述

诊断 诊断工具 调用方式

具有诊断功能的连接 维护站 (页 106) 维护站是专门组态用于诊断的操作站。

必须组态维护站。

更多相关信息，请参见文档《过程控制系

统 PCS 7；维护站》(Process Control 
System PCS 7; Maintenance Station)。

确定网络组件的清单数据 SIMATIC Management 
Console (页 72)

在“开始”(Start) 菜单的 Siemens 
SIMATIC 程序中： SIMATIC > SIMATIC 
Management Console（需要许可证）

工厂视图 > 快捷菜单命令“确定清单数

据”(Determine inventory data)

更多相关信息，请参见 SIMATIC 
Management Console 的在线帮助。

网络组态 NetPro (页 145) 网络 (Network) > 检查一致性 (Check 
Consistency)

已建立的到 SIMATIC 站的连接 NetPro (页 145) 选择 CPU： PLC >“激活连接状态”
(Activate Connection Status)

工业以太网上网卡的状态 Windows“网络连接”对话框 
(页 149) 

“控制面板 > 网络和 Internet > 网络连接 
> 更改适配器设置”(Control Panel > 
Network and Internet > Network 
Connections > Change Adapter Settings)

注意：

选择“详细信息”(Details) 视图。

连接至其它站；IP 地址、MAC 地
址

命令行输入 (页 140) 在“开始”(Start) 菜单的“运行”(Run) 对话

框中输入以下内容： “cmd” 

在 DOS 窗口中，输入 ping <IP address>

确定 MAC 地址和 TCP/IP 地址 命令行输入 (页 140) 在“开始”(Start) 菜单的“运行”(Run) 对话

框中输入以下内容： “cmd” 

在 DOS 窗口中，输入 ipconfig –all。
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诊断 诊断工具 调用方式

基础设施服务器（DHCP、
WINS、DNS）

命令行输入 (页 140) 在“开始”(Start) 菜单的“运行”(Run) 对话

框中输入以下内容： “cmd” 

在 DOS 窗口中，输入 ipconfig –all。

PC 站 设置 PC 站 (页 141) 在“开始”(Start) 菜单的 Siemens 
SIMATIC 程序中： “SIMATIC NET > 设
置 PC 站”(SIMATIC NET > Set PC 
Station)

冗余交换机：

● SCALANCE X-300
● SCALANCE X-400

观察器功能 (页 147) 在“开始”(Start) 菜单的“运行”(Run) 对话

框中输入以下内容： “cmd” 

在 DOS 窗口中，输入 TELNET。 更多信

息，请参见组态手册《SIMATIC NET；工

业以太网交换机 SCALANCE X-300/
X-400》(SIMATIC NET; Industrial 
Ethernet Switches SCALANCE X-300/
X-400)

网络中的闭环检测 闭环检测 (页 148) 可通过 SCALANCE X200/X300 和 X400 
交换机的基于 Web 的管理进行组态

网络组件的状态，WinCC 应用程

序的状态 
站组态编辑器 (页 142) 通过 HW Config 的组态和加载所需的 PC 

站 

进行调用： 在任务栏中通过按钮：

智能现场设备的连接 SIMATIC PDM (页 169) 在 SIMATIC Manager 中： 选项 (Options) 
> 设置 PG/PC 接口 (Set PG/PC Interface)

PC 以太网模块 NCM S7 工业以太网 (页 146) 在“开始”(Start) 菜单的 Siemens 
SIMATIC 程序中： “STEP 7 > NCM S7 
工业以太网 > 诊断”(STEP 7 > NCM S7 
Industrial Ethernet > Diagnostics)

已组态的通道及这些通道与 
SIMATIC 站的连接的状态

WinCC - 通道诊断 (页 155) 在“开始”(Start) 菜单的 Siemens 
SIMATIC 程序中： WinCC >“工具”(Tools) 
>“通道诊断”(Channel Diagnostics) >“通
道/连接”(Channels/Connections) 选项卡

连接至 OS： 有故障或已建立 设备状态监视 (页 152) 在过程模式中调用画面 
(@CONFIG.PDL)。

必须已设置“设备状态监视”(Lifebeat 
Monitoring)。
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诊断 诊断工具 调用方式

过程接口的状态 连接的状态 (页 157) 在 WinCC 项目管理器中： 选项 (Options) 
> 连接状态 (Status of Connections) 

客户端-服务器连接 多用户操作的状态 (页 156) 在 WinCC 项目管理器中： 选项 (Options) 
> 多用户操作的状态 (Status of Multi-User 
Operation)

确定站 

查找 IP 地址和 MAC 地址

消息帧

冲突

BANY（附加产品） (页 172) 如果已安装 BANYnet，则通过如下菜单命

令调用该程序：开始 > 程序 > BANYnet。

PROFIBUS DP 连接  更多相关信息，可参考“PROFIBUS DP 
的诊断 (页 120)”部分

PROFIBUS PA 连接  更多相关信息，可参考“PROFIBUS PA 
的诊断 (页 122)”部分。

支持 SNMP 的设备（例如，网络

交换机）的状态

PC DiagMonitor (页 144) 在“开始”(Start) 菜单的 Siemens 
SIMATIC 程序中： “PC DiagMonitor > 管
理站”(PC DiagMonitor > Management 
Station)
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7.6 组态期间的诊断

概述        

诊断 诊断工具 调用方式

硬件组态的一致性 HW Config (页 165) 菜单命令 站(Station) > 检查一致性(Check 
Consistency)

PC 站组态的一致性 站组态编辑器 (页 142) 在任务栏中，单击以下图标： 

分析“状态”(Status) 列的表条目

SIMATIC 站中的块的一致性 SIMATIC Manager 
(页 163)

选择 SIMATIC 站 (SIMATIC Station) > S7 
ProgramS7 程序 (S7 Program) > 块 
(Blocks)

菜单命令 编辑 (Edit) > 检查块一致性

(Check Block Consistency)

SIMATIC 站中的图表一致性 SIMATIC Manager 
(页 163)

选择 SIMATIC 站 (SIMATIC Station) > S7 
程序 (S7 Program) > 图表 (Charts)

菜单命令编辑 (Edit) > 检查块一致性

(Check Block Consistency)

连接错误 模块信息 (页 166) 在 SIMATIC Manager 中选择 SIMATIC 
站，或者 

在 HW Config 中选择 CPU。

在 PCS 7 操作站中打开信号互连 PCS 7 操作站 (WinCC) 转换画面 

某个 PC 站的连接功能 设置 PC 站 (页 141) 在“开始”(Start) 菜单的 Siemens 
SIMATIC 程序中： “SIMATIC NET > 设
置 > 设置 PC 站”(SIMATIC NET > 
Settings > Set PC Station)
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7.7 CPU 的诊断

概述      

诊断 诊断工具 调用方式

CPU 模块信息、冗余、连接 维护站 (页 106) 维护站是专门组态用于诊断的操作站。

必须组态维护站。

更多相关信息，请参见手册《过程控制系

统 PCS 7；维护站》(Process Control 
System PCS 7; Maintenance Station)

确定自动化系统的清单数据 SIMATIC Management 
Console (页 72)

在“开始”(Start) 菜单的 Siemens 
SIMATIC 程序中： SIMATIC > SIMATIC 
Management Console（需要许可证）

工厂视图 > 快捷菜单命令“确定清单数

据”(Determine inventory data)

更多相关信息，请参见 SIMATIC 
Management Console 的在线帮助。

CPU HW Config (页 165) 选择 CPU： 菜单命令

 站（Station）> 在线（Online）

CPU 模块信息 (页 166) 在 SIMATIC Manager 中选择 SIMATIC 
站，或者 

在 HW Config 中选择 CPU
。

选择菜单命令 PLC >“模块信息”(Module 
Information)

模块显示 评估模块显示 (页 129) 手册中的注意事项： 硬件显示的诊断 
(页 129) 

CPU 故障 - 准备诊断 仅支持专家 CPU 故障 - 准备诊断 (页 97)
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7.8 模块的诊断

概述

诊断 诊断工具 调用方式

诊断所有具有诊断功能的模块 维护站 (页 106) 维护站是专门组态用于诊断的操作站。

必须组态维护站。

更多相关信息，请参见手册《过程控制系

统 PCS 7；维护站》(Process Control 
System PCS 7; Maintenance Station)

确定自动化系统的清单数据 SIMATIC Management 
Console (页 72)

在“开始”(Start) 菜单的 Siemens 
SIMATIC 程序中： SIMATIC > SIMATIC 
Management Console（需要许可证）

工厂视图 > 快捷菜单命令“确定清单数

据”(Determine inventory data)

更多相关信息，请参见 SIMATIC 
Management Console 的在线帮助。

具有诊断功能的模块和 CP HW Config (页 165) 站 (Station) > 在线打开 (Open Online)

具有诊断功能的 I/O 模块和 CP 模块信息 (页 166) 在 SIMATIC Manager 中选择 SIMATIC 
站，或者

在 HW Config 中选择 CPU。

选择菜单命令 PLC >“模块信息”(Module 
Information)

模块显示 评估模块显示 (页 129) 手册中的注意事项： 硬件显示的诊断 
(页 129)
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7.9 PROFIBUS DP 的诊断

概述         

诊断 诊断工具 调用方式

具有诊断功能的设备和连接 维护站 (页 106) 维护站是专门组态用于诊断的操作站。

必须组态维护站。

更多相关信息，请参见文档《过程控制系

统 PCS 7；维护站》(Process Control 
System PCS 7; Maintenance Station)

确定现场设备清单数据 SIMATIC Management 
Console (页 72)

在“开始”(Start) 菜单的 Siemens 
SIMATIC 程序中： SIMATIC > SIMATIC 
Management Console（需要许可证）

工厂视图 > 快捷菜单命令“确定清单数

据”(Determine inventory data)

更多相关信息，请参见 SIMATIC 
Management Console 的在线帮助。

CPU 的内部 PROFIBUS DP 接口 模块信息 (页 166) 通过 HW Config > 模块信息（Module 
Information） 进行诊断

PROFIBUS DP 错误 通过诊断中继器的 
PROFIBUS DP 诊断 
(页 168)

通过 HW Config > 模块信息（Module 
Information） 进行诊断

PROFIBUS 节点的状态 NetPro (页 145) 在“开始”(Start) 菜单的 Siemens 
SIMATIC 程序中： STEP 7 > NetPro

选择菜单命令 视图 (View) > 带 DP 从站 
(With DP Slaves)，以便在网络视图中显

示 DP 从站

站状态 NCM S7  (页 149) 在“开始”(Start) 菜单的 Siemens 
SIMATIC 程序中： “STEP 7 > NCM S7 > 
诊断”(STEP 7 > NCM S7 > Diagnostics)

站故障

包含故障原因的详细信息的故障指

示

硬件配置中的名称和注释

订货号、地址、插槽类型

系统过程控制诊断（附加产

品） (页 174)
必须组态画面并将画面下载到 OS。

更多相关信息，请参见组态手册《过程控

制系统 PCS 7；操作站》(Process Control 
System PCS 7; Operator Station)

PCS 7 中的诊断
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7.10 PROFINET 的诊断

概述         

诊断 诊断工具 调用方式

具有诊断功能的设备和连接 维护站 (页 106) 维护站是专门组态用于诊断的操作站。

必须组态维护站。

更多相关信息，请参见文档《过程控制系

统 PCS 7；维护站》(Process Control 
System PCS 7; Maintenance Station)

确定现场设备清单数据 SIMATIC Management 
Console (页 72)

在“开始”(Start) 菜单的 Siemens 
SIMATIC 程序中： SIMATIC > SIMATIC 
Management Console（需要许可证）

工厂视图 > 快捷菜单命令“确定清单数

据”(Determine inventory data)

更多相关信息，请参见 SIMATIC 
Management Console 的在线帮助。

CPU 的内部 PROFINET 接口

（仅适用于 CPU 41x- PNIO）

模块信息 (页 166) 通过 HW Config > 模块信息（Module 
Information） 进行诊断

PROFINET 站的状态 拓扑编辑器 (页 151) 通过“编辑 > PROFINET IO > 拓扑”(Edit 
> PROFINET IO > Topology) 进行诊断。

PROFINET 站的状态 NetPro (页 145) 在“开始”(Start) 菜单的 Siemens 
SIMATIC 程序中： STEP 7 > NetPro

选择菜单命令 视图 (View) > 带 DP 从站 
(With DP Slaves)，以便在网络视图中显

示 DP 从站

站状态 NCM S7 (页 149) 在“开始”(Start) 菜单的 Siemens 
SIMATIC 程序中： “STEP 7 > NCM S7 > 
诊断”(STEP 7 > NCM S7 > Diagnostics)

现场总线诊断 BANY (页 172) 在“开始”(Start) 菜单的“程序 > BANY 
PNIO”(Programs > BANY PNIO) 中：

PCS 7 中的诊断
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7.11 PROFIBUS PA 的诊断

概述  

诊断 诊断工具 调用方式

具有诊断功能的设备和连接 维护站 (页 106) 维护站是专门组态用于诊断的操作站。

必须组态维护站。

更多相关信息，请参见文档《过程控制系

统 PCS 7；维护站》(Process Control 
System PCS 7; Maintenance Station)

确定现场设备清单数据 SIMATIC Management 
Console (页 106)

在“开始”(Start) 菜单的 Siemens 
SIMATIC 程序中： SIMATIC > SIMATIC 
Management Console（需要许可证）

工厂视图 > 快捷菜单命令“确定清单数

据”(Determine inventory data)

更多相关信息，请参见 SIMATIC 
Management Console 的在线帮助。

PROFIBUS PA 上具有诊断功能的

设备和连接

SIMATIC PDM (页 169) SIMATIC Manager：  视图 (View) > 过程

设备网络视图 (Process Device Network 
View)

PROFIBUS PA 上具有诊断功能的

设备的状态

NCM S7 (页 149) 在“开始”(Start) 菜单的 Siemens 
SIMATIC 程序中： “STEP 7 > NCM S7 > 
诊断”(STEP 7 > NCM S7 > Diagnostics)

站故障

包含故障原因的详细信息的故障指

示

硬件配置中的名称和注释

订货号、地址、插槽类型

系统过程控制诊断（附加产

品） (页 174) 
必须组态画面并将画面下载到 OS。

更多相关信息，请参见组态手册《过程控

制系统 PCS 7；操作站》(Process Control 
System PCS 7; Operator Station)

参见

确定清单数据以及安装软件 (页 72)

PCS 7 中的诊断
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7.12 基金会现场总线的诊断

概述   

诊断 诊断工具 调用方式

具有诊断功能的设备和连接 维护站 (页 106) 维护站是专门组态用于诊断的操作站。

必须组态维护站。

更多相关信息，请参见文档《过程控制系

统 PCS 7；维护站》(Process Control 
System PCS 7; Maintenance Station)

确定现场设备清单数据 SIMATIC Management 
Console (页 72)

在“开始”(Start) 菜单的 Siemens 
SIMATIC 程序中： SIMATIC > SIMATIC 
Management Console（需要许可证）

工厂视图 > 快捷菜单命令“确定清单数

据”(Determine inventory data)

更多相关信息，请参见 SIMATIC 
Management Console 的在线帮助。

FF Link  的诊断（IM 153‑2 FF 和 
FDC 157）

模块信息 (页 166) 通过 HW Config > 模块信息（Module 
Information） 进行诊断

Foundation Fieldbus 上具有诊断功

能的设备和连接

SIMATIC PDM (页 169) SIMATIC Manager： 视图 (View) > 过程

设备网络视图 (Process Device Network 
View)

PCS 7 中的诊断
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7.13 OS 的诊断

概述             

诊断 诊断工具 调用方式

所有 OS 组件和通信连接的运行能

力

维护站 (页 106) 维护站是专门组态用于诊断的操作站。

必须组态维护站。

更多相关信息，请参见文档《过程控制系

统 PCS 7；维护站》(Process Control 
System PCS 7; Maintenance Station)

WinCC 项目和分配的 SIMATIC 站 设备状态监视 (页 152) 在过程模式中调用画面 (@CONFIG.PDL)。

必须已设置“设备状态监视”(Lifebeat 
Monitoring)。

OS 组件之间的连接 SIMATIC Shell (页 152) Windows 资源管理器（工作站）： 
选择 PC 站 >“Simatic Shell”文件夹 > 在
快捷菜单中选择“属性”(Properties)

WinCC 和 AS 之间的连接 连接状态 (页 157) 在 WinCC 中： 选项 (Options) > 连接状

态 (Status of Connections)

OS 服务器和 OS 客户端之间的连

接

多用户操作的状态 (页 156) 在 WinCC 中： 选项 (Options) > 多用户操

作的状态 (Status of Multi-User Operation)

通道状态以及与至 AS 的连接 WinCC 通道诊断 (页 155) 在“开始”(Start) 菜单的 Siemens 
SIMATIC 程序中： “WinCC > 工具 > 通道

诊断”(WinCC > Tools > Channel 
Diagnostics)

在 OS 客户端上显示所连 OS 服务

器的状态

区域总览 (页 158) 在 WinCC 中： 区域总览 >“已连接服务器

的状态”(Status of the connected server) 
图标

OS 处于过程模式下

冗余 OS 组件的运行能力 显示冗余状态 (页 159) 必须组态画面并将画面下载到 OS。

相关信息，请参见组态手册《过程控制系

统 PCS 7；操作站》(Process Control 
System PCS 7; Operator Station)

冗余 OS 服务器的时间主站角色 OS 服务器的时间主站角色

（状态） (页 160) 
需要在面板上组态变量 
"@TimeSyncDevice1State" 和 
"@TimeSyncDevice2State" 。 必须加载 
OS。

PCS 7 中的诊断
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诊断 诊断工具 调用方式

OS 服务器的常规系统信息 WinCC“系统信息”

（System Info）通道 
(页 154) 

必须组态画面并将画面下载到 OS。

相关信息，请参见组态手册《过程控制系

统 PCS 7；操作站》(Process Control 
System PCS 7; Operator Station)

OS 故障 - 准备诊断 仅支持专家 相关信息，可参考“OS 故障 - 准备诊断 
(页 99)”(OS fault - preparing diagnostics) 
部分。

状态 PCS 7 Web 服务器  Internet Explorer： http://<服务器地址

>.status.html

PCS 7 中的诊断
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7.14 BATCH 站的诊断

概述 

诊断 诊断工具 调用方式

所有 BATCH 组件和通信连接的运

行能力

维护站 (页 106) 维护站是专门组态用于诊断的操作员站。

维护站必须进行组态。

更多相关信息，请参见文档《过程控制系

统 PCS 7；维护站》(Process Control 
System PCS 7; Maintenance Station)

BATCH 服务器的状态 BATCH 服务器任务栏中的

状态图标 (页 160)
任务栏

主站的状态 BATCH 服务器任务栏中的

状态图标 (页 160)
任务栏

备用服务器（伙伴服务器）的状态 BATCH 服务器任务栏中的

状态图标 (页 160)
任务栏

批生产的状态 订单文件夹处的状态显示 
(页 161)

订单文件夹

更多相关信息，请参见文档《过程控制系

统 PCS 7；SIMATIC BATCH》(Process 
Control System PCS 7; SIMATIC 
BATCH)

PCS 7 中的诊断
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7.15 路径控制站的诊断

概述 

诊断 诊断工具 调用方式

所有 SIMATIC Route 
Control 组件和通信连接的运

行能力

维护站 (页 106) 维护站是专门组态用于诊断的操作员站。

必须组态维护站。

更多相关信息，请参见文档《过程控制系统 
PCS 7；维护站》(Process Control System 
PCS 7; Maintenance Station)

冗余服务器的状态 Route Control 服务器任务栏

中的状态图标 (页 163)
任务栏

已建立的到 SIMATIC 站的连

接

NetPro (页 145) NetPro： 在线视图 > 选择 CPU： PLC >“激活

连接状态”(Activate Connection Status)

PCS 7 中的诊断
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7.16 日时钟的诊断

概述    

诊断 诊断工具 调用方式

AS-CPU 时间 SIMATIC 管理器 (页 163) 选择 CPU： PLC > 设置日时钟 (Set Time 
of Day)

AS-CPU 时间 模块信息 (页 166) 站 (Station) > 在线打开 (Open Online)

选择 CPU： PLC > 设置日时钟 (Set Time 
of Day)

PC 时间 管理操作系统 (页 137) “控制面板 > 时钟、语言和区域 > 日期和

时间”(Control Panel > Clock, Language 
and Region > Date and Time)。 请勿更改

这些设置。

已激活的时间服务 Windows 系统实用程序 “控制面板 > 系统和安全 > 管理工具 > 服
务”(Control Panel > System and Security 
> Administrative Tools > Services)“窗口

定时器” 

终端总线上的同步状态 设置 PG/PC 接口 (页 142) 在“开始”(Start) 菜单的 Siemens 
SIMATIC 程序中： “SIMATIC NET > 设
置 PG/PC 接口”(SIMATIC NET > Set PG/
PC Interface)

选择接口 > 单击“诊断”(Diagnostics) > 在
“时间”(Time) 组中

在操作员控制和监视系统中显示的

时间组态

WinCC 编辑器“时间同步”

（Time Synchronization）
使用菜单命令 编辑器（Editors）> 时间同

步（Time Synchronization） > 打开

（Open） 打开 WinCC 项目管理器

PCS 7 中的诊断
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7.17 硬件显示的诊断

概述         

许多组件都具有指示组件状态和错误的显示。 分析这些显示的内容，可在不干预系统的情

况下获得信息。

组件 下列手册和章节中包含有关诊断选项的信息：

电源模块 参考手册《SIMATIC；S7-400 可编程控制器；模块规范》

(SIMATIC; 
S7-400 Programmable Controller; Module Specifications)
● 备用电池（可选）(Backup battery (optional))
● 通过 LED 指示灯指示的错误消息 (Error messages by means of 

LED displays)
● 操作员控制和显示元素 (Operator control and display elements)

S7-400 的中央模块

CPU

参考手册《SIMATIC；S7-400 可编程控制器；CPU 规范》

(SIMATIC; 
S7-400 Programmable Controller; CPU Specifications)
● CPU 的监视功能 (Monitoring functions of the CPU)
● 状态和错误显示 (Status and error displays)
● 运行模式开关 (Operating mode switch)

CP 441 手册《SIMATIC；CP 441 点对点通讯 - 安装和参数分配》(SIMATIC;
CP 441 Point-to-Point Communication - Installation and Parameter 
Assignment)
● CP 441 的诊断 (Diagnostics for CP 441)

CP 443-1 设备手册《S7 CP/B4 部分；CP 443-1 的描述》(S7 CPs/Part B4;
Description of CP 443-1)
● 显示和运行模式开关 (Displays and operating mode switch)

CP 443-5 
Extended

设备手册《S7 CP/B4 部分；CP 443-5 Extended 的描述》(S7 CPs/
Part B4;
Description of CP 443-5 Extended)
● 显示和运行模式开关 (Displays and operating mode switch)

PCS 7 中的诊断
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组件 下列手册和章节中包含有关诊断选项的信息：

S7-300 I/O 模块 参考手册《SIMATIC；S7-300 可编程控制器；模块规范》

(SIMATIC; 
S7-400 Programmable Controller; Module Specifications)
● 信号模块的诊断数据 (Diagnostic data for the signal modules)
有关更多信息，请参见《用于过程自动化的 ET 200M 信号模块》

(ET 200M Signal Modules for Process Automation) (http://
support.automation.siemens.com/WW/view/en/7215812) 手册或

《ET 200M 分布式 I/O 设备 HART 模拟量模块》(ET 200M distributed 
I/O device HART analog modules) (http://
support.automation.siemens.com/WW/view/en/22063748) 手册。

S7-300 故障安全信

号模块

手册《SIMATIC；可编程控制器 S7-300；故障安全信号模块》

(SIMATIC; Programmable Controller S7-300;
Fail-safe Signal Modules)
● F-SM 错误的诊断 (Diagnostics of F-SM errors)
● 属性、正视图、连接和方框图 (Properties, front view, connection 

and block diagram)

S7-300
Ex I/O 模块

手册《SIMATIC；可编程控制器 S7-300，ET 200M；Ex I/O 模块》

(SIMATIC;
Programmable Controller S7-300, ET 200M;
Ex I/O modules)
● 数字量输入模块： 属性

● 模拟模块的诊断 (Diagnostics for analog modules)
● 模块视图和方框图 (Module view and block diagram)

ET 200M 手册《SIMATIC；ET 200M 分布式 I/O；调试和诊断》(SIMATIC;
ET 200M Distributed I/O; Commissioning and Diagnostics)
● 通过 LED 指示灯诊断 IM 153-1、IM 153-2 (Diagnostics by 

means of  display IM 153-1, IM 153-2)
● 通过 STEP 7 诊断 (Diagnostics with STEP 7)

ET 200iSP 手册《SIMATIC；ET 200iSP 分布式 I/O；调试和诊断》(SIMATIC;
ET 200iSP Distributed I/O; Commissioning and Diagnostics)
● IM 151-2 上的状态和错误 LED (Status and error LEDs on 

IM 151-2)
● 插入和删除模块 (Insertion and removal of modules)
● 在数字输入模块上的 NAMUR 编码器的线路断开 (Line break of 

the NAMUR encoder on the digital input module)
● 通过 STEP 7 诊断 (Diagnostics with STEP 7)

PCS 7 中的诊断
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组件 下列手册和章节中包含有关诊断选项的信息：

ET 200pro 手册《SIMATIC；ET 200pro 分布式 I/O 系统；调试和诊断》

(SIMATIC;
ET 200pro Distributed I/O System; Commissioning and 
diagnostics)
● LED 显示屏 ...
● 插入和删除模块 (Insertion and removal of modules)
● 通过 STEP 7 诊断 (Diagnostics with STEP 7)

ET 200S 手册《SIMATIC；ET 200S 分布式 I/O；调试和诊断》(SIMATIC;
ET 200S Distributed I/O; Commissioning and Diagnostics)
● 通过 LED 指示灯进行诊断 (Diagnostics by means of LED 

displays)
● 电子模块的诊断消息 (Diagnostic messages for electronic 

modules)

DP/PA 耦合器 手册《SIMATIC；总线耦合器 DP/PA-Link 和 Y-Link》(SIMATIC; 
Bus couplers DP/PA- Link and Y-Link)

通过 LED 指示灯进行诊断 (Diagnostics by means of LED displays)
● IM 157 的 LED 指示灯 (LED displays of the IM 157)
● DP/PA 耦合器的 LED 指示灯 (LED displays of the DP/PA 

coupler)
● Y 耦合器的 LED 指示灯 (LED displays of the Y coupler)

Y-Link DP/PA 耦合器之中的信息

FF Link 手册《SIMATIC;总线耦合器 FF-Link》(SIMATIC; 
Bus couplers FF- Link)

AFD 
（在现场总线上使用 
- PROFIBUS PA 或
基金会现场总线）

手册《SIMATIC;
SIMATIC NET; PROFIBUS PA》
● 通过 LED 指示灯进行诊断 (Diagnostics by means of LED 

displays)
● 电子模块的诊断消息 (Diagnostic messages for electronic 

modules)

AFS（在现场总线

上使用 - 
PROFIBUS PA 或
基金会现场总线）

手册《SIMATIC;
SIMATIC NET; PROFIBUS PA》
● 通过 LED 指示灯进行诊断 (Diagnostics by means of LED 

displays)
● 电子模块的诊断消息 (Diagnostic messages for electronic 

modules)
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组件 下列手册和章节中包含有关诊断选项的信息：

诊断中继器 手册《SIMATIC；PROFIBUS DP 的诊断中继器》(SIMATIC; 
Diagnostic Repeater for PROFIBUS DP)
● LED 诊断 (LED diagnostics)

以太网的交换机 操作说明《SIMATIC NET；工业以太网交换机 SCALANCE X-400》
(SIMATIC NET;
Industrial Ethernet Switches SCALANCE X-400)
● LED
调试手册《SIMATIC NET；工业以太网，SCALANCE X-100 和 
SCALANCE X-200 产品线》(SIMATIC NET; Industrial Ethernet, 
SCALANCE X-100 and SCALANCE X-200 Product Line)
● SCALANCE X<…> 显示（例如，SCALANCE X208 显示 

(SCALANCE X208 displays)）

PROFINET IO 和 PROFIBUS DP 的状态 LED

用于诊断的 LED 比较
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下表包含有关可用于初始诊断的 LED 以及 LED 含义的信息。

LED PROFINET IO 的含义 PROFIBUS DP 的含义

BUSF 红色点亮： 红色点亮：

总线错误（没有到子网/交换机的物理

连接）

接口处总线错误（例如，总线短路）

传输速率错误  

未激活全双工传输  

闪烁： 闪烁：

PROFINET 设备是一个控制器： 模块是一个 DP 主站：

已连接 IO 设备的故障 已连接站的故障

所分配 IO 设备中至少有一个不能寻址 所分配从站中至少有一个不能寻址

组态错误 组态错误

PROFINET 设备是一个 IO 设备： 模块是一个 DP 从站：

看门狗已过期。 看门狗已过期。

通过 PROFINET 的总线通信已中断。 通过 PROFIBUS DP 的总线通信已中

断。

IP 地址不正确。 PROFIBUS 地址不正确。

组态错误 组态错误

参数分配错误  

设备名称错误或缺失  

IO 控制器不可用/处于关闭状态，但存

在以太网连接。

 

RX 黄色点亮： 不可用

通过接口接收数据。

传输的数据量较低时，LED 闪烁。

TX 黄色点亮： 不可用

通过接口发送数据。

传输的数据量较低时，LED 闪烁。

LINK 绿色点亮： 不可用

连接了其他设备（大多数情况下为交

换机）且存在物理连接。
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LED PROFINET IO 的含义 PROFIBUS DP 的含义

FO 黄色点亮： 不可用 

表单结束必须检查各自的传输路径。

PCS 7 中的诊断

7.17 硬件显示的诊断

服务支持和诊断 (V8.1)
134 维修手册, 11/2014, A5E32786003-AA



7.18 诊断工具

7.18.1 PCS 7 的诊断工具

免责声明

警告

对因不正确使用本文档中提供的说明而可能给客户带来的任何后果，西门子概不承担任何

责任。

警告

请注意以下几点：

● 只有经过培训的维护人员才能执行所有操作。

● 对系统进行更改时，请始终遵守工厂特定规则和政府法规。

● 请遵守工厂特有限制条件并相应地对工作进行调整。

● 请始终牢记，对系统的更改会影响到系统的其它部分。

7.18.2 PC 的诊断

7.18.2.1 Windows 系统信息

调用  

在“开始”(Start) 菜单的“运行”(Run) 对话框中输入以下内容： "msinfo32"。
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概述

主题 详细信息 调用方式 更多信息 

PC 组态 操作系统

操作系统版本

PC 名称

处理器

BIOS 数据

当前登录用户

时区

工作存储器的大小

有关交换文件的信息

系统概述 操作系统的在线帮助

图形卡 图形卡的类型 “控制面板 > 系统和

安全 > 系统工具 > 设
备管理器”(Control 
Panel > System and 
Security > System 
Tools > Device 
Manager)

图形卡

操作系统的在线帮助

图形设置 设置图形卡的分辨率 桌面快捷菜单

或

“控制面板 > 外观和

个性化 > 显示调整分

辨率”(Control Panel 
> Appearance and 
Personalization > 
Display

 Adjust resolution)

操作系统的在线帮助
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主题 详细信息 调用方式 更多信息 

打印机 显示现有打印机 “启动 > 设备和打印

机”(Start > Devices 
and Printers)

操作系统的在线帮助

驱动器 识别到的内部和外部驱动器

或存储介质  

硬盘分区  

“控制面板 > 系统和

安全 > 管理工具 > 计
算机管理 > 存储 > 磁
盘管理”(Control 
Panel > System and 
Security > 
Administrative Tools

 > Computer 
Management > 
Storage > Disk 
Management)

操作系统的在线帮助

7.18.2.2 管理操作系统

调用                           

通过“计算机管理”(Computer Management) 调用

“启动 > 控制面板 > 管理工具 > 计算机管理”(Start > Control Panel > Administrative Tools 
> Computer Management)

概述

主题 详细信息 调用方式 更多信息 

事件显示   图标指示状态（进行分析需

要专业知识）

系统工具（System 
Tools）> 事件查看器

（Event Viewer）

选择文件夹，

按“F1”键 - 仅蓝色

图标 =“一切正常”

可移动存储器 识别到的外部驱动器或存储

介质

数据存储器（Data 
Memory）> 可移动介

质（Removable 
Media）
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主题 详细信息 调用方式 更多信息 

硬盘 驱动器名称、格式、大小、

分段、分区、状态

数据存储器（Data 
Memory）> 存储介质

管理（Storage 
Media Management）

 

网络适配器和 
PC 卡

网络适配器类型访问级别、

用户、服务器、网络地址

（IP/MAC 地址）     

系统工具（System 
Tools）> 系统信息

（System 
Information）> 组件

（Components）> 网
络（Network）> 适配

器（Adapter）

 

在网络范围内

分析已连接的 
PC

网络中的当前用户，

激活的 PC

系统工具（System 
Tools ）> 共享文件夹

（Shared Folders）> 
共享（Shares）

 

用户和用户组

的管理

● 创建和修改本地用户帐户

● 创建和修改用户配置文件

● 创建、添加和删除本地组

系统工具（System 
Tools）> 本地用户和

组（Local Users and 
Groups）

操作系统的在线帮助

7.18.2.3 驱动器、文件夹和文件的共享

调用                         

通过“计算机管理 > 系统”(Computer Management > System) 调用
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概述

主题 详细信息 调用方式 更多信息

驱动器和文件

夹

授予或更改驱动器和文

件夹的共享 
在树形视图中

选择共享文件夹（Shared 
Folders）> 共享（Share）

选择文件夹，

按“F1”键

驱动器和文件

夹

授予或更改驱动器和文

件夹的共享

● 打开 Windows 资源管理

器

● 在树形视图中，选择驱

动器/文件夹

● 菜单命令： 文件 > 属性 
>“共享”选项卡

操作系统的在线帮

助 

文件 授予或更改文件的共享 ● 在 Windows 资源管理器

中选择文件

● 菜单命令： “文件”
(File) >“属性”
(Properties)

● 选择“安全”选项卡，

然后在“权限”组中进

行所需的设置。

操作系统的在线帮

助 
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7.18.2.4 系统工具 - 本地用户和组

概述

主题 详细信息 调用方式 更多信息

在操作系统中

管理用户和组

● 创建和修改本地用户帐户

● 创建和修改用户配置文件

● 创建、添加和删除本地组

“控制面板 > 管理工

具 > 计算机管理 > 系
统工具 > 本地用户和

组”(Control Panel > 
Administrative Tools 
> Computer 
Management > 
System Tools > 
Local Users and 
Groups)

操作系统的在线帮

助 

应用权限 ● 标准用户、语言和密码更

改

● 选择从中获得用户数据的

计算机

● 选择用于检查组件登录的

设备

● 设置注销 SIMATIC 登录

的延迟时间

在“开始”(Start) 菜单

的 Siemens 
SIMATIC 程序中： 
“SIMATIC Logon > 组
态 SIMATIC Logon”
(SIMATIC Logon > 
Configure SIMATIC 
Logon)

SIMATIC 登录 在线

帮助

7.18.2.5 命令行命令

调用           

在“开始”(Start) 菜单的“运行”(Run) 对话框中输入以下内容：“cmd”

有关此处提到的 Windows 命令的更多相关信息，请搜索 Microsoft“帮助和支持中心”。
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概述

主题 详细信息 调用方式 更多信息

连接（网络适

配器功能）

验证本网络的适配器 输入“ping localhost”
或 

“ping 127.0.0.0”。

帮助和支持中心

连接（网络适

配器功能）

验证与另一个以太网节点

的连接

输入“ping - {PC‑名}”
或“ping ‑ {IP‑地址}”

帮助和支持中心

连接（网络适

配器功能）

识别本网络的适配器 输入“ipconfig” 帮助和支持中心

连接（网络适

配器功能）

服务器和网络服务的网络

适配器的识别

输入“ipconfig -all” 帮助和支持中心

连接（网络适

配器功能）

活动连接，计算机连接，

以太网统计

输入“netstat” 帮助和支持中心

7.18.2.6 设置 PC 站

调用

在“开始”(Start) 菜单的 Siemens SIMATIC 程序中： “SIMATIC NET > 组态设置”(SIMATIC 
NET > Configuration Settings)

概述

主题 详细信息 调用方式 更多信息

组态 检测的模块 “SIMATIC NET 组态设

置”(SIMATIC NET 
Configuration 
Settings) 文件夹

组态设置在线帮助；请参

见“设置 PC 站”主题

诊断选项 就每个模块而言，可

用选项各有不同

“SIMATIC NET 组态设

置 > 选择模块”
(SIMATIC NET 
Configuration Settings 
> Select module)

组态设置在线帮助；请参

见“设置 PC 站”主题
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7.18.2.7 设置 PG/PC 接口

调用

选项：

● 在“开始”(Start) 菜单的 Siemens SIMATIC 程序中： “SIMATIC NET > 设置 PG/PC 接
口”(SIMATIC NET > Set PG/PC Interface) 

● 在 SIMATIC Manager 中通过菜单命令“选项 > 设置 PG/PC 接口”(Options > Set PG/
PC Interface)

概述

主题 详细信息 调用方式 更多信息

时间同步 工厂总线上的 PC 同步状

态（要求：

带有通信处理器的 
PC： 
● CP 1613
● CP 1623
● CP 1628)

选择接口 > 单击“诊断”
(Diagnostics) > 在“时

间”(Time) 组中

组态设置在线帮助；

请参见“设置 PC 
站”主题

7.18.2.8 站组态编辑器

调用        

在 Windows 任务栏上，通过单击以下图标调用此工具： 
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要求

组件在组态列表中的输入顺序必须与在使用 HW Config 创建的组件映像中的顺序相同。如

果组态有所不同，则无法将其下载到 PC 站。 有关更多信息，请参见手册《过程控制系

统 PCS 7；PCS 7 - PC 组态》(Process Control System PCS 7; PCS 7 - PC 
Configuration) 的“准备 PC 站”部分。

说明

在 PC 站运行期间更改组态列表将导致关闭整个 PC 通信和重新启动。 
在此情况下，将收到相应的警告消息。

概述

主题 详细信息 调用方式 更多信息

硬件组态和 
PC 站的组态

组态列表中的状态显示表

示： 
● 已创建的组件是否与当

前的硬件组态相匹配

● 该组态是否与下载的组

态相匹配

“组件”(Components) 
选项卡

在线帮助

主题： “组件的状态

符号”

检查模块 验证模块在组态后的可访

问性。 
完成组态后，可单

击“环型”(Ring) 检查是

否能够访问模块。

倘若模块支持此功

能，模块上的显示将

指示是否可以访问该

模块。

PC 站 PC 站的诊断 “诊断”(Diagnostics) 选
项卡 >“导出”(Export) 

Save （保存）文件

需要专家知识。

如果遇到有关日志文

件内容的问题，请向

专家咨询
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7.18.2.9 打印机和打印作业

概述 

主题 详细信息 调用方式 更多信息 

设备和打印机 显示现有打印机 “启动 > 设备和打印

机”(Start > Devices 
and Printers)

通过 F1 获得在线帮

助

等待的打印作

业

显示打印作业

删除打印作业

“启动 > 设备和打印

机”(Start > Devices 
and Printers)

双击打印机名称。 

通过 F1 获得在线帮

助

7.18.2.10 PC DiagMonitor

DiagMonitor 概述   

说明

PC Diagmonitor 经认证，只能与 PCS 7 捆绑的 PC 一起使用。

主题 详细信息 调用方式 更多信息

准备 PC 站 CPU 温度、

风扇转速、

硬盘、 

RAID 磁盘

运行时间

BIOS 数据

在“开始”(Start) 菜单

的 Siemens 
SIMATIC 程序中：

PC DiagMonitor > 
Management 
Explorer

在线帮助

只有 SIMATIC PC 可
用作监视计算机。 对
于特定的类型，

DiagMonitor 需要设

备驱动程序。
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7.18.2.11 已安装的 SIMATIC 软件

概述   

主题 详细信息 调用方式 更多信息

已安装的 PCS 
7 软件版本

已安装的软件和版本，

PCS 7 软件的语言版本

 

 

在“开始”(Start) 菜单

的 Siemens 
SIMATIC 程序中： 
“SIMATIC > 产品信

息 > 已安装软件”
(SIMATIC > Product 
Information > 
Installed Software)

在线帮助

已安装的 
SIMATIC 软件

版本

计算机中安装的 SIMATIC 
软件的相关信息

在“开始”(Start) 菜单

的 Siemens 
SIMATIC 程序中： 
SIMATIC > 
SIMATIC 
Management 
Console（需要许可

证）

网络视图 > 快捷菜单

命令“确定清单数据”
(Determine 
inventory data)

更多相关信息，请参

见 SIMATIC 
Management 
Console 的在线帮助。

7.18.3 网络中的诊断

7.18.3.1 NetPro

调用

在 SIMATIC Manager 或 HW Config 中，选择菜单命令 选项 (Options) > 组态网络 
(Configure Network)。
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概述

主题 详细信息 调用方式 更多信息

组态的一致性 未联网的节点（例外： 未联

网的 MPI 节点），当只有

一个节点时，子网中的不一

致连接

网络 (Network) > 检
查一致性 (Check 
Consistency)

STEP 7 在线帮

助，“检查网络一致

性”主题

连接状态 已建立的到 SIMATIC 站的

连接

选择 CPU： PLC 
>“激活连接状态”
(Activate 
Connection Status)

 

连接状态 已建立的到 PC 站的连接 选择 PC 站： PLC 
>“激活连接状态”
(Activate 
Connection Status)

 

PROFIBUS 
上的故障

仅限于使用诊断中继器时 CPU > PROFIBUS > 
显示网络拓扑

(Display Network 
Topology)

 

DP 从站的状

态

在网络视图中显示 DP 从站 View（视图）> With 
DP Slaves（带 DP 
从站）

 

7.18.3.2 NCM S7 工业以太网

调用     

在“开始”(Start) 菜单的 Siemens SIMATIC 程序中： “STEP 7 > NCM S7 工业以太网 > 诊
断”(STEP 7 > NCM S7 Industrial Ethernet > Diagnostics)
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概述

主题 详细信息 调用方式 更多信息

CP 状态 有关已在线连接的 CP 通
信功能的运行模式动态信

息

诊断 (Diagnostics) 
> 在线 (Online) > 打
开连接 (Open 
Connection)

STEP 7 的在线帮助，

主题为： “硬件诊断”
(Hardware 
diagnostics)

手册《SIMATIC 
NET；用于工业以太网

的 NCM S7》
(SIMATIC NET; NCM 
S7 for Industrial 
Ethernet)

常规 CP 诊断和

统计功能

运行模式

扫描在以太网 CP 中记录

的事件消息

诊断 (Diagnostics) 
> 在线 (Online) > 打
开连接 (Open 
Connection)

 

诊断功能取决

于 CP 类型和运

行模式

ISO 传输连接

基于 TCP 的 ISO 连接

TCP 连接

UDP 连接

电子邮件连接

诊断 (Diagnostics) 
> 在线 (Online) > 打
开连接 (Open 
Connection)

 

7.18.3.3 SCALANCE X-300/X-400“观察器功能”

调用

通过基于 Web 的管理或 TELNET 调用
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概述

主题 详细信息 调用方式 更多信息

状态冗余管理器 观察器功能为环网结

构（工厂总线/终端总

线中的环网冗余）

提供错误诊断和错误

保护

在“开始”(Start) 菜单

的“运行”(Run) 对话

框中输入以下内容： 
“cmd” 

在 DOS 窗口中，

输入 TELNET。 有关

更多信息，请参见

《SIMATIC NET；工

业以太网交换机 
SCALANCE X-300/
X-400》(SIMATIC 
NET; Industrial 
Ethernet Switches 
SCALANCE X‑300 / 
X‑400) 文档

文档《SIMATIC 
NET；工业以太网交

换机》(SIMATIC 
NET; Industrial 
Ethernet Switches)

SCALANCE X‑300 / 
X‑400

7.18.3.4 SCALANCE X-200/X-300/X-400“闭环检测”

调用 

通过基于 Web 的管理进行调用。
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概述

相关信息 详细信息 调用方式 更多信息

闭环检测 “闭环检测”功能允许用

户指定应启用闭环检测

的端口。

基于 Web 的管理 手册《工业以太网交换机 
PH SCALANCE X - 200》
(Industrial Ethernet 
Switches PH 
SCALANCE X - 200)

手册《工业以太网交换机 
SCALANCE X - 300/X - 
400》(Industrial 
Ethernet Switches 
SCALANCE X - 300/X - 
400)

7.18.3.5 Windows“网络连接”（Network Connections）对话框

概述 

主题 详细信息 调用方式 更多信息

工业以太网上网

卡的状态

物理网络适配器和虚拟网

络适配器状态的动态显示

在“开始”(Start) 菜单

中通过“网络连接”
(Network 
Connections)

操作系统的在线帮助

7.18.3.6 NCM S7

调用       

在“开始”(Start) 菜单的 Siemens SIMATIC 程序中： “STEP 7 > NCM S7 > 诊断”(STEP 
7 > NCM S7 > Diagnostics)
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概述

主题 详细信息 调用方式 更多信息

常规 CP 诊断和

统计功能

运行模式

已连接的站

与站相关的统计功能

站概览

“常规”

（General）选项卡

● 在线帮助《NCM 诊
断》(NCM 
Diagnostics)，主

题“常规诊断功能”
(General 
diagnostic 
functions)

● 手册《SIMATIC 
NET；用于 
PROFIBUS 的 
NCM S7》
(SIMATIC NET; 
NCM S7 for 
PROFIBUS)

特定模式的诊断 有关已在线连接的 CP 通
信功能的运行模式动态信

息

  

FMS 连接 DP 主站诊断

从站的通信状态和 DP 从
站诊断的数据调用

DP 从站诊断（非被动从

站）

  

PROFIBUS 连
接

DP 主站

DP 从站

FDL 连接

FMS 连接

  

PROFIBUS 连
接

CP 的 FMS 连接中的故障

和不一致性

  

PROFINET 连
接
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7.18.3.7 拓扑编辑器 (PROFINET)

调用               

选择 PROFINET IO 系统（例如，在“配件配置”中）并调用以下菜单命令： “编辑 > 
PROFINET IO > 拓扑”(Edit > PROFINET IO > Topology)。

概述

主题 详细信息 调用方式 更多信息

设备和互连 检查已组态设备和互连 ● “表视图”(Table 
view) 选项卡 
>“在线”(Online) 
按钮

● “图形视图”
(Graphic view) 
选项卡 >“在线”
(Online) 按钮

“拓扑编辑器 > 表视

图”(Topology Editor > 
Table view) 选项卡的在

线帮助

设备和互连 离线/在线比较 ● “离线/在线比

较”(Offline/
online 
comparison) 选
项卡 >“开始”
(Start) 按钮

“拓扑编辑器 > 离线/在
线比较”(Topology 
Editor > Offline/online 
comparison) 选项卡的

在线帮助

7.18.3.8 MBSA

简介 

Microsoft 基准安全分析器 (MBSA, Microsoft Baseline Security Analyzer) 是一款面向管理

员的工具，利用它，管理员可检查 Windows 网络中是否存在安全漏洞。

概述

主题 详细信息 更多信息

安全漏洞 组态、密码、实用程序、安

全报告的创建、所需更新

● 白皮书《PCS 7 和 WinCC 的安全性概念》

(Security concept PCS 7 and WinCC)
● 来自 Microsoft® 的 MBSA 描述
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7.18.4 操作员站诊断

7.18.4.1 设备状态监视

概述

主题 详细信息 调用方式 更多信息

监视 WinCC 项目

的组件以及与其

相关的 SIMATIC 
站

已组态的组件以图形方

式在工厂画面中显示。 
在图形中，一条红线贯

穿有故障的组件。

组态设备状态监

视，然后在过程

模式中调用画面

WinCC 信息系统 在线帮

助“设备状态监视”

（Lifebeat Monitoring）

有关组态的信息，请参见

组态手册《过程控制系统 
PCS 7；操作员站》

（Process Control System 
PCS 7; Operator Station）

说明

设备状态监视和维护站

如果在工厂运行维护站，则会禁止使用“设备状态监视”来组态设备状态监视。 

7.18.4.2 SIMATIC Shell

调用  

1. 在 Windows 资源管理器的树形视图中选择“我的电脑”（My Computer）。

2. 选择“SIMATIC Shell”文件夹。

3. 从快捷菜单中选择菜单命令 设置(Settings)。
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概述

主题 详细信息 调用方式 更多信息

网络适配器 ● 本地计算机的网络适

配器

● “IP”列

本地网络适配器的当

前 TCP/IP 地址和 
MAC 地址

“网络适配器”
(Network adapters) 
列表

Simatic Shell 在线帮助

多播服务状态 
(TTL)

子网间路由跳转的最大数

量（“TTL”IP 参数）

“多播服务状态 
(TTL)”(Multicast 
service life (TTL)) 输
入行

Simatic Shell 在线帮助

多播代理 另一子网中某计算机的 
IP 地址，将其用作分配多

播数据包的替代品

“多播代理”
(Multicast proxy) 输
入行

Simatic Shell 在线帮助

兼容性 用于不同 WinCC 版本之

间通信的兼容模式

“兼容性”
(Compatibility) 复选

框

Simatic Shell 在线帮助

计算机状态更

改

当一个计算机的状态发生

改变时，将向所有的站发

送一条消息，例如：

● 计算机对项目进行了

归档时

● 计算机关闭时

● 计算机启动，进而成

为网络/站组的一部分

时。

 WinCC 信息系统 在线

帮助

通信设置 ● 时间加密设置

● 移植模式

“设置...”(Settings...) 
菜单 

文档《过程控制系统 
PCS 7；PC 组态》

(Process Control 
System PCS 7; PC 
Configuration)
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7.18.4.3 WinCC“系统信息”（System Info）通道

简介

使用 WinCC“系统信息”（System Info）通道评估来自服务器 PC 的系统信息。

此通道不需要硬件，因为在安装了该通道的服务器 PC 上能够直接访问系统信息。

说明

只有来自单个服务器的系统信息才能够在客户机上表示或评估。

概述

主题 详细信息 调用方式 更多信息

时间信息 在过程画面中，显示日时钟、

日期和星期

在已组态的画面中

显示

WinCC 信息系统 在
线帮助，主题为： 
“通讯 > 系统信息”

（Communication > 
System Info）

CPU 负载 趋势显示中的 CPU 负载 在已组态的画面中

显示

 

驱动器容量 -  

存储空间

● 在多客户机系统上，显示

并监视不同服务器的驱动

器可用容量

● 监视可用的驱动器容量和

消息触发

在已组态的画面中

显示

 

定时器和计数器 使用定时器

和计数器（例如，计算运行小

时数）

在已组态的画面中

显示

 

事件触发 通过在脚本中评估系统信息触

发事件

在已组态的画面中

显示

 

组态

WinCC 信息系统 在线帮助，“通讯（Communication）> 系统信息（System Info）> 通
道组态（Channel Configuration）> 如何组态通道系统信息（ How to Configure the 
Channel System Info）”。
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7.18.4.4 用户管理器

调用

在“开始”(Start) 菜单的 SIEMENS SIMATIC 产品下，选择菜单命令 WinCC Explorer。

概述

主题 详细信息 调用方式 更多信息

对于 OS

创建用户 

设置访问权限

为 PCS 7 操作站的用户分

配和验证访问权限： 
● 对于过程模式

● 对于组态系统编辑器

在 WinCC 项目管理器

的树形视图中选择：

编辑器（Editors）> 
用户管理器

（User Administrator）
> 打开（Open）

有关

WinCC 信息系统在线

帮助，请参见“用户管

理器功能”和“防止未

经授权的操作”主题

7.18.4.5 WinCC 通道诊断

调用              

在“开始”(Start) 菜单的 Siemens SIMATIC 程序中： “WinCC > 工具 > 通道诊断”(WinCC 
> Tools > Channel Diagnostics)

PCS 7 中的诊断
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概述

主题 详细信息 调用方式 更多信息

连接 已组态的通道及其与 SIMATIC 站
的连接（直接或通过 Internet 
Explorer 的网络连接）的状态概

览

“通道/连接”
(Channels/
Connections) 标
签

WinCC 信息系统 在
线帮助“如何测试通

道和连接”（How 
to Test the Channel 
and the 
Connection）

跟踪模式 可在过程模式下激活跟踪模式（这

会影响到运行系统）

仅支持专家 WinCC 信息系统 在
线帮助“如何组态通

道的跟踪功能”

（How to Configure 
the Trace Function 
of a Channel）

更多信息

WinCC 信息系统 在线帮助“使用通道诊断进行通道诊断”（Channel Diagnostics Using 
Channel Diagnosis）

7.18.4.6 多用户操作的状态

调用       

OS 服务器和 OS 客户端之间连接的诊断

仅限 WinCC 处于过程模式时： 在 WinCC 项目管理器的菜单中。

PCS 7 中的诊断
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概述

主题 详细信息 调用方式 更多信息

连接状态 状态 - 服务器和客户端之

间接口的逻辑连接和当前

状态

工具 (Tools) > 多用

户操作的状态 
(Status of Multi-
User Operation)

WinCC 信息系统 在线帮

助，主题为： “多用户操

作的选项状态”

（Options Status of 
multi-user operation）

服务器上的连

接状态

多用户操作中的当前连接

状态

“过程数据服务器”

（Process Data 
Server）选项卡

 

客户端上的连

接状态

启动了扫描的客户端的当

前状态

“过程数据客户端”

（Process Data 
Clients）标签

 

7.18.4.7 连接状态

概述

主题 详细信息 调用方式 更多信息

连接状态 
(OS-AS)

WinCC 和自动化系统之间

的连接 

状态 - 过程接口的逻辑连

接和当前状态

仅限 OS 处于过程模

式时： 在 WinCC 项
目管理器的菜单

中。 工具 (Tools) > 
连接状态 (Status of 
Connections)

WinCC 信息系统 在线帮

助，主题为： “检查连接

状态”（Checking the 
status of the 
connection）

OS 连接（服

务器 - 客户端）

本地客户端的连接诊断的

整体状态

请参见“多用户操

作的状态 (页 156)”
部分 
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7.18.4.8 区域总览

概述

主题 详细信息 调用方式 更多信息

在 OS 客户端上

显示所连 OS 服
务器的状态

冗余监视的视觉显示，

请参见下表：

总览区中图标颜色的含

义

在过程模式下，单

击区域总览中

的“已连接服务器

的状态”(Status of 
the connected 
servers) 按钮。

功能手册《过程控制系

统 PCS 7；OS 过程控

制》(Process Control 
System PCS 7; OS 
Process Control)
 

总览区中图标颜色的含义

图标颜色 含义

绿色 被监视服务器处于过程模式且状态为“正常”。

红色 一台或多台服务器的状态为：服务器“故障”。

红色（闪烁） 故障状态尚未确认。

黄色 一台或多台服务器的状态为：服务器“故障”且冗余失效。

黄色（闪烁） 故障状态尚未确认。

（无图标） ● OS 客户端上的启动列表中缺少进

程“CCEmergencyWatchRTServer.exe”。

● 客户端上未加载任何服务器数据。

说明

冗余单工作站系统

冗余状态更改会生成过程控制消息。
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7.18.4.9 显示冗余状态

概述                

对于包含冗余 PC 的工厂，随时可获取冗余状态的总览以便诊断是非常重要的。冗余状态

代表各主站计算机和备用计算机的状态。 为此，可在过程画面中组态冗余状态的显示。

● 在 OS 客户端上，将显示分配给 OS 客户端的冗余服务器对和非冗余服务器的状态。

● 服务器状态会显示在 OS 服务器上。

主题 详细信息 调用方式 更多信息

冗余 OS 组件

状态

主机；备用机

独立

连接

● 未初始化

● 已初始化

● 无连接

● 故障

在 WinCC 项目中创

建 OS 服务器的画

面。 插入一个控件。

图形编辑器： “对象”
(Object) 选择板 >“默
认”(Default) 选项卡 > 
在“智能对象”(Smart 
Objects) 树形视图中 
> 将该控件拖放至画

面中 > 在“插入控件”
(Insert control) 对话

框中 >
选择“PCS 7 冗余状态

控件”(PCS 7 
Redundancy State 
Control)

有关组态的更多信息，请

参阅组态手册《过程控制

系统 PCS 7；操作站》

(Process Control 
System PCS 7; Operator 
Station)

诊断画面中冗余 OS 服务器的状态

如果使用维护工作站，块图标将在诊断区域显示冗余 OS 服务器的冗余状态。 

有关冗余组件状态显示的块图标信息，可参考文档《过程控制系统 PCS 7；维护工作站》

(Process Control System PCS 7; Maintenance Station)。
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7.18.4.10 OS 服务器的时间主站角色（状态）

概述                 

工厂总线上的时间主站 OS 服务器状态可显示在工厂画面中。 可使用一个 BCE 网络适配

器或最多两个通信处理器（例如 CP 1623）作为实施时间同步的接入点。 

在面板上组态以下内部文本变量后，便可确定过程模式下的接入点状态：

● 网络适配器 1 : @TimeSyncDevice1State

● 网络适配器 2 : @TimeSyncDevice2State

相关信息 详细信息 调用方式 更多信息

OS 服务器的

时间主站（状

态）

状态信息

● Active master
● Standby master
● Slave
● Deactivated

OS 的过程画面

● 面板上的已组态文本

变量

有关组态信息，请参见 
WinCC 信息系统的在线

帮助

7.18.5 BATCH 站的诊断

7.18.5.1 BATCH 服务器任务栏中的状态图标

概述         

相关信息 详细信息 调用方式 更多信息

状态服务器 BATCH 服务器任务栏中的 BATCH 启动协

调程序

可从快捷菜单中打

开 BATCH 启动协调

程序。

 

SIMATIC BATCH 的在

线帮助

 
冗余服务器的

状态

监视 BATCH 客户端上的 BATCH 启动协调程序

可以通过在 BATCH 客户端上运行 BATCH 启动协调程序来监视任意批生产设备的状态，

不必安装 BATCH 服务器。 在启动协调程序启动时，将会打开一个包含所有加载的批生产

设备的对话框，以实现此目的。 选择批生产设备后，启动协调程序的符号连同设备的状态

会出现在 BATCH 客户端的状态栏中。 
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BATCH 启动协调程序的状态符号   

该符号包含 SIMATIC BATCH 的状态显示。 下表中列出了可能的状态。

符号 含义

无状态符号。 未连接到 BATCH 项目。 未加载 BATCH 项目，SIMATIC BATCH 正在

等待 BATCH 数据。 或者已加载 BATCH 数据，但服务器应用程序尚未启动。

SIMATIC BATCH 准备就绪 (Ready)。 BATCH 项目已加载并启动。 

中间状态。 正在发生状态变化 (Processing)。 

中间状态。 准备转换为“运行”状态 (Running Prepared)。

SIMATIC BATCH 正在 BATCH 主站或 BATCH 单工作站系统上运行 (Running)。 
BATCH 项目已加载并启动，且 BATCH Runtime 已启动。 

SIMATIC BATCH 正在 BATCH 备用站上运行 (Listening)。 BATCH 项目已加载并启

动，且 BATCH Runtime 已启动。

中间状态。 准备转换为“侦听”状态 (Listening Prepared)。

中间状态，正在切换为 BATCH 主站 (Switch up)。 状态从 Listening 切换为 Running.

中间状态，正在切换为 BATCH 备用站 Switch down。 状态从 Running  切换为  
Listening. 

SIMATIC BATCH 出错 (Fault)。 

说明

例如，在 BATCH 服务器冗余切换期间，Processing、Switch up, Running Prepared, 
Switch down, Listening Prepared  的组合状态是临时的。

7.18.5.2 订单文件夹处的状态显示

除了批生产订单文件夹符号外，还有用于显示订单文件夹中所有批生产组合状态的符号。 
扩展批生产信息会覆盖此符号，以动态方式显示。  
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可能的显示

符号 组合批生产状态

“未激活”状态

文件夹中包含的批生产具有以下其中一种状态：

● 已规划

● 已完成

● 已暂停

● 已中止

● 已发布

● 已取消

● 未知

 “激活”状态

订单中至少有一个批生产为“等待”或“运行”状

态。 

“已暂停”状态

订单中至少有一个批生产为“正在保持/正在暂停”

或“已保持/已暂停”状态。 所有其它批生产均未激

活或已完成/已中止/已停止。  

“未知”状态

该符号指示确定所有订单文件夹的状态信息所需的时

间段。 这是一个过渡状态，之后会变为以上三种状态

中的其中一种状态。 

覆盖订单文件夹的符号 扩展组合批生产状态 

操作员操作 

订单中至少有一个批生产需要操作员手动输入。 

错误

订单中至少有一个批生产存在错误。

PCS 7 中的诊断

7.18 诊断工具

服务支持和诊断 (V8.1)
162 维修手册, 11/2014, A5E32786003-AA



7.18.6 路径控制站的诊断

7.18.6.1 路径控制服务器任务栏中的状态图标

概述         

使用 SIMATIC Route Control，Route Control 服务器任务栏中的状态图标将指示冗余状

态。

相关信息 详细信息 调用方式 更多信息

冗余服务器的

状态

过程模式下服务器的状

态显示：

双击某个状态图标，

以便显示包含该服务

器状态相关信息的字

段。

有关冗余 Route Control 
服务器的信息，请参阅手

册《SIMATIC Route 
Control》。

主服务器的任

务栏中的图标

备用服务器的

任务栏中的图

标

7.18.7 SIMATIC 站的诊断

7.18.7.1 SIMATIC Manager

调用                                              

在“开始”(Start) 菜单的 Siemens SIMATIC 程序中： SIMATIC Manager

PCS 7 中的诊断

7.18 诊断工具

服务支持和诊断 (V8.1)
维修手册, 11/2014, A5E32786003-AA 163



概述

主题 详细信息 调用方式 更多信息

诊断硬件 快速查看： 图标指示操作

状态或模块状态。 
PLC > 诊断/设置 
(Diagnostics/
Setting) > 硬件诊断 
(Hardware 
Diagnostics)

然后，模块信息 
(Module 
Information) > 更新 
(Update)：  F5 键 

STEP 7 的在线帮助，

主题为： “硬件诊断和

故障诊断”(Hardware 
diagnostics and 
troubleshooting)

相关信息，可参考

“模块信息 (页 166)”
部分。

更多信息： 双击图标

模块信息 使用此菜单命令,读出有关

所选模块的信息。

选择 CPU 或 CP：  
PLC > 模块信息 
(Module information)

STEP 7 的在线帮助，

主题为： “硬件诊断和

故障诊断”(Hardware 
diagnostics and 
troubleshooting)

相关信息，可参考

“模块信息 (页 166)”
部分。

运行模式 显示当前模块的运行模式

（RUN、STOP）。

这需要与 CPU 进行在线

连接。

选择 CPU 或 CP：  
PLC > 模块信息 
(Module information)

 

时间 检查/设置时钟 选择 CPU： PLC > 
诊断/设置 
(Diagnostics/
Setting) > 设置时钟 
(Set Time of Day) > 
设置时钟(Set Time 
of Day)

STEP 7 在线帮助，主

题“具有时区设置和

夏季/冬季时的 CPU 
时钟”(CPU Clocks 
with Time Zone 
Setting and Summer/
Winter Time) 及“使

用时钟功能”(Using 
the Clock Functions) 
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主题 详细信息 调用方式 更多信息

PROFIBUS 上
的故障

● 总线段故障

● 错误位置与诊断中继

器间的距离

选择主站系统： PLC 
> PROFIBUS 节点诊

断、监视/修改节点 
(PROFIBUS Node 
Diagnostics, 
Monitor/Modify 
Node)

STEP 7 在线帮助，主

题“使用诊断中继器

的拓扑显示”
(Topology display 
using diagnostics 
repeaters)

所有安装的许可

证

（已安装组件的

许可证密钥和授

权版本）

● 产品（名称、版本、

发布）

● 组件（名称、版本、

发布）

● 固件更新

● DLL（STEP 7 DLL、
Windows DLL）

帮助(Help) > 关于

(About) > 显示

(Display) 按钮

STEP 7 在线帮助，主

题“已安装的 
SIMATIC 软件”
(Installed SIMATIC 
software)

现场设备

● PA 设备

● FF 设备

● HART 设备

要求： 已安装 SIMATIC 
PDM。 
● 图标提供有关这些设

备状态的信息

“视图 > 过程设备工

厂视图”(View > 
Process Device 
Plant View)

选择设备。

选择快捷菜单命令 打
开对象(Open 
Object)。

SIMATIC PDM 在线

帮助 > 组态网络和过

程设备

图标： ...> 过程设备

工厂视图中的设备图

标

PCS 7 软件的语

言版本

 

语言版本

欧洲语言版本； 

亚洲语言版本

帮助 (Help) > 关于 
(About) > 

单击“显示”
(Display)。

“产品”(Products) 选
项卡

__SIMATIC PCS 7 
EU__ = 欧洲语言版

本 

__SIMATIC PCS 7 
CHS__ = 亚洲语言版

本

7.18.7.2 HW Config

调用                

在“开始”(Start) 菜单的 Siemens SIMATIC 程序中： SIMATIC Manager。 在树形视图中，

单击“SIMATIC 站”(SIMATIC Station)，然后在选择列表中双击“硬件”(Hardware)。
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概述

主题 详细信息 调用方式 更多信息

可在线访问组

件

图标指示模块的

运行模式

（= 系统诊断）。 

站 (Station) > 在线打

开 (Open Online)
通过 <F5> 键刷新显示。 双
击该图标以获得更多信息。

时间 检查/设置 站 (Station) > 在线打

开 (Open Online)

选择 CPU： PLC > 设
置时钟 (Set Time of 
Day)

STEP 7 在线帮助，主题“具

有时区设置的 CPU-xxx 时钟”
(CPU-xxx clocks with time 
zone setting)、“夏令时/标准

时间”(Daylight-saving/
standard time) 及“使用时钟

功能”(Using the clock 
functions)

模块信息 使用此菜单命令读

取所选

模块的信息。

选择模块： PLC > 模
块信息 (Module 
information)

相关信息，可参考“模块信

息 (页 166)”部分。

更多相关信息，参考 STEP 7 在线帮助。

● 在线视图中的诊断图标

● 快速视图中的信息功能

● 确定 STOP (CPU) 原因的基本过程

● 硬件诊断和故障诊断

● 运行模式和运行模式转换

7.18.7.3 模块信息

调用快速信息

1. 在 SIMATIC Manager 中通过选择菜单命令 组件视图 (Component View) > 视图 (View) > 在
线 (Online)，调用快速信息。

2. 使用菜单命令 CPU > 诊断/设置 (Diagnostics/Settings) > 硬件诊断 (Hardware Diagnostics)，
选择 SIMATIC 站。

附加诊断： 选择模块，单击“模块信息 (Module Information)”
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调用模块诊断

1. 打开 HW Config。

2. 选择菜单命令 站 (Station) > 在线打开 (Open Online)。

3. 选择模块。

4. 选择菜单命令 PLC > 模块信息 (Module Information)。

CPU 的诊断

在 CPU 上进行扩展诊断检查。

更多信息： 
STEP 7 帮助“诊断、硬件诊断和故障诊断”(Diagnostics, hardware diagnostics and 
troubleshooting)

主题 详细信息 调用方式 更多信息

模块数据 用于识别所选模块实例的数

据：

● 类型

● 订货号

● 固件

● 版本

● 状态

● 机架中的插槽

“常规”(General) 选
项卡

已组态和已插入模块

的比较

诊断缓冲区中

的事件和有关

所选事件的详

细信息

分析 CPU 停止的原因，有

关所选模块的事件的历

史。 

所选模块的诊断数据

“诊断缓冲区”
(Diagnostic Buffer) 标
签 

检查诊断缓冲区中的

事件和有关所选事件

的详细信息

DP 从站诊断 所选 DP 从站的诊断数据

（符合 EN 50170） 
“DP 从站诊断”(DP 
Slave Diagnostics) 标
签

确定 DP 从站的故障

原因

目标系统 当前时间、运行小时数和

有关时钟同步的信息（同步

间隔） 

“时间系统”(Time 
System) 标签
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主题 详细信息 调用方式 更多信息

性能数据 所选 (CPU/FM) 模块的操作

数区域和可用块 
“性能数据”
(Performance Data) 
标签 

检查用户程序以确定 
CPU 是否满足执行用

户程序的相应要求，

例如过程映像的大小 

 

性能数据 显示在所选模块的功能范围

内

所有可用的模块类型。 可
在模块中使用的 OB、SFB 
和 SFC 的列表。 

用于检查在用户程序

中包含及调用的标准

块。

 

DP 从站的诊断

主题 详细信息 调用方式 更多信息

模块数据 用于识别所选模块实例的数

据：

● 类型

● 订货号

● 固件

● 版本

● 状态

● 机架中的插槽

“常规”(General) 选
项卡

已组态和已插入模块

的比较

DP 从站诊断 所选 DP 从站的诊断数据

（符合 EN 50170） 
“DP 从站诊断”(DP 
Slave Diagnostics) 
标签

确定 DP 从站的故障

原因

7.18.7.4 带诊断中继器的 PROFIBUS 诊断

要求

● 必须已安装诊断中继器。

● 必须准备了电缆诊断。
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调用

在 HW Config 中选择诊断中继器。

选择菜单命令 PLC >“诊断/设置”(Diagnostics/Setting) >“模块信息”(Module Information)

更多信息： 
STEP 7 帮助，主题“诊断、硬件诊断和故障诊断”(Diagnostics, hardware diagnostics and 
troubleshooting)

概述

主题 详细信息 调用方式 更多信息

快速概览 

总线段上的

故障

指示 PROFIBUS 主站

系统状态的图标

“模块信息”(Module 
Information) 对话框

● 状态

● 图标位于标签名

（DP1、DP2、DP3、
PG）的前面

STEP 7 的在线帮助，主

题为： “硬件诊断和故障

诊断”(Hardware 
diagnostics and 
troubleshooting)

已组态和已插入模块的

比较

DP 从站诊

断 
所选 DP 从站的诊断数

据（符合 EN 50170） 
“DP 从站诊断”(DP 
Slave Diagnostics) 标签

确定 DP 从站的故障原

因

错误位置 错误位置的图形化表示   

7.18.7.5 SIMATIC PDM

简介

SIMATIC PDM 是一个用于对现场设备（例如，传感器）进行组态、参数分配、调试和维

护的软件包。
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概述

主题 详细信息 调用方式 更多信息

快速信息；显

示组态

图标提供组态和设备状

态概览

（然后： 请参见下面的

设备状态）

在 SIMATIC Manager 
中： “视图 > 过程设备

工厂视图”(View > 
Process Device Plant 
View)

SIMATIC PDM 在线

帮助，“组态网络和

设备”

图标： ...> “功能 > 诊
断 > 设备图标总览”
(Functions > 
Diagnostics > 
Overview of device 
icons)

设备信息 ● 类型

● EDD/DLL（类型文

件）

● 制造商

● 版本

在“过程设备工厂视图 > 
选择设备 > 编辑 > 对象属

性”(Process Device 
Plant View > Select 
device > Edit > Object 
properties) 中打开项目

“设备”(Device) 选项卡

SIMATIC PDM 在线

帮助

设备状态 ● 通信

● 维护状态

● 过程错误

● 组态错误

● 全部状态

● 设备特定的消息文本

在“过程设备工厂视图 > 
选择设备 > 编辑 > 对象属

性”(Process Device 
Plant View > Select 
Device > Edit > Object 
Properties) 的“诊断”
(Diagnostics) 选项卡中，

打开“设备状态”(Device 
status) 列表中的项目

SIMATIC PDM 在线

帮助（如果制造商文

件可用）

文档管理器 调用分配给设备的文档 在“过程设备工厂视图 > 
选择设备 > 编辑 > 对象属

性”(Process Device 
Plant View > Select 
device > Edit > Object 
properties） 的“文档管

理器”(Document 
Manager) 选项卡中打开

项目 

SIMATIC PDM 在线

帮助
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主题 详细信息 调用方式 更多信息

在线确定现场

设备（自 
SIMATIC 
PDM V8.0 
SP1 起的 
LifeList, ）

LifeList – 确定可用设备

（PROFIBUS/基金会现

场总线） 

在“开始”(Start) 菜单的 
Siemens SIMATIC 程序

中： 启动 SIMATIC PDM 
>“视图”(View) > LifeList

操作手册

《SIMATIC；

SIMATIC PDM 帮助》

(SIMATIC; 
Help for SIMATIC 
PDM)

远程访问现场

设备

设备信息 通过 Internet Explorer 打
开 SIMATIC PDM 的 
Web 界面

操作手册

《SIMATIC；

SIMATIC PDM 帮助》

(SIMATIC; 
Help for SIMATIC 
PDM)

7.18.8 附加诊断选项

7.18.8.1 PCS 7 的附加诊断选项

免责声明

注意

免责声明

对因不正确使用本文档中提供的说明而可能给客户带来的任何后果，西门子概不承担任何

责任。

注意

请注意以下几点：

● 只有经过培训的维修人员才有权操作过程控制系统。

● 对系统进行更改时，请始终遵守工厂特定规则和政府法规。

● 请遵守工厂特有限制条件并相应地对工作进行调整。

● 请始终记住，对系统的更改可能会影响系统的其它部分。
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概述

下面列出的组件和工具不属于 PCS 7 的一部分，它们可用来进行高级测试和诊断。 下述

部分中也包含一些适于 PCS 7 的诊断应用程序：

● SIMATIC PCS 7 Condition Monitoring Library (页 172)

● BANY（附加产品） (页 172)

● 系统过程控制诊断（附加产品） (页 174)

7.18.8.2 SIMATIC PCS 7 Condition Monitoring Library

SIMATIC PCS 7 Condition Monitoring Library 以 PCS 7 Advanced Process Library 的块

为基础的一个附加块库。 该库用于机械资产（如泵和阀）的诊断和维护。

通过库中包含的块，可经济高效地实现机械资产的监视和分析。 

用户因此可以在早期发现可能的损坏，从而提高工厂的效率和可用性。 

7.18.8.3 BANY（附加产品）

概述

BANY  是一款基于 Microsoft Windows 的工具，用于对 PCS 7 以太网、PROFINET  及 
PROFIBUS 网络进行文档编制、诊断、记录和分析。

下面的程序包可以单独提供，也可以捆绑提供：

程序包 应用 安装后通过“开始”(Start) 菜单调用程

序：

BANYnet 以太网网络的诊断工具 “程序 > BANYnet”(Programs > 
BANYnet)。    

BANY PROFIBUS PROFIBUS 网络的诊断

工具

“程序 > BANY PROFIBUS”(Programs 
> BANY PROFIBUS)。    

BANY PNIO PROFINET 网络的诊断

工具

“程序 > BANY PNIO”(Programs > 
BANY PNIO)。    

PCS 7 中的诊断
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要求

● 要通过 BANY PROFIBUS 来分析 PROFIBUS 的 PC 必须配有 PROFIBUS 网络适配

器 (CP 5512)。

● 如果要同时分析终端总线和工厂总线，则 PC 必须配有两个以太网网络适配器。

BANYnet

下表列出了使用 BANYnet 诊断以太网网络的选件：

主题 详细信息 调用方式 更多信息

系统组态 目标/实际组态之间的比较、图

形总览、设备状态监视

在“启动”(Start) 窗口中，

通过“工厂管理器”(Plant 
Manager) 按钮

在线帮助

消息帧通信 解释（包括 PCS 7）、统计、

批生产分析

在“启动”(Start) 窗口中，

通过“总线分析”(Bus 
Analysis) 按钮

在线帮助

总线记录 并行记录、特殊触发、过滤 通过“总线分析”(Bus 
Analysis) 对话框中的菜单

调用

在线帮助

BANY PROFIBUS

下表列出了使用 BANY PROFIBUS  诊断 PROFIBUS 网络的选件：

主题 详细信息 调用方式 更多信息

系统组态 目标和实际组态之间的比较、

图形总览、主站/从站监视、设

备状态监视

显示、参数分配

在“启动”(Start) 窗口中，

通过“工厂管理器”(Plant 
Manager) 按钮

在线帮助

总线分析，传输速率为 
9.6 Kbps 到 12 Mbps

总线负载测量、解释（包括 
PCS 7）、统计、批生产分析、

总线瓶颈、有效储量、冗余分

析

在“启动”(Start) 窗口中，

通过“总线分析”(Bus 
Analysis) 按钮

在线帮助

总线记录 并行记录、特殊触发、过滤 

可借助于触发器自动开始和结

束记录。

通过“总线分析”(Bus 
Analysis) 对话框中的菜单

调用

在线帮助

PCS 7 中的诊断
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BANY PNIO

下表列出了使用 BANY PNIO  诊断 PROFINET 网络的选件：

主题 详细信息 调用方式 更多信息

系统组态 目标和实际组态之间的比较、

图形总览、主站/从站监视、设

备状态监视

显示、参数分配

在“启动”(Start) 窗口中，

通过“工厂管理器”(Plant 
Manager) 按钮

在线帮助

总线分析，传输速率高

达 100 Mbps
总线负载测量、解释（包括 
PCS 7）、统计、批生产分析、

总线瓶颈、可用预留量、冗余

分析、运行中和实时分析

在“启动”(Start) 窗口中，

通过“总线分析”(Bus 
Analysis) 按钮

在线帮助

总线记录 并行记录、特殊触发、过滤、

同步检查

可借助于触发器自动开始和结

束记录。

通过“总线分析”(Bus 
Analysis) 对话框中的菜单

调用

在线帮助

7.18.8.4 系统过程控制诊断（附加产品）

简介

在操作站上显示 PROFIBUS 诊断信息

在线帮助： 系统诊断帮助

概述

主题 详细信息 调用方式 更多信息

PROFIBUS DP – 常规 站故障

来自 HW Config 的显

示

OS 中的画面 组态： 请参见在线帮

助 1)  

PROFIBUS DP 故障 包含故障原因的详细

信息的故障指示

OS 中的画面 组态： 请参见在线帮

助 1)  

PCS 7 中的诊断
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主题 详细信息 调用方式 更多信息

来自 HW Config
的信息

“名称和注释” OS 中的画面 组态： 请参见在线帮

助 1)  

组态信息 订货号、地址、插槽

类型

OS 中的画面 组态： 请参见在线帮

助 1) 

1) 在线帮助系统诊断 - 帮助 >“PROFIBUS DP/PA 诊断”（PROFIBUS DP/PA 
DIAGNOSTICS）部分。

PCS 7 中的诊断
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故障、更换和返回 8
8.1 故障、更换和返回 - 文档指南

文档指南   

有关组件响应以及如果发生故障、更换和返回之后所要遵循的过程的信息，可参考以下文

档：

方案 有关信息，可参考…… 部分...

I/O

模块的故障和功能

故失常

手册《自动化系统 S7-400 
CPU 规范》(Automation 
System
S7-400 CPU 
Specifications)

● CPU 的监视功能 (Monitoring 
functions of the CPU)

SIMATIC
ET 200M 的故障和

功能失常

手册《SIMATIC 分布式 I/O 
设备 ET 200M》(SIMATIC 
Distributed I/O device
ET 200M)

● 调试和诊断 (Commissioning and 
diagnostics)

SIMATIC
ET 200iSP 的故障

和功能失常

手册《SIMATIC 分布式 I/O 
设备 ET 200iSP》
(SIMATIC Distributed I/O 
device
ET 200iSP)

● 调试和诊断

SIMATIC
ET 200S 的故障和

功能失常

手册《SIMATIC 分布式 I/O 
设备 ET 200S》(SIMATIC 
Distributed I/O device
ET 200S)

● 调试

● 布线和安装

● 容错操作

SIMATIC
ET 200pro 的故障

和功能失常

手册《SIMATIC 分布式 I/O 
设备 ET 200pro》
(SIMATIC Distributed I/O 
device
ET 200pro)

● 报警、错误和系统消息

服务支持和诊断 (V8.1)
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方案 有关信息，可参考…… 部分...

ex I/O 模块的故障

和功能失常

手册《可编程控制器 
S7-300，ET 200M Ex I/O 
模块》(Programmable 
Controller 
S7-300, ET 200M
Ex I/O modules)

● SIMATIC S7 ex 数字模块 (SIMATIC 
S7 ex digital modules)

● 模拟模块的诊断 (Diagnostics for 
analog modules)

冗余 I/O 模块的故

障和功能失常

组态手册《过程控制系统 
PCS 7；容错过程控制系

统》

(Process Control System 
PCS 7; Fault-Tolerant 
Process Control Systems)

● 冗余 I/O 模块故障

● 发生通道错误时，如何针对 I/O 模块

的响应来设置 CPU

分布式 I/O 组件的

故障和功能失常

手册《可编程控制器 
S7-400H；容错系统》

(Programmable Controller 
S7-400H; Fault-Tolerant 
Systems)：

● PROFIBUS DP 主站的故障和更换 
(Failure and Replacement of a 
PROFIBUS DP Master)

● 冗余 PROFIBUS DP 接口模块的故

障和更换 (Failure and Replacement 
of a Redundant PROFIBUS DP 
Interface Module)

● 冗余 PROFIBUS DP 从站的故障和

更换 (Failure and Replacement of a 
Redundant PROFIBUS DP Slave)

● 冗余 PROFIBUS DP 线路的故障和

更换 (Failure and Replacement of 
Redundant PROFIBUS DP Lines)

使用 PDM 组态的

设备故障

手册《SIMATIC；过程设备

管理器》(SIMATIC; The 
Process Device Manager)

● 设备更换 (Device Replacement)

自动化系统

冗余 AS 中的 CPU 
故障

组态手册《过程控制系统 
PCS 7；容错过程控制系

统》

(Process Control System 
PCS 7; Fault-Tolerant 
Process Control Systems)

● 主 CPU 故障

故障、更换和返回
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方案 有关信息，可参考…… 部分...

冗余 AS 中 CPU 之
间的同步故障

组态手册《过程控制系统 
PCS 7；容错过程控制系

统》

(Process Control System 
PCS 7; Fault-Tolerant 
Process Control Systems)

● 光纤电缆故障

通信

故障和功能失常：

SCALANCE 
X-400

操作说明《SIMATIC 
NET；工业以太网交换机 
SCALANCE X-400》(
SIMATIC NET; 
Industrial Ethernet 
Switches SCALANCE 
X-400)

● 安装和调试 (Installation and 
Commissioning)
– 安装和删除 (Installation and 

removal)
– 显示 LED (Displaying LEDs)
– 更换 C-PLUG (Replacing the C-

PLUG)

故障和功能失常：

SCALANCE 
X-200

调试手册

《SIMATIC NET；工业以太

网 SCALANCE X-100 和 
SCALANCE X-200 产品线》

(SIMATIC NET; Industrial 
Ethernet
SCALANCE X-100 and 
SCALANCE X-200 
product line)

● 安装和维护 (Installation and 
Maintenance)

● 通过远程机制组态/诊断 
(Configuration/Diagnostics via 
Remote Mechanisms)

● SCALANCE X2<...> 显示 
(SCALANCE X2<...> Display)

中断的网络连接 组态手册《PCS 7 过程控制

系统；容错过程控制系统》

(PCS 7 Process Control 
System; Fault-Tolerant 
Process Control Systems)

● 冗余 OS 服务器的故障、故障转移和

重启动

– 到 OS 伙伴服务器的网络连接中

断

– OS 客户端与 OS 服务器之间的网

络连接中断

– OS 与 AS 之间的网络连接中断

PROFIBUS DP 上
的故障

手册《SIMATIC；

PROFIBUS DP 的诊断中继

器》(SIMATIC; Diagnostic 
Repeater for PROFIBUS 
DP)

● 安装

● 调试

● 诊断

故障、更换和返回
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方案 有关信息，可参考…… 部分...

PROFINET 上的故

障

手册《SIMATIC; 
PROFINET System 
Description》

● PROFINET IO 的诊断

● PROFINET CBA 的诊断

操作员监控工作站

冗余 OS 服务器的

故障

组态手册《PCS 7 过程控制

系统；容错过程控制系统》

(PCS 7 Process Control 
System; Fault-Tolerant 
Process Control Systems)

● 冗余 OS 服务器的故障

OS 服务器发生故

障时 OS 客户端的

切换响应

组态手册《PCS 7 过程控制

系统；容错过程控制系统》

(PCS 7 Process Control 
System; Fault-Tolerant 
Process Control Systems)

● OS 服务器发生故障时 OS 客户端的

切换响应

BATCH 服务器的

故障

手册《过程控制系统 PCS 
7；SIMATIC BATCH》

(Process Control System 
PCS 7; SIMATIC BATCH)

● BATCH 服务器的故障

BATCH 服务器发

生故障时 BATCH 
客户端的切换响应

手册《过程控制系统 PCS 
7；SIMATIC BATCH》

(Process Control System 
PCS 7; SIMATIC BATCH)

● BATCH 服务器发生故障时 BATCH 
客户端的切换响应

Route Control 服务

器对故障的响应

手册《过程控制系统 PCS 
7；SIMATIC Route 
Control》(Process Control 
System PCS 7; SIMATIC 
Route Control)

● Route Control 服务器对故障的响应

如果 Route 
Control 服务器出现

故障，Route 
Control 客户端的切

换响应

手册《过程控制系统 PCS 
7；SIMATIC Route 
Control》(Process Control 
System PCS 7; SIMATIC 
Route Control)

● 如果 Route Control 服务器出现故

障，Route Control 客户端的切换响

应

故障、更换和返回

8.1 故障、更换和返回 - 文档指南

服务支持和诊断 (V8.1)
180 维修手册, 11/2014, A5E32786003-AA



索引

A
AS-OS 连接, 124

诊断, 124

B
BANY, 172

BANY PROFIBUS, 172
BANY PROFINET, 172
BANYnet 以太网, 172
调用, 172

BANYnet
调用, 172

BATCH 站的诊断, 126

C
CP 341 固件更新, 52
CP 443-1 固件更新, 53
CP 443-5 Extended 固件更新, 55
CP 诊断 – 以及统计功能, 146
CP 状态, 146
CPU, 118

诊断, 118
CPU 操作系统

更新, 44
固件, 44

CPU 负载, 154
CPU 故障, 97

准备诊断, 97
CPU 诊断缓冲区, 96

读取, 96

D
DiagMonitor, 144
DOS 窗口/命令提示符, 93
DP 从站, 145, 166

诊断, 166
状态, 145

DP 从站诊断, 168

E
ESM, 172

状态, 172

F
FMS 连接, 149, 151
Foundation Fieldbus 的诊断, 123

H
HART 设备, 163
HW Config, 118, 165

CPU 的诊断, 118
调用, 165
模块信息, 165

I
IM, 48

固件更新, 48

M
MBSA, 151

N
NetPro, 145

O
OS, 155

通道诊断, 155
OS 服务器, 159

冗余的诊断, 159
时间主站角色, 160

OS 服务器的时间主站角色, 160
OS 故障 - 诊断, 99

准备诊断, 99
OSM, 172

状态, 172
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P
PA 设备, 163
PC DiagMonitor, 145
PC 用户设置, 110

诊断 (Diagnostics), 110
PC 站, 142
PC 组件, 75, 111

检查诊断, 75
诊断, 111

PCS 7 OS 数据, 29
备份, 29

PCS 7 的附加诊断选项, 171
PDM - 设备, 169
PROFIBUS, 120, 145, 149, 151, 172

调用分析, 172
分析, 172
连接, 149, 151
诊断, 120

PROFIBUS DP, 174
常规, 174
故障, 174

PROFIBUS PA 的诊断, 122
PROFINET, 121, 172

调用分析, 172
分析, 172
诊断, 121

R
Route Control 站的诊断, 127

S
SIMATIC BATCH, 30, 33

备份组态数据, 30
归档批生产, 33

SIMATIC Management Console, 72
SIMATIC Manager

HART 设备, 163
PA 设备, 163
PROFIBUS 上的故障, 163
调用, 163
模块信息, 163
时间, 163
系统错误, 163
许可证, 163
运行模式, 163

SIMATIC PDM（附加件）, 169

SIMATIC Route Control, 35
备份组态数据, 35

SIMATIC Shell, 152
SIMATIC 路径控制

备份项目数据, 35

W
WinCC, 154, 155

WinCC 系统信息通道, 154
通道诊断, 155

WinCC 中的消息流, 87
Windows 帮助和支持中心, 135
Windows 网络连接对话框, 149

备

备份, 21, 22, 24, 26, 28, 29, 30, 31, 32, 35, 37
AS 参数, 21
BATCH 项目, 30
PCS 7 ES, 22, 24
PCS 7 OS 数据, 29
SIMATIC Route Control, 35
SIMATIC 路径控制的项目数据, 35
操作员文本和显示文本, 27
创建, 31
从备份副本中恢复路径控制数据, 36
多项目, 24
恢复, 32
恢复路径控制数据, 36
项目数据, 22, 24
映像文件中的 PC 站, 37
自定义操作, 28
自定义功能, 28
自定义库, 26

备份 AS 参数, 21
备份库, 26
备份自定义操作, 28
备份自定义库, 26
备份组态数据, 21, 22, 24, 26, 29, 30, 35

AS 参数, 21
PCS 7 OS, 29
SIMATIC BATCH, 30
SIMATIC Route Control, 35
多项目, 24
工程师站, 22, 24
项目特定的库, 26
自定义库, 26
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比

比较项目版本, 38

操

操作系统, 40
最新固件版本的供给来源, 40

常

常规 CP 诊断和统计功能, 149, 151

处

处理 GSD 文件, 58

创

创建, 31
备份, 31

创建用户, 155

存

存储介质, 137
存储卡

下载, 44
存储空间, 154

措

措施, 93
如果出现故障, 93

错

错误位置, 168

打

打印机和打印作业, 144
打印机和设备, 137

导

导出
SIMATIC BATCH, 31
操作员文本和显示文本, 27

导出/导入批生产对象, 31
导入

SIMATIC BATCH, 31
导入/导出助手, 31

等

等待的打印作业, 137

调

调用
BANYnet, 172
HW Config, 165
NCM S7 PROFIBUS, 149, 151
NCM S7 工业以太网, 146
NetPro, 145
PROFIBUS, 172
PROFINET, 172
SIMATIC Manager, 163
SIMATIC PDM, 169
WinCC 通道诊断, 155
WinCC“系统信息”（System Info）通道, 154
带诊断中继器的 PROFIBUS 诊断, 168
计算机管理, 137
模块信息, 166
驱动器、文件夹和文件的共享, 138
冗余状态, 158
冗余状态控制, 159
设备状态监视, 152
设置 PC 站, 141
设置 PG/PC 接口, 142
系统工具 - 本地用户和组, 140
系统诊断控制工程, 174
用户管理器, 155
站组态编辑器, 142

调用 NCM S7 PROFIBUS, 149, 151
调用 NCM S7 工业以太网, 146
调用驱动器、文件夹和文件的共享, 138
调整, 42

硬件更改后, 42
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订

订单文件夹, 161

定

定时器和计数器, 154

读

读取, 96
CPU 诊断缓冲区, 96

多

多项目, 24
归档, 24
恢复, 24

多用户操作, 156
状态, 156

访

访问级别, 138

分

分辨率, 136
分析

机械资产, 172

符

符号, 161

根

根据运行模式调用 CP 类型和诊断, 146

跟

跟踪模式, 155

更

更新, 40, 47, 48, 51, 60
CP 443-x, 51
CPU 操作系统, 44
IM 的固件通过以太网, 48
IM 152-1, 47
IM153-1, 47
IM153-2, 47
IM157, 47
固件, 44
软件, 60
硬件, 40

更新 SIMATIC S7 CPU, 42
更新固件, 43

工

工程师站, 22, 24
备份组态数据, 22, 24

工具, 110, 111, 117, 118, 120, 121, 124, 128
对于 PROFINET 的诊断, 121
用于诊断 CPU, 118
用于诊断 OS 连接, 124
用于诊断 PC 组件, 111
用于诊断 PROFIBUS, 120
用于诊断的 PC 用户设置, 110
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用于组态期间的诊断, 117

工业以太网
交换机, 147, 148

工业以太网总线, 160

供
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最新操作系统版本, 40
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固

固件
更新, 43

固件版本, 47
确定, 47

固件更新, 48, 52
CP 341, 52
IM, 48
接口模块, 48

故

故障, 163
在 PROFIBUS 上, 163

故障、更换和返回 - 文档指南, 177
故障特征, 73

冗余接口, 73

观

观察器, 147

管

管理用户和用户组, 137, 140

归

归档, 22, 24, 33
多项目, 24
方法，FTP 服务器, 34
方法，SQL 服务器, 34
方法，目录, 34
批生产, 33
项目, 22

过

过程控制消息, 160

恢

恢复, 24, 32
备份, 32
多项目, 24
项目, 24

恢复路径控制数据, 36

获

获得有关消息的信息, 84

基

基本术语
消息概念, 79

基本术语 (Basic terms), 86
消息概念 (Message concept), 86

计

计算机管理, 137
调用, 137

监

监视组件, 152

交

交换机
工业以太网, 147

接

接口模块, 48
固件更新, 48

局

局域网, 160

库

库, 26
备份, 26

连

连接, 124, 155, 169
使用 SIMATIC PDM, 169
诊断 AS-OS 连接, 124

连接状态, 145, 156
在服务器上, 156
在客户端上, 156
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路

路由器, 147

命
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ipconfig, 140
netstat, 140
ping, 140
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模

模块, 75, 142, 165, 166, 168
检查, 142
具备诊断属性, 75
数据, 166
诊断中继器的状态, 168
状态, 165, 166

模块信息, 163
模块属性, 75

检查诊断, 75

默

默认文件夹, 28
本地操作, 28
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全局操作, 28
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目

目标系统, 166

批

批生产, 33
归档, 33

启

启动协调程序
状态符号, 161

驱

驱动器, 137, 138
共享, 138

驱动器和文件夹, 138
驱动器容量, 154

确

确保可用性 - 预防性措施, 17

热

热启动, 73
冗余接口, 73

任

任务栏中的图标, 160, 163
BATCH 服务器, 160
Route Control 服务器, 163

冗

冗余, 159
OS 服务器的时间主站角色, 160
OS 服务器的诊断, 159

冗余 OS 组件, 159
冗余接口, 73

故障特征, 73
热启动, 73

冗余状态, 158
冗余状态控制, 159

调用, 159

软

软件, 60
更新, 60

设

设备文档, 95
设备信息, 169
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调用, 141
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设置 PG/PC 接口, 142
调用, 142

设置访问权限, 155

时

时间, 128, 142, 163, 165
时间同步, 142
诊断, 128

时间同步, 160
时间信息, 154

使

使用 OS Web 选件进行交互式操作员监控, 100
使用维护站进行完整诊断, 106

示

示例, 47
确定当前固件版本, 47

事

事件查看器, 137
事件触发, 154

授

授权, 37
从备份中排除, 37

数

数据, 32
从备份恢复, 32

数据备份, 19, 29, 30, 35, 37
PCS 7 OS, 29
SIMATIC BATCH, 30
SIMATIC Route Control, 35
使用备份, 19
使用映像文件, 37

图

图形卡, 136
图形驱动程序, 136
图形设置, 137

网

网络, 137
分析已连接的 PC, 137

网络适配器和 PC 卡, 137

维

维护站, 75

文

文件夹, 29, 138
对于 PCS 7 OS 数据, 29
共享, 138

系

系统, 140, 163
本地用户和组, 140
系统错误, 163

系统和系统设置, 137
系统诊断控制工程, 174
系统组态, 172

显

显示, 129
硬件的诊断, 129

显示组态, 169

项

项目, 22, 24
归档, 22
恢复, 24

消

消息, 85
解析, 85

消息的目标组, 86, 87
消息概念

基本术语, 79
消息概念 (Message concept), 86

基本术语 (Basic terms), 86
消息缓冲区的溢出, 89
消息来源和组态, 83
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消息类型, 86
在归档中, 86
在消息列表中, 86

消息列表, 86
消息流, 86

在 WinCC 中, 86
消息系统(Message system), 81
消息优先级, 89
消息帧通信, 172

信

信息, 95
关于故障原因, 95

性

性能数据, 166

要

要求, 75
诊断, 75

一

一致性, 145

以

以太网诊断功能和统计功能, 147, 148

隐

隐藏消息, 90

硬

硬件, 40, 129, 163
更新, 40
显示的诊断, 129
诊断, 163

硬件组态, 142
准备 PC 站, 142

硬盘, 137

用

用户, 138
用户管理器, 155

原

原因, 93
CP 故障, 93
CPU 故障, 93
I/O 模块故障, 93
PC 组件故障, 93

远

远程诊断, 100

运

运行模式, 163

在

在线更新, 43

站

站组态编辑器, 142
调用, 142

诊

诊断
交换机, 147
路由器, 147

诊断功能取决于 CP 类型和运行模式, 149, 151
诊断中继器, 168

确定模块状态, 168

状

状态, 86, 145, 156, 160, 161, 163, 172
DP 从站, 145
OS 服务器的时间主站角色, 160
OSM/ESM, 172
多用户操作, 156
冗余 BATCH 服务器, 160
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冗余 Route Control 服务器, 163
消息, 86

资

资产管理, 75

自

自定义功能, 28

总

总线段, 168
总线记录, 172

组

组件 - 可在线访问, 165
组态, 117, 141

诊断, 117
组态信息, 174
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